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Preface: Getting help

Welcome to the FileMaker Pro application from Claris Coi-poration.

FileMaker Pro is designed to help you manage information easily and

effectively.

If you're new to the Mac OS You need to learn about using the mouse,

working with disks, and other Mac OS conventions. See the

documentation that came with your computer.

Important If you are using a system prior to Mac OS 7.5, or if you are using

Mac OS 8, what you see on your screen might not match the illustrations in

the documentation.

Customer support and registration

Please take the time to complete and mail the product registration card

that is included in this package. Refer to our Web site at

http://www.claris.com for information about customer support.

U.S. and Canadian retail customers can also refer to the Claris Senice

Directory included with the software. For customers outside of the U.S.

or Canada, refer to the Technical Support brochure included with the

software.

Using Help and the user's guide together

Throughout this guide you see Help icons in the maigin, along with

instructions, that tell you what keywords to use to find a related Help

topic. A keyword is like a term in an index. In some cases. Help gives

you additional information about a subject. For more information about

using Help keywords, see "Using the Help index" on page XIV.

'P Cttoose FileMaker Help Index from the (21 or Help menu, and then type:

Help, using

Use the FileMaker Pro Quick Reference on the back cover of this user's

guide to get at-a-glance infonnation about using the FileMaker Pro tools

and status area controls.
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Glossary terms are available in the Help Reference section, as well as

underlined with a dotted line in Help topics.

Note The examples in this documentation show dates and numbers in

U.S. formats such as November 30, 1998. and $1,234.50.

Using FileMaker Pro Help

FileMaker Pro Help is available whenever FileMaker Pro is running. It

contains some information not in the printed documentation, like

troubleshooting tips. As you get comfortable with FileMaker Pro, you'll

be able to find all the information you need in FileMaker Pro Help.

Opening FileMaker Pro Help

To open Help when FileMaker Pro is running, choose a command from

the ^ or Help menu:

Choose
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To Do this

Arrange windows for easy

access

On a small screen, move the FileMaker Pro document window
and the Help window so the comers overlap. Then you can click

a comer to bring a window into view.

On a larger screen, arrange the windows side by side.

Switch between the Help

window and a

FileMaker Pro file window

Click the window you want to work with.

Close FileMaker Pro Help Click the close box in the upper-left comer of the window.

and leave it mnning Claris Help Viewer continues to mn in the background. To
show Help again, click a FileMaker Pro window, and then press

Hide FileMaker Pro Help

and leave it mnning

Quit FileMaker Pro Help

and the QuickHelp 4.0

application

Click a Help window, and then choose Hide QuIckHelp 40 from the

application menu (at the right of the menu bar). To show Help

again, choose Show All from the application menu.

Click the Help window to make it active, and then choose Quit

from the File menu.

Using the Help contents

When you open FileMaker Pro Help, you see a list of Help topics, like

the table of contents in a book. You can click topic titles to see any

subtopics, and then click a topic to move to the information you need.

FileMaker Pro Help

I

Cont^Ms \ lnd»x \ Fmd \

Select a book and then click "Open
"

> -^ Using Onscreen Help
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Using the Help window

To navigate in the Help system, you click buttons and underlined text in

the Help window.

Click solid underlined text to jump to a topic related to the current topic.

Click to see the index

Click to return to the

Help contents -

Displays the title of the

current topic

Click dotted

underlined text to

see a definition

Click solid

underlined text to

jump to a topic

related to the

current topic

- Click to return to the last topic viewed

Imp Hac — Tech Reuiem build

[S Go Back j B> Pi-int 03 Previous I DS N*xt

Kevwo'd
I

grouping t&n
Grouping and ungrouping objects

Creating a

« group of

layout objects

Group pbiec,t5 30 you can vork on the aroMP^.c? object 6? tf it vere a single object You can

copy and paste grouped objects, maintaining the arrangement of the objects within

the group

assign attributes (like a font or a fill color) to items in the group, even if the

attribute isn't appropriate for all the items in the group (For example, assigning a

new font to a group that contains text, a fi_el_d.. and a graphic c.

field, but leaves the graphic alone )

. more easilg work with stackjng.grder^ because grouped obj

lager

align an individual object to a grouped object

To group objects: in ,Lau,o,ut.mpde, select the objects, and then

Arrange menu If you include a locked object in the group, the resulting grouped object

also locked

To ungroup a grouped object: Select the grouped object, and then choose Ungroup

from the Arrange menu If you ungroup an object that contains other grouped objects,

those objects remain grouped until you ungroup them too

Tip You can edit text that's part of a group by double -clicking the text

Related topics

Adding and formatting ob i ects in Lauout

Aligning ob j ects to each other

Arranging obi ects

Click to move to

the next or

previous topic

- Type a word

you want to

find in the

Index and

press Return

- Drag the note icon

into a topic and type

your own notes

To return to any topic you viewed during a help session, choose History

Window from the Options menu, and then double-click the topic title.

Using the Help index

FileMaker Pro Help comes with a Ust of index entries, which are

significant words and phrases (called keywords), to help you find the

topics containing the information you want. Each index entry is

associated with one or more topics.

This user's guide gives you keywords throughout the documentation to

help you find related topics by their index entries in Help.
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To use the Help index:

1

.

If you aren't in Help, choose FileMaker Help Index from the Q or Help

menu.

2. In the Index window, type all or part of the keyword to find.

You see the topics associated with the keyword in the list.

3. Double-click the topic you want.

To browse the index, scroll

through the alphabetical list or

type the first few letters of the

entry you're looking for

FileMaker Pro Help

I
Cmtwite S '"'''>' \rind \

1 Type the first few letters of the word gou're looking for.

2. Select in index entrg and then olictt "DispUg

grouping objects

Atou' pt-i'^i:fir>9 database flies

Chanqirig gr 'nup privileges

['efnifig grt^op*

Oeieling groups

Status (CurrentGroup^ function

I I Close Vindow When Displaying Topic tf "^P"a ilM
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Using Find

You can search for specific words in FileMaker Pro Help:

1. Click the Find tab.

2. If you want, choose options from the two pop-up menus. Then type

the word that you "re looking for.

3. Click Search.

4. Click a topic in the scrolling list, then click Display.

Choose options from the

pop-up menus if you want

FileMaker Pro Help

^7m5 \_

1 Find topics that Q
T-

( I
the word

[ More Choices )

2. Select ^ topic artd then i^lick " Display
"

:^\
Options ^\

f Search \

Using buttons with scripts

At.uijl File; lal er F'lo moder

Layout mode keyboard commands
Deleting records

Omitting one or more records

1 I Close Vmdow Vhen Displaying Topics

39 Topics Found

Type the word you

want to find

Select a topic from

the list

Getting additional help

To get context-sensitive help for dialog boxes and menu items, press the

Help key (on an extended keyboard) or press 86-?.

Use Help to get information on the.se additional tasks:

For information on

Choose FileMaker Help

Index from the (^ or Help

menu, and then type

Printing a Help topic Help, printing

Adding your own notes or instructions to a topic

Uinnolations)

Help, ctjstomizing

Creating bookmarks to quickly access topics you use

often

Help, customizing

Copying all or part of a topic to an application that Help, using

supports text, to compile help information you u.se often

Setting Help preferences to customize the way you use

Help

Help, customizing
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Using the FileMaker Pro documentation

This guide and the other documentation in the set give you all the

information you need to know about installing and using FileMaker Pro.

Start by reading chapter 1, "FileMaker Pro basics," for an overview of

FileMaker Pro, and for information about managing files and

performing common tasks. Then read chapter 2, "Creating a database

file," for information about designing FileMaker Pro database files. You
can then move to the chapters you need for doing your work, such as

using layouts, or entering, finding, and sorting information.

Use the following additional tools to help you with FileMaker Pro.

Use To

FiU'Mdker Pro

liislallulioii and New
Feaiures Guide

Install FileMaker Pro on your hard disk. If you've used

previous versions of FileMaker Pro, you can read about

features new to this version.

FileMaker Pro Tutorial

(an on.screen tutorial

)

To get an overview of how to u.se and design a FileMaker Pro

database. You can complete the tutorial in one session, or one

segment at a time. To use the tutorial, double-click the Tutorial

file in the Tutorial folder.

FileMaker Pro template

files

FileMaker Pro Help

Balloon Help

CDMLDevehiHT'

See and work with databa.se files created with FileMaker Pro.

You can use the templates for your business or personal work

—

as they are, or change them to suit your needs. (See "Creating

and opening files" on page 1-9.)

Get complete, onscreen, step-by-step instructions and reference

information for using FileMaker Pro as you work. (See "Using

FileMaker Pro Help" on page XII.)

See brief descriptions of FileMaker Pro tools, iciins. and

menus. (Choose Show Balloons from the ^ or Help menu. To
turn off Balloon Help, choose Hide Balloons. ) Choose About

Balloon Help IVom the f^] "f Help menu to see directions for using

Apple Balloon Help.

Guide Gel information on publishing custom Web database solutions.

Open the CDML Reference file in the Web Tools folder, in the

FileMaker Pro 4.0 folder.

Web browser Help

Sample custom HTML
pages and databases

Get help while working with a database in a browser. Available

by clicking the ? icon in the Instant Web Publishing interface.

LIse as models for creating your own custom Web databases.

Available in the Web folder, in the FileMaker Pro 4.0 folder.





Chapter 1: FileMaker Pro basics

You're using FileMaker Pro software because you have information to

manage, or information you would like to publish on the World Wide

Web. This information could be just about anything: accounts,

inventories, suppliers, sales contacts, employees, or products. The

power, flexibility, and ease of use of FileMaker Pro help you manage

that information, so you can:

find information quickly

update and maintain information

print documents like invoices, fonn letters, and mailing labels

analyze information using onscreen and printed reports

Important Before you read this chapter, be sure you know how to use

FileMaker Pro Help, as explained in the preface, "Getting help."

Understanding FileMaker Pro

Before you begin to work with FileMaker Pro, you should be familiar

with the basics of FileMaker Pro. If you"re new to databases, start with

the next section, "What's a database?" If you're familiar with databases

but new to FileMaker Pro, start with "What's a FileMaker Pro database

file?" on page 1-3.

Whafs a database?

A database is a collection of information, or data, that you can organize,

update, sort, search through, and print as needed. A database doesn't just

hold information—you use a database to organize and analyze

information so that you understand its significance.

A database can be onefile, such as Clients, which might hold the names,

addresses, and phone and fax numbers of all your clients.

A database can also be many files that, together, contain all the

information about a particular topic, or related topics (sometimes called

a database system). For example, a database for a travel agency can

include files that hold information about clients, tours, invoices, and

accounting.
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Using the relational capabilities of FileMaker Pro, you can join

information between files to create a relational database. For example,

one file can show you which clients went on a particular tour and a

relatedfile can show how much they paid. (For more information about

relational databases, see chapter 10, "Using data from related files.")

Trip ID iT10

Trip Name : Por-Lon :

Origin Destination

Route

ID

:R20

:R42

Portland

Boston

Boston

London

'
r

Trip file
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Records in a Clients file
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Fields and field definitions

Fields are the basis of a database file. Fields store, calculate, and display

the data you have entered or calculated. For example, you might create

a field named Tour Name to hold a descriptive name for each tour you

add to a Tours database file.

The information you put into a field—by typing, copying, looking up, or

importing—is its value. Field values in a FileMaker Pro file can be:

text

a number

a date

a time

a graphic, sound, or movie

the result of a formula that calculates the field's value

a summary of the values in the field for a group of records

Each field has a set of characteristics that defines how it will store,

display, and interpret data, and whether the value is typed or entered into

the field or is the result of a calculation. These characteristics are the

field definition. You create a field in a file and define it to suit your

needs. For example, the type of data in the field and whether to calculate

the field's value are both part of the field definition.

Tour ID

Tour Name

Origin

Destination

Unit Cost

Tax

Total



Records
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To enter data in a database file, you create a record and then enter data

into the fields. After you have records in a file, you can work with them

in various ways, such as sorting them, finding a group of records that

contains particular data, or importing and exporting records.

One record contains

all the information

about a single activity,

individual, or subject

^ Choose FileMaker Help Index from the Q9 or Help menu, and then type:

records, overview

iSiEa;!aiu>i:cEj«:£»;'^s:tj^::%ii:;^;f«^
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Access privileges and passwords

Access privileges and passwords promote file security by controlling

who can use a file and particular fields and layouts, and which tasks they

can do. In the FileMaker Pro Web Companion, a password controls who
can browse and edit a file on the World Wide Web.

A file doesn't require access privileges and passwords; you can create or

change them as needed. For more infomiation see chapter 7,

"Networking and access privileges" and chapter 1 1 , "Publishing files on

the Web."

"7 Choose FileMaker Help Index from the (2! or Help menu, and then type:

access privileges

Using relationships in a database

Whether you create a database with one file (sometimes called ziflat-file

database) or many files (a relational database), you can use data from

other files as if the data were in the cunent file. A file that contains data

used in another file is a related file.

To copy data from a related file and store it in the current file, define

a lookup (see "Looking up and displaying data from other files" on

page 10-1).

To view and work with data from different files in the current file

without storing that data in the current file, create a relational

database (see "Working with relational databases" on page 10-14).

To learn more about these differences, see "Lookups and relational

databases: a comparison" on page 10-8.

You can publish both flat-file and relational databases on the World

Wide Web using FileMaker Pro Web Companion. For more

information, see chapter 1 1, "Publishing files on the Web."
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Working with modes
You work in FileMaker Pro in four modes. You switch between modes

by choosing a menu command for the mode you want.

In this mode You do this

Browse Work with the data in a file. You can view, add, change, sort, omit, and

delete records. Browse mode is where you'll do much of your work. For

more information, see chapter 4, "Working with information in records."

Layout Determine how information is presented on your screen or in printed

reports, labels, and forms. You design layouts for specific tasks, like data

entry or printing invoices or envelopes. For more mfonnation. see

chapter 3. "Laying out and arranging information."

Find Search for particular records that match a set of criteria. You can then

work with these records, called the finiml si'l. After you find a group of

records, FileMaker Pro returns to Browse mode so you can begin working

with them. For more information, see "Finding information" on page 4-19.

Preview See on your screen how data in records, forms, or reports will look before

you print on paper. For more information, see chapter 6, "Previewing and

printing infonnation."



1-8 FileMaker Pro User's Guide

Layout mode

Browse mode
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Note Some FileMaker Pro tasks, like defining fields and relationships

and using ScriptMaker, can be performed in any mode.

^ Choose FileMaker Help Index from the £21 or Help menu, and then type:

modes
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Managing files

The following sections tell you how to work with FileMaker Pro files.

Creating and opening files

You can create a file when you start FileMaker Pro or after

FileMaker Pro is already running.

Create a file from a copy of a template—a predefined file that you use

as is. or modify to suit your particular needs. Or create a file from

scratch, without using a template. (If you didn't install templates and

want to use them, see the FileMaker Pro Installation and New Features

Guide.

)

After you name a new file, you see the Define Fields dialog box, where

you create the database fields and define their characteristics. (See

chapter 2, "Creating a database file."")

The following table describes the ways to create or open a file in

FileMaker Pro. If FileMaker Pro isn't already running, start it by

double-clicking the application icon. When you start FileMaker Pro,

you see the New Database dialog box. and you can skip the first (Choose

New...) step in the following directions.

To Do this

Create a file using a In FileMaker Pro. choose New from the File menu. In the New
template file Database dialog box, select Create a new file using a template, choose

a template category from the pop-up menu, and then double-click

the name of a template file in the list. In the Create New File dialog

box. type a name for the file (choose a different folder, if needed),

and then click Save.

Create a file without In FileMaker Pro. choose New from the File menu. In the New
using a template file Database dialog box. select Create a new empty file, and then click

OK. In the Create New File dialog box. type a name for the file

(choose a different folder, if needed), and thenvlick Save.
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To Do this

Open an existing file If FileMaker Pro isn't running, in the folder containing your

FileMaker Pro files, double-click the name of the file to open. Or
drag the file onto the FileMaker Pro application icon.

You can also double-click the FileMaker Pro application icon. In

the New Database dialog box, select Open an existing file, and then

click OK. In the Open dialog box, double-click the name of the file

to open. If vou're asked for a password, type the password, and

then click OK.

If FileMaker Pro is running, choose Open from the File menu, and

then double-click the name of the file to open. If you're asked for

a password, type the password, and then click OK.

If you have opened the file recently, you can also choose the

filename from the listing in the File menu if you have selected this

option in application preferences. For more information, see

chapter 9, "Customizing FileMaker Pro."

Neui Database i

Create a file

Select to stop showing

this dialog box

CLARIS"

FileMiiker

® Create a neuf file using a

template:

O Create a neai empty file..

OOpen an eHisting file...

—j
I
No longer show this dialog

Template Info... ]

Business
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When you open a file created with FileMaker Pro versions 2.0 and

2.1, you see a message telling you the file must be converted to

FileMaker Pro 4.0 format. To rename the original file, keep the

Rename old file as checkbox selected and type a name (or use the

FileMaker Pro default). The new file is converted to the current

FileMaker Pro file format. The original file has a new name, but the

contents don't change. (For more information about converting files

from previous versions of FileMaker Pro, see the FileMaker Pro

Installation and New Features Guide.)

When you open a file saved with internal default formats different

from the system formats set on your computer, you might see an alert

message. For information about this situation, see appendix B,

"Working with international files."

You can open a file created in another application, like Lotus 1-2-3,

Microsoft Excel, or ClarisWorks software, in FileMaker Pro and

convert it to FileMaker Pro format. See "Importing data into a new
file" on page 8-9.

/ Choose FileMaker Help Index from the ^ or Help menu, and then type:

• creating

opening files

Closing files

FileMaker Pro saves changes you make to a file as you work and

whenever you close a file or leave the application.

To close a file, be sure the file's window is active, and then do one of

these:

Click the close box (in the upper-left comer of the file's window).

Choose Close from the File menu.

O Choose FileMaker Help Index from the C£ or Help menu, and then type:

closing database files

Saving a copy of a file

Although FileMaker Pro saves changes to a file as you work, you can

save a copy of a file for various purposes.
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Important Always save a copy before you make extensive changes. You

can"t restore data after you delete a t"ield from the Define Fields dialog

box or remove records using the Delete Record or Delete All commands.

1

.

Make the file you want to save the active file, and choose Save a Copy

As from the File menu.

2. In the Save a Copy dialog box, for Type, choose an option from the

pop-up menu.

Choose To

Copy of current file Duplicate Ihc entire file, including the field definitions,

layouts, scripts, page setup options, and data. Copying a

file is useful before you make extensive changes.

Compressed copy (smaller) Compress the entire file into less disk space by

reclaiming unused space in the file. Compressing a file

may take time, so it's a good idea to compress a file only

when you're archiving it.

Clone (no records) Make a copy that contains all the field definitions,

layouts, scripts, and page setup options, but no data.

Make a clone when you want a template of the file.

3. To rename the file, for Create a copy named, type a name.

Name of the new file

|t2j EHdmple files Z]
Clients

% Clients Old

r~l Data e»ported from Organizer

[]] DataOut.TKT

Q Employee (4^

Create a copy named:

I Clients Copy

Type:
|
copy of current file -^-|-

Eject

Desktop

Neiu CH

Options for saving a copy

4. Click Save.

7 Choose FileMaker Help Index from the CS or Help menu, and then type:

saving files
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Leaving FileMaker Pro

When you're finished working in FileMaker Pro, choose Quit from the

File menu.

Important Always quit FileMaker Pro before you turn off your

computer.

'f <Clioose FileMaker Help Index from the (21 or Help menu, and then type:

closing database files

iSK^as^iJiC?*?.;

Checking your spelling

You can use the installed spelling dictionaries to check the spelling in a

file, all at once or as you type. FileMaker Pro compares your text with

its main dictionary (which contains almost 100,000 words) and a user

dictionary, in which you can store up to 32,000 unique terms. Each file

can have its own user dictionary. This is useful when, for example, you

have files that contain unique terms (like medical or legal terms).

You can check the spelling of a selected word or passage, all words in

the current record or layout, or all words in the records most recently

found (the current found set) or browsed in Browse mode.

When FileMaker Pro finds a word it doesn't recognize, you can correct

it, skip it, or add it to your user dictionary.

Note Before you begin, be sure the dictionaries currently selected are the

ones you want to use. See "Working with spelling dictionaries" on page

1-16.

Checking your spelling in a file

1. Display the layout or record, find the set of records, or select the text

to check.
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2. Choose Spelling from the Edit menu, and then:

To check the spelling of



FileMaker Pro basics 1-15
|

4. When all questionable words are resolved, click Done.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

checking spelling

Checking your spelling as you type

As you type, FileMaker Pro can alert you to errors with either a flash in

the menu bar, or a beep.

Checking your spelling as you type is much slower than checking the

entire file at one time.

1

.

Choose Preferences from the Edit menu, and then choose Document.

2. In the Document Preferences dialog box, choose Spelling from the

pop-up menu. Select how you want to be alerted and where you want

the Spelling dialog box to appear.

Choose Spelling

Select how you want to be -

alerted as you type

Have the Spelling dialog box

.

appear where you place it

Document Preferences
\

I

Spelling^

SpeH as i|Ou type :

I

(*) 0"

Q Beep on questionable spellings

(3 Flash menu bar on questionable spellings

Dialog placement :

(•) Automatic

O User defined

I
Done )|

3. Click Done.

When you're alerted to a spelling error, you can do one of these:

Correct the last word typed.
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Choose Spelling from the Edit menu, and then choose Correct Word, before

you press Tab or Enter. Use the Spelling dialog box to conect the word.

(See "Checking your spelling" on page 1-13.)

O Choose FileMaker Help Index from the C9 or Help menu, and then type:

checking spelling

Working with spelling dictionaries

When you check spelling, you can use the main dictionary and the user

dictionary installed with FileMaker Pro, or you can use a user dictionary you

created.

The main dictionary is associated with all your FileMaker Pro files. User

dictionaries work with specific files. After you select a user dictionary for a

file, FileMaker Pro uses that dictionary until you select a different one.

Selecting a spelling dictionary

Before you can check spelling, select the spelling dictionaries to use. (If the

dictionaries you want to use are already selected, you don't need to reselect

them.)

Select dictionaries when:

your spelling dictionaries are in a place other than the FileMaker Pro

folder, the Claris folder, or the System Folder

you want to make more than one spell-checking pass through a file using

different dictionaries (for example, dictionaries of different languages)

you want to switch to a different dictionary (like one that contains special

terms) after checking with the dictionary currently selected
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To select, ignore, or create a spelling dictionary:

1. Choose Spelling from the Edit menu, and then choose Select

Dictionaries.

2. In the Select Dictionaries dialog box, choose an option.

To Do this

Select or switch a For Select Dictionary Type, ctioose Mam Dictionary or User Dictionary. It

dictionary needed, locate the correct folder. Then select the dictionary name

and click Select.

Ignore your user For Select Dictionary Type, choose User Dictionary, and then click None,

dictionary

Create a user For Select Dictionary Type, choose User Dictionary, and then click New.

dictionary TyP^ '' unique, distinguishing name for the new user dictionary, aiid

then click Save.

Select Dictionary Type: |Main Dictionary ^|

U Claris Translators

CDCIarislDorks Assistants

QCIarislUorks Stationery

CUColors and Gradients

CD FileMaker Temp

Q Main Dictionary

Q US Englisti Spelling

Desktop

c open

[
Done

Currently S*lMted Dictionary

USENCLSH MPR

Select the type of

dictionary to use

9 Choose FileMaker Help Index from the ^ or Help menu, and then type:

>• creating

S»gS5!SS51!«iS!3a3SS«e3SK(gWW)S«*»^^

Making changes to a user dictionary

You can edit, import text to, and export text from a user dictionary.

Editing a spelling dictionary

Before you begin, be sure the dictionary to edit is selected. (See

"Selecting a spelling dictionary" on page 1-16.)

1 . Choose Spelling from the Edit menu, and then choose Edit User

Dictionary.
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2. In the User Dictionary dialog box, make any changes, and then click

OK.

To Do this

Add a word For Entry, type the word, and then click Add.

Remove a word from the list Select the word, and then click Remove.

Change a word Remove the word from the list, type a replacement, and

then click Add.

Words in dictionary •

User Dictionary; User Dictionary

ciieclc

checker
Chen
Clarjslmpact

Claristilorlcs

Compton

I?

Entry:

L OK

I
Cancel |

TeHt File 4

Currently Installed

user dictionary

O Choose FileMaker Help Index from the £S or Help menu, and then type:

editing

Importing or exporting a spelling dictionary

Before you begin, make sure the currently installed dictionary is the one

you want to import into or export from.

1. Choose Spelling from the Edit menu, and then choose Edit User

Dictionary.

2. In the User Dictionary dialog box, click the Text File triangle, and then:

To Do this

Import a text file Click Import. (If necessary, locate the correct folder.) Then

double-click the name of the file to import. (To cancel importing,

press Command-period.)

Export a text file Click Export. (If necessary, choose a different folder.) Type a name
for the file to export to. and then click Save.
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3. When importing or exporting is complete, click OK, and then click OK
again.

'P Choose FileMaker Help Index from the £S or Help menu, and then type:

exporting, dictionaries

importing data



Chapter 2: Creating a database file

This chapter tells you how to design a database file:

to use by itself

to use as part of a relational database

This chapter also explains some limitations on options available when

designing a file to use with FileMaker Pro Web Companion.

For information about creating a relational database, which includes

more than one database file, see chapter 10, "Using data from related

files."

Important Before you read this chapter, be sure you know how to use

FileMaker Pro Help, as explained in the preface, "Getting help."

Planning a database file

Plan a database before you create it to save time and effort later on.

Although you can change the design later, the more you plan ahead, the

fewer changes you'll need to make. Whether you plan to publish your

database on the World Wide Web or not, the concepts are the same.

Follow these general steps when you plan a database:

1. Decide which categories of information you work with, and plan a

separate database file for each major category.

For example, for a small business, you might need one database file

for products, one for customers, and another for employees.

2. Analyze your current information management system to determine

the tasks you perform.

For example, do you print mailing labels and invoices? What reports

do you produce? Are there new tasks you want to do?

3. Decide what data you want the file to contain, and plan the fields to

hold the data.

For example, to print invoices, you need fields for a billing address,

shipping address, quantity, product code, and so on, and calculated

fields for subtotal, sales tax, shipping charge, and invoice total.

4. Determine relationships between your file and other files whose data

you can use.
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For example, if data you want already exists in another file, you can

use it in the current file by defining a relationship to the other file and

then defining lookups or adding fields from that file on a layout of the

current file.

5. Decide what layouts you need, and plan a separate layout for each

task.

For example, plan layouts for data entry, order entry, printing mailing

labels, printing form letters, and for each type of report you produce.

6. If others will use your database, think about who can use the file and

which tasks they can perform.

If security is important to your data, you can restrict who can do

which tasks by assigning passwords and access privileges to the file.

7. Put your ideas on paper, listing the files you need and the fields for

each file. Also list the forms and reports you will generate from each

file.

Sample Database Design Form
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After you have all the basic parts in place, you can begin creating your

database, as described in the next section. "Defining database fields."

Start with a simple design and use it for a while. You can change it as

needed.

Keep these points in mind as you plan database fields:

Use separate fields for first name and last name so you can search or

sort records based on either.

Use separate fields for city, state, and postal code. If you combine

them, you can't sort records based on the individual fields.

Make a separate field for titles (to hold values like Dr., Mr., and Ms.).

Defining database fields

When you create a file, you begin by defining the database fields. To
define a new field, give it a name, and then select options that determine

how the field interprets, enters, calculates, stores, and displays data. All

these chaiacteristics make up Ihefield definition. After you define fields,

you can add. change, or delete field definitions as needed.

1

.

Create a file, or, in Browse or Layout mode, choose Define from the

File menu and then choose Fields.

2. In the Define Fields dialog box, for Field Name, type a unique name
for the field.

Don't use the following symbols or words: , (comma), +, -, *, /, ^, &,

=, A >, <, <,>,(, ), ", :, ::, AND, OR, XOR, NOT. or a FileMaker Pro

function name. Don't begin a field name to be used in a calculation

fonnula with a period (.) or a number.

3. For Type, select a field type, and then click Create.

See "Assigning a field type" on page 2-5.
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4. Define options for the field.

If the field type is Do this

Text, number, date,

time, or container

Calculation

In tlie field definitions list, double-click the fieldname (or select

the field, and then click Options), and then set entry options for

the field. See "Choosing data entry options" on page 2-6.

In the Specify Calculation dialog box. define a formula for the

field. See "Understanding formulas" on page 2-13.

Summary In the Options for Summary Field dialog box, select summary

options. See "Defining summary fields" on page 2-23.

Global In the Global Field Options dialog box. select global options.

See "Defining global fields" on page 2-9.

Field names and definitions -

Type a nanne for a new field •

Select a field type

ir

I Define fields for "EmploHee"

Field Name



Creating a database file 2-5]

Assigning a field type

When you define a field, you must decide the kind of data it will contain

and then select the appropriate field type. FileMaker Pro uses the field

type to interpret the data when sorting and performing calculations. The

following table explains each field type.

Select this

field type If the field's data will be

Text Up to 64,000 characters of letters, symbols, and numbers used as text.

You can sort records based on a text field and use a text field in formulas

for calculations and summary fields. Text fields are usually sorted

alphabetically ( from first character to last character in the alphabet, or last

to first), starting with the first character in the field. For more

information, see "Sorting records" on page 4-30.

Number Up to 255 characters of numbers or other characters, of which only the

numbers are treated as numeric. You can sort records based on a number

field and use number fields in formulas for calculations and summary

fields. Number fields are sorted numerically (lowest to highest or highest

to lowest), based on the numeric part of the data.

Date Dates only. A date field must include at least the day and month portion

(dd and mm) of a dale. If you enter no year, and have not typed a separator

character for a year, FileMaker Pro enters the current year for you. You
can sort records based on a date field and use date fields in formulas for

calculation and summary fields. Date fields are sorted chronologically

{from earliest to latest or latest to earliest).

Time Times only. A time field can contain only the hours, minutes, or seconds

portion (/)/?, mm, and ss) of a time. You can sort records based on a time

field and use lime fields in formulas for calculation and summary fields.

Time fields are sorted chronologically (from earliest to latest or latest to

earliest).

Container A graphic, sound, or QuickTime movie. You enter data in a container

field in different ways, depending on the type of data. Container fields

can be used in calculation fields and summary fields. See "Working with

container fields" on page 4-6.

Calculation

Summary

Global

The result of a calculation formula thai uses field values from the current

record or related records. The formula can use values of all field types.

The result can be text, a number, date, time, or container. See

"Understanding formulas" on page 2-13.

A value that's produced by summarizing field values from more than one

record in the same file. See "Defining summary fields" on page 2-23.

One value to be used in all records of the file. A global field can be text,

number, date. time, or container. Use the value of a global field in

calculations and scripts. You can't use a global field to find records. See

"Defining global fields" on page 2-9.
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Keep these points in mind:

Because they often include non-numeric characters hke hyphens or

parentheses, define postal codes and telephone numbers as text fields,

not number fields.

You can't search or sort records based on container fields, but you

can define text fields to describe or identify them. Then search and

sort based on the description or identifying number of the field's

value.

You can change the way data is displayed in text, number, date, and

time fields. See "Defining display formats for fields" on page 3-59.

The characters displayed for the decimal separator and thousands

separator in number fields, and the part separators in date and time

fields, and the order in which date and time parts appear depend on

the system formats set for the file and the display format for the field.

See appendix B, "Working with international files," and "Defining

display formats for fields" on page 3-59.

'P Choose FileMaker Help Index from the gS or Help menu, and then type:

fields, defining

Choosing data entry options

For each text, number, date, time, and container field, you can set or

change options to make entering data fast and accurate. You can have

default data entered in the field and have the data checked against

validation requirements set for the field.

1. Create a file, or choose Define from the File menu and then choose

Fields.

2. In the Define Fields dialog box, double-click a field you want to set

data entry options for.

3. In the Entry Options dialog box, choose the type of entry options to

set from the pop-up menu (at the top of the dialog box).

To have a default value automatically entered in the selected field

for each record, choose AutO Enter.

To have data in the field checked against validation requirements

you set for the field in each record, choose Validation.

4. Define repetitions and storage options.
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To make the field a repeating field, select Repeating field witil a

maximum of n repetitions, and then type the number of repetitions.

(See "Defining repeating fields" on page 2- 1 1 .) To set options for

indexing the field's values, click Storage Options, and then select

indexing options. You can also choose a language for indexing and

sorting text fields. (See "Indexing fields" on page 2-12.)

Select options for automatically entering and validating data.

For To Do this

Auto Enter Turn off automatically entered data Select Nothing.

Enter the date, time, or user name
when the record was last created or

changed

Choose an option from the pop-up

menu.

Assign a unique, sequential number

to the field in each record

Select Serial number, and then type a

starting value (for example. 1001

)

and the number to increment by.

Enter the value from the previously

accessed record

Select Value from previous record.

Enter data you specify Sdect Data, and then type the data

you want, up to 255 characters.

Enter the result of a calculation in

the field

Select Calculated value, and then

define the fomiula. (See the note at

the end of this section and

"Understanding formulas" on page

2-13.)

Enter a value that's copied from a

field in the same or a different file

Select Looked-up value, and then

define the lookup. (See "Defining

lookups between files" on page

10-11.)

Prevent users from changing an

automatically entered value

Select Prohibit modification of value.

Validation Check that the data is a number,

date, or time

Select Of type and then choose a type

from the pop-up menu.

Check that the field is not empty, or

that the value is unique or already

existing in the file

Select Not empty. Unique, or Existing.

Check that the value is in the value

list you specify

Select Member of value list, and then

choose a value list from the pop-up

menu, or define a value list. (See

"Defining value lists" on page .3-75.)

Check that the value falls within the

range you specify

Select In range, and then type a

starting value and ending value for

the range.
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For To Do this

Check that the value matches the

result of a calculation

Select Validation by calculation, click

Specify, and then define a formula.

The result must be Boolean
—

"true"

or "false," "yes" or "no," and so on.

(See "Understanding formulas" on

page 2-13.) The result is false when

the result is or null (empty);

otherwise the result is true.

Prevent users from entering invalid

data

Select Strict: Do not allow user to

override validation.

Display a message you specify when Select Display Custom message if

the data doesn't meet the validation validation fails, and then type a

requirements message (up to 255 characters).

Set entry options for entering

default data in the field

Entry Options for Field "first Name" :

1
Hiitn FntPt w\
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6. Click OK. and then click Done.

Keep these points in mind:

You can't set FileMaker Pro to enter data automatically for

calculation, summary, and global fields.

If you create or edit records using FileMaker Pro Web Companion,

auto-entered data appears only after the record has been submitted

from the browser software.

Select Calculated value to calculate a value only when a record is first

created or when a value in a field the calculation refers to changes (as

long as the field with the calculation doesn't already contain a value).

If necessary, you can enter a different value in the field (when Prohibit

modification of field isn't selected). However, when you want a

calculated value that's always up to date and which you can't change

by entering data in the field, define the field as a calculation field. See

"Defining database fields" on page 2-3 and "Understanding

formulas" on page 2-13.

When the data in a validated field doesn'l meet the vahdation

requirements, users see a warning message when they try to move out

of the current record. If Strict: Do not allow user to override validation is

set for the field, users must correct the data before moving out of the

record. You can use Display custom message if validation fails to give

users the data requirements.

To save time during data entry and to validate fields, define value

lists. Value lists aren't attached to any field definition. You can

format value lists to display in a pop-up list or menu, or as

checkboxes or radio buttons. See "Defining value lists" on page 3-75.

*? Choose FileMaker Help Index from the ^ or Help menu, and then type:

data entry options

Defining global fields

A global field contains one value that's used for all records in a file. Use

the value of a global field:

to declare variables in If, Else, End If, Loop, End Loop, and Exit

Loop If script steps
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for fields that rarely need to be updated. For example, use a global

field to put your company logo (a graphic) and address (text fields)

on several layouts. You can quickly update the field if needed without

having to update each layout.

as a fixed value to be used in calculations in all records in a file

You can also use a global field in layouts and calculations and as

repeating fields. You can't use a global field for finding data.

1

.

Create a new file, or choose Define from the File menu and then

choose Fields.

2. In the Define Fields dialog box. for Field Name, type a name for the

field.

3. For Type, select Global, and then click Create.

4. In the Global Field Options dialog box, select options.

To Do this

Choose a data type for For Data type, choose a type from the pop-up menu. (See

the field "Assigning a field type" on page 2-5.)

Make the field Select Repeating field with a maximum of n repetitions, and then

repeating and set the type the number of repetitions. (See '"Defining repeating fields"

number of repetitions on page 2-11.)

5. Click OK. and then click Done.

Choose a (jata type for the field

Click to make this a repeating field

Options for Global Field "Constant"

A global field is defined to contain only one value which is shared across

all records in a file, it can be used as a temporary storage location Cas in

scripts)

- C-ata type [ Number -^
|

- Q Repeating field with a maximum of J repetitions

Cancel

Note If you're working with global fields in a shared file, see "Working

with shared files" on page 7-6.

9 Choose FileMaker Help Index from the 2E or Help menu, and then type:

global fields
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Defining repeating fields

A repeating field holds more than one value (up to 1000). each in a

separate repetition (row) of a field of any type except summary. For

example, use a repeating field to show all available tours for a cruise

line.

Destination

London
New York
lonolulu

Wellington

Each value in a repeating field

is a single, separate value

You can use repeating fields for calculating values and finding and

sorting records. FileMaker Pro includes all values in a repeating field for

calculations, summaries, and find requests, even these that aren't visible

in the current layout. For sorting, FileMaker Pro uses only the first value

in a repeating field.

You can make a calculated field repeating when you define a

calculation. (See "Writing formulas for calculation fields" on page

2-20.) You can make a global field repeating when you choose global

field options. (See "Defining global fields" on page 2-9.)

To define a text, number, date. time, or container field to be repeating:

1

.

Create a file, or. in Browse or Layout mode, choose Define from the

File menu and then choose FieltJS.

2. In the Define Fields dialog box, double-click the name of the field to

be repeating.

3. In the Entry Options dialog box, select Repeating field with a maximum

of n repetitions, and then type the number of repetitions you want.

4. Click OK, and then click Done.

To change the number of repetitions visible on a layout, see

"Formatting repeating fields" on page 3-72.

Choose FileMaker Help Index from the .2 or Help menu, and then type:

repeating fields
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Indexing fields

FileMaker Pro indexes each value in fields used for these tasks (unless

you deselect the automatic index option):

validating fields with unique or existing validation criteria

matching fields in a related or lookup file

matching fields in a master file (to find data in a field based on the

relationship)

You can index all field types (except container, summary, or global) to

improve performance for tasks like finding data. Indexing uses

additional disk space and can slow perfomiance of some operations,

especially in large files.

1. Create a new file, or, in Browse or Layout mode, choose Define from

the File menu and then choose Fields.

2. In the Define Fields dialog box, double-click the name of the field to

index.

3. In the Entry Options dialog box, click Storage Options.

4. In the Storage Options dialog box, for Indexing, click On. If you are

working with a text field, choose a language from the pop-up menu.

In most cases, keep Automatically turn indexing on if needed selected.

Otherwise, tasks like finding take much longer on unindexed fields.

Index each value in

the current field

Select this to speed up -

finding on unindexed fields

i storage Options for Field "Month" ;

Indexing improves performance for some operdftons like finds and supports

functionality like joins and field value uniqueness at the cost of increased file

Size and time spent indexing

-^Indexing O^"
® Off ^ Automaticallg turn indexing on if needed

Default language for indexing and sorting text
|
£nglis

f
Cancel ][[ oiT

- Choose the

language to index

and sort values by
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5. Click OK twice, and then click Done.

Keep these points in mind:

You can set indexing options for a calculated field when you define

the calculation. (See "Writing formulas for calculation fields'" on

page 2-20.)

To use the index for data entry, see "Working with the index" on page

4-10.

O Choose FileMaker Help Index from the Q or Help menu, and then type:

index

Understanding formulas

You write aformula (a specific operation on one or more values in the

database) for a calculation or summary field. For example, suppose your

file contains two number fields—Unit Price and Quantity—and one

calculation field. Subtotal. You want to calculate a value for Subtotal in

each record, so you write the calculation formula:

Unit Price * Quantity

for the Subtotal field. Then, each time you type values in Unit Price and

Quantity, the formula multiplies those values and displays the result in

Subtotal.

Unit Price

Quantity

Subtotal

Tax Rate

Total

50 00

2

$100.00

$108 00

Contains a formula that multiplies tfie value in

Unit Pnce by tfie value in Quantity

Contains a formula tfiat multiplies the value in

Tax Rate by the value in Subtotal and adds

the result to Subtotal
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Use a calculation field to calculate a result from values in other fields in

the current record (or from other related records, using a relationship).

Use a summary field to produce a result using values in more than one

record in the database.

IJJeI »~- >?r

Sales Totals

Culkkiu 3514 m
S3MI OO

2996 00

Onnd Toul Sold S32r70 00

Calculation fields Summary fields—

I

The values you calculate can come from all field types. You can produce

different values in a summary field, depending on whether you're

browsing all or some of the records, whether records have been sorted,

and where you place the summary field on the layout.

The formula's result can be text, number, date, time, or container. The

result of a calculation depends on the field type of the values it calculates

and whether the field type is calculation or summary.

A formula contains one or more parts arranged in a particular order

(called synta.\) that determines the values to use and the operations to

perform to produce the result you want. The following sections explain

each formula part and its syntax.

Important In the United States, commas act as list separators in

functions, formulas, and calculations. In other countries, semicolons

might be used as list separators. The separator that is used depends on

the operating system your computer uses, as well as the one used when

the file was created.
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An expression is a value or any computation that produces a value.

Expressions can be combined to produce other expressions.

Type of expression
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Field references

Operators

Afield reference is a field name that acts as a placeholder for the field's value.

When FileMaker Pro evaluates the formula in the current record, the value in

the field represented by the field reference is used in the calculation.

(Quotation marks indicate a text expression.)

This expression
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Mathematical operators

Use the following mathematical operators with numeric expressions.

Symbol Name Definition Examples

Addition Adds two values 2+2

Subtotal+Sales Tax

Subtraction or

Negation

SubUacts the second 2-2

value from the first, or

changes the sign to + or
InvoiceTotal-Discount
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Symbol Name Definition Examples

> or >= Greater than or True when the value on 5>6 returns false

equal to the left is greater than or _,_ . . ,„^
, , , , 5>5 returns true

equal to the value on the

right

< or <= Less than or

equal to

True when the value on

the left is less than or

equal to the value on the

right

5<6 returns true

19<18 returns false

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

comparison operators

^^:se!aatsim!S!S^^«xs^!ssi!f{xzi:isfc^7^^

Logical operators

When you want FileMaker Pro to perfonn a calculation based on two or

more conditions, use logical operators to describe such conditions.

Operator Definition Example

AND True only when both of two values are

true. The result is:

true when true AND true

false when false AND true

false when false AND false

InvoiceTotal<100 AND
SalesTax<6

OR True when either of two values is true. The

result is:

• true when true OR true

• true when true OR false

» false when false OR false

InvoiceTotal<100 OR
SalesTax<6

XOR True when either, but not both, of two

values is true. The result is:

• false when true AND true

• true when false AND true

• false when false AND false

InvoiceTotal<100 XOR
SalesTax<6

NOT Changes a value within parentheses from NOT InvoiceTotal>1000
false to true or from true to false. The

result is:

• false when NOT ( true)

true when NOT(false)
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Use AND, OR. or XOR to combine two expressions; use NOT with only

one expression.

9 Choose FileMaker Help Index from the (^ or Help menu, and then type:

logical operators

Text operators

Use the following text operators with text expressions. (Double

quotation marks indicate a text expression.)

Symbol Name Definition Examples

Concatenation Appends the text slnng on the "XXX" & "

right to the end of the text string "XXXZZZZZ'

on the left

ZZZZZ" returns

Text constant Marks the beginning and the

end of a text constant. Quotation

marks without text between

them indicate a blank space. If

you enter text into a formula

without using quotation marks,

FileMaker Pro interprets the

text as a field name or function

name. To put a quotation mark

in a text constant, precede it

with another quotation mark.

"Sydney, NSW" returns

Sydney. NSW
"

" returns an empty (null)

value

"The report said
""Confidential"" on

the top" returns The report

said "Confidential" on the top

Return marker Inserts a paragraph return in a

text constant

"M.T.N.TrekgiSportingJ

Equipment" returns

M.T.N. Trek

Sporting

Equipment

(The II symbol must be

enclosed withm the quotation

marks of the text constant)

^ phoose FileMaker Help Index from the SI or Help menu, and then type:

text operators
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Stored and unstored calculation results

You can have FileMaker Pro:

perform a calculation whenever the data that the calculation is based

on changes, and store the result in the calculated field (a stored result)

perform a calculation and display the result only when you need to

use the data—for example, to browse or print records—(an unstored,

or virtual, result)

In most cases, FileMaker Pro makes a field stored when you define the

field. You can change the storage type to unstored.

Keep these points in mind:

FileMaker Pro makes a calculated field unstored when its formula

refers to a global field, an unstored calculated field, a related field, or

a calculation that includes a summary field.

Stored results use more disk space. Unstored results take more time

to calculate.

"? pihoose FileMaker Help Index from the C9 or Help menu, and then type:

calculation fields

Functions

A function is a predefined, named formula that performs a specific

calculation and returns a single, specific value. You type only the

function, and FileMaker Pro performs the calculation it represents. You

can use functions by themselves or combine them with other functions

or expressions. For information about specific functions in

FileMaker Pro, see appendix C, "Summary of functions."

O Choose FileMaker Help Index from the gS or Help menu, and then type:

functions, using

Writing formulas for calculation fields

1

.

Create a file, or choose Define from the File menu and then choose

Fields.

2. In the Define Fields dialog box, for Field Name, type a name for the

field.

3. For Type, select Calculation, and then click Create.
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4. In the Specify Calculation dialog box, define the formula.

To Do this

Add a field In the toniiula box, click where yi)U want the field reference to

reference appear. In the list of field names, double-click a field name.

Add a In the formula box, click where you want the operator to appear. In

mathematical or the keypad, click an operator. (Quotation marks and parentheses

text operator are copied to the formula as a pair, with the insertion point blinking

in the middle).

Add a comparison In the formula box. click where you want the operator to appear,

or logical operator For Operators, choose an operator from the list.

Add a constant

value

In the formula box, type the value. (See "Constants" on page 2-

1

5.)

Add a function In the formula box. click where you want the function to appear.

From the functions list, double-click a function. (To see a category

of functions, for View, choose a category. ) In the formula box.

replace the placeholder parameter with the value or expression you

want.

Relationship pop-up nnenu -

Choose field references

Formula box -

Choose a formula result type

Make a field repeating

Calculate only if at least one

field in the formula has a value

Address 1

Agent

Amoont

Beds

City

Client First

Client Last

Country

Subtotal =

Sum( Amount 1

Specify Calculation ;

n
Abs I number I

Atan (number)

Average (field )

Case (test! , result 1 [,testi',n

Choose (test, resultO [, resuUI

Cos (number)

Count (field )

Date (month, daij , ijear.i

L alculation result is | Number ^
|

r~l Repeating field with a maximum of I 2 values

^ Do not evaluate if all referenced fields are empty

Storage Options..

[ Cancel

Select

functions

Select

operators

Choose

indexing and

result storage

options
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5. Select calculation options for the field.

To Do this

Make the calculated Click Repeating field with a maximum of n values, and then type the

field repeating maximum number (up to 1000) of repetitions you want.

Set the field type of the

result

For Calculation result is <value>. choose a field type for the result.

Be sure to choose the correct type for the result you want.

See fields from a

different file

Have FileMaker Pro

perform a calculation

even when all

referenced fields have

no value (are empty)

Choose a filename from the relationship pop-up menu. (For

more information about relationships, see "Understanding

relationships" on page 10-9.)

Deselect Do not evaluate if all referenced fields are empty. (Do this

when you always want FileMaker Pro to calculate a result, even

if the field is empty or has never been modified. ) Select this

option when you don't want FileMaker Pro to evaluate the

calculation until one of the referenced fields has a value (so you

don't display zero as a result).

6. To select indexing and storage type options for the field, click Storage

Options, select options, and then click OK.

To Do this

Make the calculation Select Do net Store calculation results—calculate only when needed,

result unstored To store the result in the field, deselect the option.

Index the result For Indexing, select On. To remove indexing, select Off. (See

"Indexing fields" on page 2-12.)

Specify the language Choose the language from the pop-up menu. (See "Indexing

for finding and sorting fields" on page 2-12.)

indexed values

Select this when you -

want an unstored result

: Storage Options for Field "Trip Total"

tnij«9^ing and stormg the results of d calculation improves performance of some

operations like fintls at the cost of increased file size and time spent indexing.

Indeving (3 Oh

(•lOff ^Automatically turn indexing on if needed

-^ Q Do not store calculation results ~ calculate only when needed

raolt language for indexing and sorting text
\
English 3

7. Click OK, and then click Done.
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Keep these points in mind:

When you type values, expressions, functions, and parameters, the

letters can be uppercase or lowercase. FileMaker Pro doesn't

consider case for calculation purposes.

When you use a repeating field in a calculation, the other parts of the

formula must be compatible with that field.

O Choose FileMaker Help Index from the E^ or Help menu, and then type:

calculation fields

-Xi^-:^^SSiJi?^3iiiX1tiJS!!^S!^ilii!>Sii^7JSZ.'Vt

Defining summary fields

Important The value in a summary field depends on the layout part in

which you place the summary field, so you must know about parts and

summary parts to get the results you want. Before you define a summary
field, see "Working with layout parts" on page 3-24 and "About

summary layout parts" on page 3-29.

1

.

Create a new file, or choose Define from the File menu and then

choose Fields.

2. In the Define Fields dialog box. for Field Name, type a name for the

field.

3. For Type, select Summaiy, and then click Create.

4. In the Options for Summary Field dialog box, select the type of

summary to perform, and then select the name of the field that

contains the values to summarize.

To summarize values in a field in the found set

of records by Select

Calculating the total of values in the field Total Of

Calculating the average of values in the field Average Of

Counting the number of records that contain a value for the field Count Of

Finding the lowest number, or the earliest date or time, for a field Minimum

Findmg the highest number, or the latest date or time, for a field Maximum

Calculating the standard deviation from the mean of the values in Standard Deviation of

a field. (The formula is n- 1 weighted, following the normal

standard deviation. For population standard deviation, see step 5.)

Calculating the ratio of the value in the field to the total of all the Fraction of Total Of

values in that field. (For example, find what fraction of total sales

can be attributed to each individual sales person.)
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5. If you want, select a summary option, if applicable to the summary

type.

For this summary
type To Select

Total of Show the cumulative total for the Running total

current and all previous records

Average of Determine the average in one field

based on a value in another field that's

used as a weight factor

Weighted average. In the

list of fields that

appears, select a field

name for the averaged

values.

Count of Show the cumulative count of the Running COUnt

current and all previous records

Standard Deviation Calculate population standard

of deviation, where the formula is

n-weighted

By population

Fraction of Total of Define a subset of the group to sort by Subtotaled. In the list of

fields that appears,

select a field name for

the subtotaled values.

Choose a formula

-

Set an option for -

the formula type

[ Options for Summary Field "Cruise total" i

-(•)To1alof

Q Average of

QCount of

QMinimum

C)Mdximum

Qstandard Deviation of

(3rfaclion of Total of

Price per person

Refund

Subtotal

Tax

Temp Deptirtrnent

Temp User Name

~ QRunmng total

Cancel
][[

OK

Choose a field

for the formula

to operate on

6. Click OK, and then click Done.

*? Choose FileMaker Help Index from the Q or Help menu, and then type:

summary fields
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Changing field definitions

Important Keep the following in mind:

Deleting a field from a file in the Define Fields dialog box

permanently and irretrievably deletes the field definition and all the

data in that field in all your records. Before you delete a field from a

file, be sure you don't need any data the field contains. To delete a

field from only a layout, see "Deleting a field from a layout" on page

3-59.

When you change the definition of a field that contains data, the data

in that field could be affected. In addition, changing the field type to

container, calculation, summary, or global erases data permanently

and irretrievably.

1

.

Open the file you want to change, and choose Define from the File

menu and then choose Fields.

2. In the Define Fields dialog box, make your changes.

To Do this

Cliange a field

name

Duplicate a field

definition

In the field definitions list, select the field to change. For Field Name,

type or paste the new name, and then click Save. FileMaker Pro also

changes the field name in layouts and field references in formulas.

In the field definitions list, select the field to duplicate, and then

click Duplicate. The new field appears at the end ot the list with copy

added to the name. You can change the field name.

Change the field In the field definitions list, select the field, select a field type, and

type then click Save. ( See "Assigning a field type" on page 2-5,

)

Change data entry In the field definitions list, double-click the field, and then make

options your changes. (See "Choosing data entry options" on page 2-6.)

Change a formula In the field definitions list, douhle-click the field, and then make

your changes. Once you exit the Define Fields dialog box.

FileMaker Pro recalculates the value for every record in the

database.

Reorder field For View by, choose an option from the pop-up menu. To define a

definitions custom order, use the double-arrow pointer to the left of a field

definition to drag an item to another location on the list.

(FileMaker Pro uses the order for all dialog boxes and when it

creates Standard and Single-page form layouts.) Reordering field

definitions does not affect existing layouts.

Delete a field from

the file (and from

all layouts that

contain the field)

In the field definitions list, click the field, click Delete, and then click

Delete again.
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3. Click Done.

Note You can't delete a field that's used in a formula. You must delete

the calculation field or remove the field reference in the formula before

you delete the field. You also can't delete a field used in a calculation

within a script or a field used in a relationship definition.

If a field is placed on a layout in a related database, and that field is later

deleted, a placeholder for the deleted field remains in the related

database. The placeholder contains the text ::<Field Missing>.

*7 Choose FileMaker Help Index from the '^ or Help menu, and then type:
'^

field definitions

:r.T i-- -»'»eS3i«Kr'»awrH?w;st:«E.:WiUffl*8^^



Chapter 3: Laying out and arranging information

This chapter tells you how to create, edit, arrange, and format layouts to

bring together information and graphic elements for display or printing.

Layouts can be displayed on one computer or on a network of

computers.

Important Before you read this chapter, you need to know how to design

a database tile, as explained in chapter 2. "Creating a database file." In

addition, be sure you know how to use FileMaker Pro Help, as explained

in the preface, "Getting help."

Understanding layouts

A FileMaker Pro layout presents data contained in a database. Layouts

determine the appearance of data and organize it for viewing, reporting,

finding, or data entry. A layout does not store data.

Use a layout to selectively display fields in a file. You can have more

than one layout for a file (for example, design separate layouts for

entering data, summary reporting, printing mailing labels, or publishing

a database on the Web using FileMaker Pro Web Companion). You can

have as many layouts for each file as disk space or maximum file size

allows. You can change a layout's design without affecting the data or

other layouts for the file. When you change data in a field on a layout,

the changes are reflected in the same field on other layouts for the

database.
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Data entry form layout Form letter layout

List report layout Mailing labels layout

In a layout you:

add, arrange, and format the fields you want to use

• create summaries of data you want summarized (like a grand total)

specify how to print records

add graphics and text, to add emphasis and interest
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Note Layouts used with FileMaker Pro Web Companion Instant Web
Publishing do not display graphics or text objects when viewed on the

Web. You can create custom HTML pages that include graphics and text

objects when you use FileMaker Pro Web Companion Custom Web
Publishing. For more information, see chapter 1 1, "Publishing files on

the Web."

Text: Use for titles,

column fieadings, field

labels, instructions,

and form letters

Fields; Use for entenng

and displaying data

Parts: Use tieaders, footers,

tfie body, and summaries to

divide a layout into special

purpose areas

Graphic objects: Use lines, rectangles, rounded

rectangles, ovals, and graphics anywhere

on a layout to add interest and emphasis

The page: The chosen printer, current

page setup, and layout type determine

how information looks on the printed page
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You make changes to a layout by using the tools available in Layout

mode.

Layout pop-up menu -

Book.

Tools -

Fill, pen, and line
•

width controls

Zoom controls

*-t-h

Layouts

2a
SHI
[szzra
|p^

'""U'^P

BodM

I
Foa(w

I

Bl L<<)ou« |4l|l

T

I
Employees ]

nil

I

Mode pop-up menu Status area

Part label control

Status area control

9 Choose FileMaker Help Index from the ^ or Help menu, and then type:

layouts, managing
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Working with predefined layout types

FileMaker Pro creates the first layout, a Standard layout, when you

finish defining fields for a new file. A Standard layout contains all the

fields in the database file. It appears in Browse mode, ready for you to

enter data.

Field labels

IFfitName , - J
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To use a predefined layout type, choose New Layout from the Mode
menu, and then select a layout type. To change the layout, use the tools

and commands in Layout mode to tailor the layout for your needs.

Use this layout type To display

Standard All tlie fields in the database file, with field labels, on separate

lines in the viewing order set in the Define Fields dialog box.

You see one record per screen. The layout includes a body and

a blank header and footer.

The fields you want, in columns from left to right, witli a

header thai includes field labels as column headings. If all

fields don't fit across the body. FileMaker Pro wraps them to

the ne.\t line. You see many records per screen. This layout

includes a blank footer.

The fields you want (in columns, with a header that includes

field labels) without wrapping fields to the next line. You can

adjust the t~ield size to see a record on a single line. You see

many records per screen. This layout includes a blank footer.

All the fields in the database file, with field labels, on separate

lines in the viewing order set in the Define Fields dialog box.

It's like a Standard layout, but without a header or footer.

Labels The fields you want, in the arrangement you choose to print on

mailing label stock.

Envelope The fields you want, in the arrangement you choose to print on

a standard business envelope.

Blank The fields you want. A blank layout includes a blank header,

body, and footer.

Columnar report

Extended columnar

Single-page form

FileMaker Pro considers the printer and page setup information when it

displays boundaries and measurements on the layout. When you need to

fit something on the page in a certain way, such as a layout to print data

on preprinted forms, first use the Chooser to choose your printer. Then

select options in the Page Setup dialog box.
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Keep these points in mind:

To see how a layout displays information on the screen, choose

Browse from the Mode menu. To see how a layout will print, choose

Preview from the Mode menu.

You can display a specified layout every time you open a document.

See "Setting document preferences" on page 9-7.

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

predefined layouts

Using Standard, Single-page form, and Blank layouts

Standard, Single-page form, and Blank layouts are good for browsing

and data entry. You can view or add records one by one, with or without

headers and footers. With a Blank layout, you build a custom browse or

entry screen.

The Standard layout is a good choice for use with FileMaker Pro Web
Companion Instant Web Publishing. Text styles and graphics do not

display when you publish a database using Instant Web Publishing, so a

basic layout - such as Standard, Single-page form, with headers and

footers deleted if you like - is all that is necessary. For more information

see chapter 1 1, "Publishing files on the Web."
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A Standard layout contains all the database fields in the body of the

layout, in the viewing order set in the Define Fields dialog box. You see

the field names as field labels to the left of the fields, and a blank header

and footer. A Single-page form layout looks like a Standard layout, but

it doesn't have a header and a footer, and it's vertically the size of one

page (although you can resize it if you like). A Blank layout contains a

blank header, body, and footer. You add the fields for a Blank layout.

Standard layout -

Single-page form layout -

Blank layout

Creating Standard, Single-page form, and Blank layouts

1. In Layout mode, choose New Layout from the Mode menu.

2. In the New Layout dialog box, for Type, select Standard, Single-page

form, or Blank.
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3. Select other options, and then click OK.

To Do this

Give the layout a

different name

For Layout Name, type a name.

Include or exclude To include the layout, select Include in layouts menu. To exclude the

the layout in the layout, deselect this option. (For example, you might exclude

layout pop-up layouts when you want to give users access only to a particular

menu layout.!

Include the layout in the

layout pop-up menu

Select the type of layout to

create

Neuj Lauout :

Layout Name Layout #2

[^ Include in layouts menu

Type
() Standard

O Columnar report

O EHtended columnar

O Sinyle paye form

O Labels

O Enuelope

O Blank

You can rename the layout

4. To enhance or modify the layout, see the appropriate sections later in

this chapter.

Choose FileMaker Help Index from the g£ or Help menu, and then type:

blank layout

single-page form layout

standard layout
:=.. <.>J ,taW.«:S(i;vS«iiE;-<BSj.'!-S

Using Columnar report and Extended columnar layouts

Use the Columnar report and Extended columnar layouts for reporting,

printing, and viewing more than one record at a time in Browse mode.

A Columnar report layout displays and prints fields in columns. Fields

are displayed from left to right across the body, in the order you specify.

Fields that don't fit wrap to multiple lines. Field names appear in the

header as column headings. If the fields wrap to more than one line,

column headings are stacked. The footer is blank.
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An Extended columnar layout displays all fields on one line across the

page. You see each record in one row across the layout, with no

wrapping fields or stacked headings. Use an Extended columnar layout

for browsing; any objects that extend beyond the right edge of the page

won't print. You can also use this layout if the selected fields don't fit

across the page and you intend to make some fields smaller to fit the data

on the page.

lUnatrt '14
]

ClitM first Cli«m Ltsi MdnWuabtr

|Fa» ,,J,^,,^,"~1k^M«sa-^
jP*!!!:J:.-_-_-:=-L

Columnar

report layout

Extended

columnar

layout

Creating Columnar report and Extended columnar layouts

1

.

In Layout mode, choose New Layout from the Mode menu.

2. In the New Layout dialog box, for Type, select Columnar report or

Extended columnar.

3. Select other options, and then click OK.

To Do this

Give the layout a

different name

For Layout Name, type a name.

Include or exclude To include the layout, select Include in layouts menu. To exclude the

the layout in the layout, deselect this option. (For example, you might exclude

layout pop-up layouts when you want to give users access only to a particular

menu layout.)
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4. In the Specify Field Order dialog box, choose fields for the layout,

and then click OK.

Relationstiip pop-up menu

Double-click the fields you

want in ttie layout, in tfie order

you want ttiem to appear

Click to remove all

fields from the list

Drag the double arrows

to reorder fields

First Name
Last Name
Address

City

Post Code

"Home Ptione

Title

C'epartment

Starting Salary

Date of Hire

Last Review Date

Nevt Review

Specify Field Ordqr

I

Cancel

ield Order

t First Name -

* Ldjt Nam*
t Title

• starting Salary

Double-click a field

name to remove it

Click to include all

fields

Click to move a

selected field

5. To enhance or modify the layout, see the appropriate sections later

in this chapter.

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

columnar report layout

extended columnar layout

Using Labels layouts

To set up a Labels layout, you can:

choose from many preset label sizes. Match the number on your label

stock with an option in the label measurements list in the Label Setup

dialog box. When you choose a label type, FileMaker Fro prepares a

layout based on the preset dimensions.

specify your own label dimensions. Measure your labels and match

them to the dimensions of a preset label type. If you use label stock

that doesn't match a label type, set custom measurements for your

labels.

Important Use a Labels layout only to arrange and print data in a format

suitable for labels. Labels layouts do not use fields, they use a special

format of text surrounded by angle brackets (« »). Because of this,

you can't add data to a database file using a Labels layout. To add data,

use a different layout type.
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The sample label contains

tlie fields you specify in the

Specify Layout Contents

dialog box

For all labels layouts, you specify the data to print on each label. For a

custom labels layout, specify the number of labels across the page and

the label dimensions. FileMaker Pro then divides the body of the layout

into the number of labels across the page. The leftmost label is a sample

of a single label on a layout, and the rest of the labels across the page are

dimmed.

The dotted vertical line shows where

the next label across starts

"?
I
Choose FileMaker Help Index from the ^ or Help menu, and then type:

labels layout

Setting up to print on labels

Before you set up a Labels layout, select a printer and set up the page for

the size of your label stock.

If you print on a laser or ink jet printer, set the paper size to match

your sheet of labels.



Laying out and arranging information 3-13
1

If you use continuous-feed stock (like tractor-feed labels) and a dot

matrix printer, create a custom paper size equal to the height of one

label. Use a custom paper size to minimize the back-and-forth

movement of the platen and save label paper.

To Do this

Select Ihe printer Choose Chooser from the Apple menu, and then select a printer.

Set a paper size for Choose Page Settjp from the File menu. Select the size of the

a laser or ink jet mailing label sheets you plan to use (usually US Letter in the U.S.

printer and A4 elsewhere), and then click OK.

Create a custom Choose Page Setup from the File menu. Select a Paper option you

size for a dot-matrix rarely use. At the Edit Paper Sizes options, for Mame, type a name,

printer type values for Width ( the width of a sheet of labels ) and Height (the

height of one label, up to 36 inches), and then click Save. Select I\l0

Gaps Between Pages, and then click OK.

Keep these points in mind:

Depending on the printer and version of the system software you use,

the Page Setup dialog box might contain different options. See your

printer manual.

To make sure the printer uses the full paper height for each label

when you're using a dot-matrix printer, select No Gaps Between Pages.

If you change the dimensions of a standard page size in the Page

Setup dialog box and you're using a dot-matrix printer, change the

name to recognize the dimensions as custom. To restore the preset

size, click Restore.

'P Choose FileMaker Help Index from the 05 or Help menu, and then type:

printing, labels

Creating a Labels layout

1

.

In Layout mode, choose New Layout from the Mode menu.

2. In the New Layout dialog box, for Type, select Labels.

3. Select other options, and then click OK.

To Do this

Give the layout a For Layout Name, type a name,

different name
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To Do this

Include or exclude To include the layout, select Include in layouts menu. To exclude the

the layout in the layout, deselect this option. (For example, you might exclude

layout pop-up layouts when you want to give users access only to a particular

menu layout.)

4. In the Label Setup dialog box, select options, and then click OK.

To Select

Use preset label

dimensions

Use label measurements for and then choose a label option.

Create custom Use custom measurements, and then type values tor Labels across the

measurements page. Width, and Height. See "Creating custom labels" on page 3-16.

Select preset labels or -

custom measurements

Width is the distance from .

the left edge of one label to

the left edge of the next label

Height is the distance

from the top edge of the

first label to the top edge

of the next label

Label Setup :

O Use label measurements for
|
Huery 12-290

<i) Use custom measurements:

Labels across the page

Vidth

Current Page Setup

8 500 wide by 1 1 000 high

i^O

5. In the Specify Layout Contents dialog box, select and arrange fields

for the labels, and then click OK.

To Do this

Select fields for the labels In the fields list, double-click the fields you want, in the

order you want them to appear.

Place a field on a new line Press Return at the end of the previous line.

Display a punctuation mark For Layout contents, set the insertion point before or after

(like a comma) between field the « or » characters around a field name, and then

values click a punctuation button.

Display a space between field For Layout contents, click between field names where

values you want a space, and then press the Space bar.
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To Do this

Remove a field name from the For Layout contents, select the field name and« and»
layout contents characters, and then press Delete.

Remove all field names and

characters from the layout

contents

Click Clear All.

Relationship pop-up menu -

Fields list -

Field names arranged in a label -

: Specify Layout Contents
:

Curf*rit Fil^ T'Emfilcij^.

Frst Name
Last Name
Address

City

Post Code

Home Phone

Title

Layout contents

[ Clear HII
]
F

First Name>* <<Last Name*
Title>>

Address >>

«City>>, <cPost Code>>

Click to add

punctuation

characters

6. In the layout, adjust or delete the header, if necessary.

See "Resizing parts" and "Deleting layout parts" on page 3-36.

If you're using Do this

A laser or inlc jet printer Set the header to the top of the first row of labels. The

layout header compensates for the nonprintable area.

If the labels are small, try setting the header to the top of

the second row of labels. FileMaker Pro won't print on

the first row of labels, but it prints in the correct position

on subsequent labels.

A dot matrix printer Delete the header, if there is one. Click the pan label, and

then press Delete.

7. Adjust the margins, if necessary.

See "Setting margins for labels" on page 3-16.

8. To enhance or modify the layout, see the appropriate sections later in

this chapter.

Note Depending on the labels you choose, the layout may contain a
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blank header. If the first label starts at the top edge of the paper, set the header

height to the height of the label so that printing starts on the second row of

labels on the page.

O Choose FileMaker Help Index from the CS or Help menu, and then type:

labels layout

Creating custom labels

If you don't see the size of your labels in the pop-up menu in the Label Setup

dialog box, try to match your label dimensions with a preset type. To do this,

add the space between labels to the label width and height to determine the

horizontal and vertical pitch (the width of the left edge of a label to the left

edge of the next, and the length of the top of one label to the top of the next).

Side margin ,^_ Horizontal pitch

Label width —
Top margin

Label height

Vertical pitch

*? Choose FileMaker Help Index from the [2) or Help menu, and then type:

labels layout

Setting margins for labels

You can set margins that reflect the width of labels you're printing on. If you

set a top margin, you don't also need a header on your layout.

1

.

In Layout mode, choose Layout Setup from the Mode menu.

2. In the Layout Setup dialog box, select Fixed page margins, and then type

values for each margin.

3. Click OK.
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Turn page margins on to see how your page will print. For more

information about setting margins and printing, see "Setting

margins" on page 6-4.

9 Choose FileMaker Help Index from the iX' or Help menu, and then type:

printing, labels

Printing labels

Before printing on label stock, practice printing on regular paper. If

you're having trouble with alignment, try adjusting the header size,

margins, or paper size.

You can also try the following tips for specific printer problems.

For this printer Select

Laser or ink jet printer Larger Print Area after clicking Options in the Page Setup dialog box.

See "Printing" on page 6-12.

Dot matrix printer Enable Print Spooling in the Print dialog box to minimize the rollback

of the platen.

For more information about printing, see "Previewing before printing"

on page 6-1 1 and "Printing" on page 6-12.

9 Choose FileMaker Help Index from the 2i or Help menu, and then type:

printing, labels
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Using Envelope layouts

The Envelope layout arranges fields for printing on standard business

envelopes. It includes a header.

jEnvfflop* I

HMdw I

|K-|Jg^-l«-l

lOoUiiplBI i.^~t . i^miii"

<<ClienlFirsr>> <<Ch«ntLi

<<ClieniTr(le>>

<<Coinp*nvNNn*>>

< (Address l>>

< (Address J>>

<<Ciry>., <iPoil Cod*>i

~M

Important Use an Envelope layout only to arrange and print data in a

format suitable for envelopes. You can't add data to a database file using

an Envelope layout. To add data, use a different layout type.

Setting up to print on envelopes

Before you create an envelope layout, do the following:

Choose the printer (see "Setting up to print on labels" on page 3-12).

In the Page Setup dialog box, select US Letter (for U.S., or A4 for

elsewhere). Don't choose an Envelope paper size.

If you feed the envelopes into the printer short-side first, choose a

landscape (horizontal) paper orientation. If you feed the envelopes

into the printer long-side first, choose a portrait (vertical) orientation.

Creating an Envelope layout

1

.

In Layout mode, choose New Layout from the Mode menu.

2. In the New Layout dialog box, for Type, select Envelope.
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1

3. Select other options, and then click OK.

To Do this

Give the layout a different name For Layout Name, type a name.

Include or exclude the layout in To include the layout, select Include in layouts menu. To
the layout pop-up menu exclude the layout, deselect this option. (For example,

you might exclude layouts when you want to give

users access only to a particular layout.)

4. In the Specify Layout Contents dialog box, select and arrange fields

for the envelopes, and then click OK.

To Do this

Select fields for the envelopes In the fields list, double-click the fields you want, in the

order you want them to appear.

Place a field on a new line Press Return at the end of the previous line.

Display a character (like a

comma) between field values

For Layout contents, set the insertion point before or after

the « or » characters around a field name, and then

click a character button.

Display a space between field

values

For Layout contents, click between field names where

you want a space, and then press the Space bar.

Remove a field name from the

layout contents

For Layout contents, select the field name and« and»
characters, and then press Delete.

Remove all field names and

characters from the layout

contents

Click Clear All.

Relationship pop-up menu

Fields list

.

Field names arranged

in an envelope

: Specify layout Contents \

I

Current File p Emploij^.

First Name
Last Name
Address

City

Post Code

Home Phone

Title

ij [ Clear Rll
|

<Fir£tName>> '<Last^

' Address >>

<City>>, <<Post Code>>

r^^
Click to add

punctuation

characters
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5. To enhance or modify the layout, see the appropriate sections later in

this chapter.

Note Depending on the printer you use, you might not need the header.

If you Do this

Manually feed envelopes into a

center-feed printer

Keep the header and adjust it, as necessary, to

match the printing to the envelope size.

Manually feed envelopes into a right

edge-feed printer

Keep the header and adjust it, as necessary, to

match the printing to the envelope size. (A good

rule of thumb for the header size is to subtract the

envelope height from 8.5 inches.)

Manually feed envelopes into a left

edge-feed printer

Delete the header, and insert a footer. Adjust the

fooler, as necessary, to match the printing to the

envelope size.

Use a laser or ink jet printer that

automatically feeds envelopes

Choose Page Setup from the File menu, and then

select No. 10 Envelope paper size. Customize the

Envelope layout, and then delete the header.

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

envelope layout

Arranging records in columns

Instead of using a Columnar report or Extended columnar layout, you

can set columns for a layout. For example, print phone directories with

the records in several columns. Print records:

down the page (column by column), for reports like directories,

where you read from top to bottom, column by column

across the page (row by row), for reports like mailing labels, to use

the fewest number of rows and conserve label stock

Each block is a record

3 -J

4

T
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It's easiest to start with a Blank layout or a layout with no objects in the

body. Before you set up columns, choose the printer to use and set the

page setup options you want.

To set columns in a layout:

1

.

In Layout mode, choose the layout name from the layout pop-up

menu.

2. Choose Layout Setup from the Mode menu.

3. In the Layout Setup dialog box, click Print in <value> columns.

4. Select options, and then click OK.

To
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Keep these points in mind:

You only see columns when you preview or print data; you don't see

columns in Browse mode.

In the sample (leftmost) column in the layout, make adjustments to

keep the fields within the column, and arrange the information that

prints for each record.

To Do this

See data in fields that extend

beyond the first column into the

gray area of the second column

Select the fields to slide, choose Sliding/Printing from the

Format menu, and then select options. See "Sliding

objects and parts" on page 6-7.

Adjust the size of all the

columns at once

Drag the vertical dashed line immediately to the left of

the gray area to change the column width.

To see how wide the column is Choose Size from the Show menu. Position the pointer

over the vertical dashed line and hold down the mouse

button (be careful not to change the column width). You
see the column width in the Size palette.

See how the records wil

in columns

I print Choose Preview from the Mode menu.

When you print records in columns down the page, FileMaker Pro

prints subsummary parts the width of the column. If the subsummary

part controls a page break, FileMaker Pro starts a new column (not a

new page). When you print records in columns across the page,

FileMaker Pro prints subsummary parts across the width of the page,

and then starts a new page if the part controls a page break. (See "About

summary layout parts" on page 3-29.)
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To change the placement of records (across first or down first) and the

number of columns, choose the layout from the layout pop-up menu,

and then choose Layout Setup from the Mode menu. Change the

options, and then click OK. (To remove the column setup, deselect

Print in columns.)

*? Choose FileMaker Help Index from the gS or Help menu, and then type:

records, in columns
f."-5w^5iSS:5a5:53S5r<3ai033aBWK3^5!aT

Managing layouts

In Layout mode, you can change layouts without changing the

information in the associated database file.

To Do this

Switch layouts Choose a different layout from the layout pop-up menu.

From the layout pop-up menu, choose the layout to duplicate, and then

choose Duplicate Layout from the Mode menu. A duplicate of the layout

appears last in the layout pop-up menu, with Copy appended to the

name. (Depending on the layout, you may want to duplicate it before

making changes.

)

From the layout pop-up menu, choose the layout to delete. Choose

Delete Layout from the Mode menu, and then click Delete in the alen

message. A database must have at least one layout at any time, so you

can delete all layouts except the last remaining one. You can't undo

deleting a layout.

From the layout pop-up menu, choose the layout to rename, and then

choose Layout Setup from the Mode menu. For Mame, type a new name,

and then click OK.

Reorder layouts in Choose Set Layout Order from the Mode menu. Drag the layout name to

the layout pop-up the position you want, and then click OK.

^^"^
In a multiuser database, only the host can reorder layouts, and only

when the database isn't being shared.

Include or exclude Choose Set Layout Order from the Mode menu, and then choose a

the layout in the layout. To include the layout, select Include in layouts menu. To exclude

layout pop-up the layout, deselect this option. You see a checkmark next to the name

menu of a layout that's included in the layout pop-up menu.

Duplicate a layout,

to design a new one

Delete a layout

Rename a layout

9 Choose FileMaker Help Index from the G9 or Kelp menu, and then type;

layouts, managing

layout pop-up menu
iaiS8»«iHlHaafflgigahJ58f8Mi3»agT<? ai.i&.oii.i^jKccs.'ic:
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Working with layout parts

FileMaker Pro layouts are divided into parts, which are areas in a layout

that tell FileMaker Pro how to display and print data and text within each

part. For example, by using parts, you can tell FileMaker Pro to print

data:

once for each record

only at the top of each page

only before or after groups of sorted records

only once on the first page of a report

Header -

Body-

Subsummary

-

Trailing Grand -

Summary

Footer
-

i
Employees I

Employee Repoit

E(.'erj'Where

Header 1
Piral Name Tiae Depaitmem

IFuslHa/ne" "ItLaattlajnT" "IITiile ipemtmitM

ForOepartneni jDepartOiem Toldl Enployecs |TOBll

Sub-summanj bij Department (Trailing)

Trailing Grand Summarij

E'^O^^re Travel Confldenual

Fooiar
\

TEHwrmmwEmmmEm

A subsummary below the

body summarizes data for

each group of records

sorted on the break field

(Department)

Trailing grand summary

Footer -

Ev«ry\Vlie*»

f irat Bmmm

Einployev Re|>ort

Uh<
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Each layout must have at least one part. Choose from eight different

layout parts, as described in the following table.

Layout part Description

Header Use for column headings, titles, graphics, and other infomiation that will

appear only at the top of every page. For example, include a header for a

directory. FileMaker Pro displays the header in Browse mode and prints it

on every page, except the first page if you add a title header. Fields added

to a header are printed on every page, using data from the first record on

that page. You can delete the header from any layout.

Body

Subsummary

Leading grand

summary

Trailing grand

summary

Put everything you want to appear in each record, including fields, text,

lines, and graphics, in the body. The contents of the body are printed for

each record in the current found set. When you print records.

FileMaker Pro pnnts the body for as many records as can fit on the page

with the other parts. You can change the size of the body to change the

amount of space used for each record. The body is the only part used with

FileMaker Pro Web Companion Instant Web Publishing.

Prints a summary of information for each group of records sorted on the

break field. You can add one or more subsummaries above or below the

body. See "About summary layout parts" on page 3-29.

Use to summarize all records being browsed above the data in individual

records. You can use only one leading grand summary. See "About

summary layout parts" on page .3-29.

Use to summarize all records being browsed below the data in individual

records. You can use only one trailing grand sunimary. See "About

summary layout parts" on page 3-29.

Footer Use for page numbers, dates, graphics, or any other information you want

to appear only at the bottom of every page. FileMaker Pro displays the

footer in Browse mode and prints it on every page, except the first page if

you add a title footer. Fields added to a footer are printed on every page,

using data from the last record on that page. You can delete the footer from

any layout.

Title header Use for printed reports. The title header replaces the regular header on the

first page only. For example, put a report title in the title header. Use the

regular header on the other pages of the report for information like a

chapter name.

Title footer Use for printed reports. The title footer replaces the regular footer on the

first page only. For example, put the author and date in the title footer. Use

the regular footer on the other pages of the report for information like page

numbers.

Every predefined layout type includes the body part. Most layouts,

including the Standard layout, also have a header part and footer part. A
layout can have only one header, body, and footer.
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You can put fields, graphic objects, and text in any layout part. For

example, put your company logo as a graphic object in the header and

place a horizontal dividing line at the bottom of the body.

Title -

header

Title —
footer

j Employees 1

'Em^ym Ktepant: $ms TmMs
Everywhere

PiisiName
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Adding layout parts

You can add a new part to a layout or replace one you deleted. First add

the part, and then specify the kind of information to appear in it.

A dotted line defnies the bottom of a layout part, and the part label to the

left of the line identifies the part.

Part tool -

Part label -

Neui Tours i

Avdilablf T 1

a
<-f-+

HA
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To add a layout part:

1

.

In Layout mode, choose Part Setup from the Mode menu.

2. In the Part Setup dialog box, click Create.

List of parts in the

current layout

Part Setup
]

a Header
< Body
fi Footer [

Create...
)

[
Change...

]

(
Delete ]

3. In the Part Definition dialog box, select options.

Select the type of -

part to create

Select options for page

numbering and breaks

: Part Derinition ;

O Title Header

Q Header

Q Leading Grand Summary

O EoJn

(•) Sub-Summary when sortH by

Q Trailing Grand Summary

O Title Footer

irreTit File I "EnipTrnjei 3
First Name
Last Name
Address

City

Post Code

Home Phone

Title

Department

I I
Page break before each occurrence

I I
Page break after every M occurrences

I I
Restart page numbers after each occurrence

Q Allow part to break across page boundaries

[ I
b^s•:i^4 remjinder of part before new pa']-

Cancel

For subsummaries, select the

field ttie records will sort by

(break field)

4. Click OK, and then click Done.

Keep these points in mind:

To set options for parts and to add subsummary and grand summary

parts to layouts, see '^Changing part types and options" on page 3-36

and "Adding a summary part" on page 3-31.

To resize layout parts, change what they contain, or remove all but

one of them, see "Changing layout parts" on page 3-35.
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To print a cover page for a report, make the title header large enough
to cover a page. You can then add a regular header, a regular footer,

and any other layout parts you want to appear on subsequent pages.

"? ? Choose FileMaker Help Index from the OB or Help menu, and then type:

layout parts, defining

Adding objects to a layout part

You can add fields of any type, graphic objects (like lines, rectangles,

ovals, and pictures), and text in all layout parts. (To add objects to a part,

see "Working with all object types" on page 3-37.)

Important FileMaker Pro considers an object to be in a part when the top

of the object is in or just touching the part. For example, to print a box

only when the header prints, put at least the top of the box in the header.

Or if the top of a field touches the bottom of a header, the field becomes

part of the header, and its contents won't print or display after the first

record.

O Choose FileMaker Help Index from the GS or Help menu, and then type:

objects, creating

About summary layout parts

Use summary parts to view and display information from one or more

records. You place a summary field in a summary part to perform the

summary. (To define summary fields, see "Defining summary fields" on

page 2-23.)

Summary part Description

Leading grand summary Al the beginning of a report, summarizes all the values in a

summary field for all records being browsed. You can have only

one leading grand summary in each layout. If you put

nonsummary fields in a leading grand summary. FileMaker Pro

prints the data in that field for the first record being browsed.

Leading subsunimary Before the body of a report, summarizes the values in a summary
field for a group of records. You sort the records according to the

break field for that part to create groups that have the same value

for that field. If you put nonsummary fields in a leading

subsummary, FileMaker Pro prints the data in that field for the

first record of the group being summarized.
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Summary part Description

Trailing subsummary Same as leading subsummary, except it displays the subsummary

after the body of the report and prints the data for the last record of

the group being summarized for any nonsummary fields in the

part.

Trailing grand summary Same as leading grand summary, except it displays the grand

summary at the end of a report and prints or displays the data for

the last record being browsed in any nonsummary fields in the

part. You can have only one bailing grand summary in each

layout.

Place a subsummary pan,

containing only the Department

field, above the body to place

the department name ahead of

that group of records -

Place a subsummary part, -

which totals the employees

for each Department,

below the body

You can start a new page for any subsummary part. See "Paginating a

layout" on page 3-32.

I
HHder jme Laa! Mame

Employees i

Emfi'^miJ^

Everywhere

Exttmion Depaitmeni

For Department [Depaitmeitt

I
Sub-swTwnanj bg DejMrtmgnt ClMdinq) "j

|FirgtHam£~ 1 jLftgt Name~ jmi "l lExffixaipaJ IDejaltnoeat
I

[Ml]

Total Employees IToMgmitoyel

I
Sub-summanj b>j Ogpartnwn^ (Trailing) I

For Everyvhere Travel

I
Traflinq Grand Summanj

Everywhere Trgvel Confidential

Footer

33'OoUaiPIBI t'VO-' KJ-it l

Total Employees [Total EjBJloys]

Use a grand summary to view the total

number of employees in the company

'P Choose FileMaker Help Index from the CS or Help menu, and then type:

parts, layout
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Adding a summary part

1 . Add a summary part.

See "Adding layout parts" on page 3-27.

2. In the Part Definition dialog box, select a summary type.

If you click Sub-SUmmary when sorted by, also select the field to sort

by (the break field). To define a summary field, see "Defining

summary fields" on page 2-23.

3. Select page numbering and page break options, click OK, and then

click Done.

For information on the options, see "Paginating a layout" on page

3-32.

4. In the layout, drag the summary field into the summary part.

See "Adding fields to a layout" on page 3-56.

5. If you added a subsummary part, sort the records according to the

break field (specified when you created the part).

See "Sorting records" on page 4-30. '

Keep these points in mind:

The break field groups the records. Each time a group starts or

finishes printing, the leading or trailing subsummary is displayed.

When you view records as a list in Browse mode, subsummary parts

aren't displayed. To see subsummary parts in a View as List layout,

print the file, or switch to Preview mode.

If you add a summary part to a layout that doesn't include a body part,

FileMaker Pro lets you specify whether you want the summary above

or below any body part you might add later on.

To see summaries for groups of sorted records, move the summary
fields into a subsummai^ part. To see summaries that total all records

in the found set, move the summary fields into a Leading grand

summary or Trailing grand summary part.
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FileMaker Pro previews and prints correct subsummary values only

after you sort the records. Sorting groups the records by the value in

the specified field (break field), so the subsummary totals all records

with the same value in that field. You can sort by more than one field

to add another level of grouping to your data.

ZJ
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2. In the Part Definition dialog box, select an option.

To Select With these layout parts

Start a new page before

pnnting the contents of tlie

part (for example, print a

trailing grand .summary on a

new page)

Page breal< before eacti

occurrence

Start a new page after pnnting

the content.s of the specified

occurrences of the part ( for

example, print five records in

the body, and then start a new
page)

Page break after every

<value> occurrences

Stan page numbering from

the beginning after printing

the pan (for example, stan

page numbering after the title

header if you want it to serve

as a cover page

)

Restart page numbers after

each occurrence

Subsummary when sorted by

Body

Trailing subsummary

Trailing grand summary

Leading grand summaiy
Subsummary when sorted by

Body

Trailing grand summary

Title header

Header

Leading grand summary
Subsummary when sorted by
Body

Footer

Print the entire contents of the

part even if it doesn't fit on

one page ( for example, divide

and print the body across two
pages when it doesn't fit on a

single page with the other

parts)

Allow part to break across

page boundaries

Leading grand summary
Subsummary when sorted by

Body

Trailing grand summary

Print as much of the contents

of a part as fits on the page but

not finish printing it on the

next page (for example, print

the information in a Notes

field to the bottom of the page

and truncate the rest

)

Discard remainder of part

before new page (available

only if you select Allow

part to break across page

boundaries)

Leading grand summary
Subsummary when sorted by

Body

Trailing grand summary

3. Click OK. an(J then click Done.

Keep these points in mind:

If you .set column options to print records down the page and specify

a page break for a subsummary part, FileMaker Pro starts a new
column, and not a new page, when you preview or print records. If

you print records in columns across the page. FileMaker Pro starts a

new page if the subsummary part includes a page break.

If the body or a summary part is too large to fit on a page between the

header and the footer, you see a dashed line on the layout to show
where the part will be divided. (This can change if you set sliding

options. See "Sliding objects and parts" on page 6-7.)
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If the whole body of another record won't fit at the bottom of a page,

FileMaker Pro prints it on the next page, unless you set the option to

break parts across pages or the body can't fit on a single page.

The amount of extra -

space above and below

ttie objects in the body

determines the spacing

between displayed or

printed records

I Neu> Tours j

Available Tours

Everywhere

HM<)tr~i

Cniise Ship [CrUlS^ ^hW~

Tour length |T.'(Jf feMjjtfl

^ Cnitsc Dcslinnlton ICfUtSe Dg^IIAtlvn

Cruise *b«(csalc price [Crm£tf_WhQte5dl'^-priLy

Seesoii )Ojprin<j QSummer QAut ijmn QWinter QAIIy^ar |

I 8«>l I

SI
Available Toui-s

dUBl i-^ro^ lOIIl

•3ruid tvbnwvh cruiK 0(iin*i«> M*sk^

7 nghlS CrullE WWIdt «•(» 17^S

OSpnifl (JiSummer riAulumn Q**"**' 0*" V*"
GIdciei rouiie belwcttn Vwicouvier and Anchorage Includes

7 nights
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Changing layout parts

Change layout parts as described in the following sections.

Reordering parts

You can change the order of the body and subsummary parts only. For
example, move a subsummary above the body to see subtotals first.

FileMaker Pro moves all the objects in the reordered part and maintains

its proportions.

1

.

In Layout mode, choose Part Setup from the Mode menu.

2. Use the double-artow pointer to drag the part to the new position.

3. Click Done.

This symbol indicates a locl<ed -

part—you can't ctiange it

Use the double-arrow -

pointer to drag a part

Part Setup
;

-a Title Header
6 Header
* Sub-summary by Department ILeadingI
< Body
* Sub-summary by Department ITraihngI

a TraMlng Grand Summary
6 footer

CbangerT]

|_Done_J]

Pail label control

(at bottom of window)

Keep these points in mind:

In Layout mode, you can click the part label control at the bottom of

the screen to move the part labels to a vertical position (for more
room on the layout). To read vertically displayed part labels more
easily, temporarily flip down the labels by holding down the mouse
button when the pointer is over the label.

You can have only one leading and one trailing subsummary part

based on the same field. You can't move a subsummary based on a

field to where another subsummary based on that same field exists.

*? Choose FileMaker Help Index from the® or Help menu, and then type:

layout parts, managing
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Resizing parts

When you resize a layout part, FileMaker Pro always maintains the size

of the other parts. For example, changing the size of the header won't

change the size of the body.

In Layout mode, use the pointer to drag the part label (or the dotted line

below the part) until the part is the size you want.

^ Choose FileMaker Help Index from the CS or Help menu, and then type:

layout parts, managing

Changing part types and options

You can change a layout part's type and options, including the break

field, numbering, and page break settings in the Part Definition dialog

box.

To display the Part Definition dialog box. double-click the part label in

the layout or see "Adding layout parts" on page 3-27.

To change
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3. If the part contains objects, click Delete in the alert message.

4. Click Done.

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

layout parts, maiidging

gaaaigasasag£igs«g;;gffi»3'gwi^gjy;s.j - ff^T^i'gw^^itTJSMi.yrMY

Working with all object types

An object is a separate element—text, a field, or a graphic object (such

as an oval or an imported picture)—that you can draw, select, move,
resize, delete, copy, and otherwise change. You place objects in a layout

to design how the layout looks and works. For example, add the title

Invoice, or emphasize a group of fields by enclosing them in a shaded or

colored rectangle.

I

Layout "}
I

lA \
o o

s_

|Pi^

|K.|%,|S.|

Employees i

Tex* object

Recta nge Rounded

Rectangle

^"'"7 [Salary

Text Field

I
Bo<v I

Lag outBBI

Note Another type of object is a portal, which displays related records.

For more information, see "Creating a portal to hold related fields'" on
page 10-23.
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Working with the drawing tools

For each type of object you work with, you use the various tools in the

status area of the Layout window.

Tool panel

Button tool

Field tool

Fill controls -

Pen controls

alQlo
^ r -I

i. J"

F.is.ld.. 3
IS^i

^m

Portal tool

Part tool

Line wldtti palette

Status area control

(at the bottom of the window)

No tools visible? Choose Layout froin the Mode menu, and then click the

status area control at the bottom of the screen.

Use the following techniques to work with the tools:

To Do this

Use a tool once Click a tool to select it. (The tool becomes gray.)

Keep a tool selected Double-click a tool. (The tool becomes black to

indicate it remains selected until you select a different

tool.) To set an option to keep layout tools selected,

see "Setting layout preferences" on page 9-3.

Switch between the tool last used

and the pointer

Press Enter.

*? Choose FileMaker Help Index from the |2I or Help menu, and then type:

» tool panel •
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Selecting objects

Whenever you want to work with an object, you must select it first. You
see handles, small black squares along the boundaries of a selected

object.

iDeparUn^nt r
Handles Surround

' r-^ a selected obiect

To select an object, use the pointer tool or choose Select All from the Edit

menu.

To select Do this

One object With the arrow pointer, click the object. (If the object has no fill, click

its border.)

Several objects at Drag the arrow pointer to make a selection box that completely

once surrounds the objects. Or hold down Shift and click the objects. Or
choo.se Select All from the Edit menu.

All objects of the Click the tool for the type of object to select, and Uien choose Select All

same type from the Edit menu.

All fields With the arrow pointer, click a field, hold down Option, and then

choose Select All from the Edit menu.

Deselect selected Click a blank area of the layout or any tool in the tool panel. Or hold

objects down Shift and click the selected object.

Y Choose FileMaker Help Index from the Q or Help menu, and then type:

objects, changing

objects, selecting
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Positioning and sizing objects

Use the text ruler, graphic rulers, ruler lines, T-square, AutoGrid, and

Size palette to size, position, and align objects.
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The following information tells you how to use each guide.

To show or hide the rulers, ruler lines, or T-square, choose Text Ruler,

Graphic Rulers, Ruler Lines, or T-Squares from the Show menu. For

infomiation about the text ruler, see "Fonnatting text paragraphs" on

page 3-84.

To switch the Auto Grid on or off, choose AutO Grid from the Arrange

menu. To temporarily disable the AutoGrid, hold down Command
while dragging an object.

To adjust the T-square, place the pointer on the horizontal or vertical

line. When the pointer is a double arrow, drag the line. (To see the

position of the T-square in the Size palette, choose Size from the

Show menu, position the pointer over the T-square, and then hold

down the mouse button.)

To position an object using the Size palette, select the object, and then

choose Size from the Show menu. Type the measurements for the

position you want, and then press Return or Enter. (The unit of

measure is that set for the graphic rulers.) You can close the palette

or leave it open.

Type the distance from ttie

left edge of the page to the

left edge of the object

Type the distance from the top of the page to the

- top edge of the obiect

FileMaker Pro updates measurements for right

and bottom edges based on the object's width

and height

To position an object precisely by dragging it, choose Size from the

Show menu. Drag the object until you see the position you want in

the Size palette.

To set the unit of measure—inches, centimeters, ot pixels (dots that

make up the graphic on a computer screen)—for rulers and ruler

lines, click the box where the graphic rulers intersect. When the Size

palette is open, click the units label.

On this ruler
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To change the unit of measure for the graphic rulers and the AutoGrid,

choose Set Rulers from the Mode menu. Make your selections and

click OK. (You can choose different units of measure for the rulers and

the AutoGrid. If you change units for the AutoGrid, you change the

increments by which objects are snapped "to" the grid.)

Choose a unit of

measure for the rulers

Type the number of units for

the AutoGrid, and choose a

unit of measure

Note To align objects to each other, see "Aligning objects to each other"

on page 3-48.

^ Choose FileMaker Help Index from the £2 or Help menu, and then type:

objects, positioning

text ruler

Editing objects and data quickly using the context menu

You can quickly edit an object or data by choosing editing commands

directly from the context menu. You can display the context menu for all

objects in Layout mode and for fields and selected text in Browse mode.

In Layout mode, hold down Control, and then click and hold down the

mouse button while the pointer is on an object to edit. In Browse mode,

hold down Control, and then click and hold down the mouse button

while the pointer is on a field or data to edit.
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The commands in the context menu depend on the type of object

selected. For example, when a text object is selected in Browse mode,

you see text formatting commands like Font, Size, and Style. When the

object is selected in Layout mode, you see additional commands like

Specify Field and Field Borders.

Text

Specify Field.,,

Field Format,

Field Borders.,

Fill

Pen

Cut

Copu

Pa=te

Editing a text field in Layout mode

Font
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Arranging objects

The following sections explain how to arrange graphic objects, fields,

and text on a layout.

For infonnation on using the AutoGrid. rulers, T-square, and other

alignment guides, see "Positioning and sizing objects'" on page 3-40.

Moving objects

To move Do this

One object Select the object, and then drag it to the position you want. (To

constrain the movements to horizontal or vertical directions, hold

down .Shift as you drag the object.)

Several objects at once Select the objects, and then drag them to the position you want.

(To constrain the movements to horizontal or vertical directions,

hold down Shift as you drag the obiects.)

An object to a different Select the object, and then choose Cut from the Edit menu. Move
layout to the other layout and choose Paste from the Edit menu. Then drag

the object to the position you want.

You can use draa and drop to move objects to different layouts in

other files. See "Using drag and drop to move information" on

page 4-13.

An object to a different Select the object, and then choose Cut or Copy from the Edit menu,

application or desk Open the other application or desk accessory, bring it to the front,

accessory and then choose Paste from tlie Edit menu.

Keep these points in mind:

You can quickly and easily move one or more objects to a different

location in the cunent file or to a different file or application by using

drag and drop. See "Using drag and drop to move information" on

page 4-13.

If you drag a handle by mistake and resize the object, choo.se Undo

from the Edit menu before you do anything else in FileMaker Pro.

^ Choose FileMaker Help Index from the (2) or Help menu, and then type:

objects, positioning
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Cutting, copying, and pasting objects

To Select the object, and then do this

Make one copy of

(duplicate) an object

Choose DtJplicate from the Edit menu (or hold down Option and

drag the object). Then move the object to the position you want.

Remove an object to

paste it elsewhere

Choose Cut from the Edit menu. To paste the object elsewhere,

click where you want to insert it. and then choose Paste from the

Edit menu.

Paste a copy of an object Choose Copy from the Edit menu. Click where you want to insert

elsewhere the object, and then choose Paste from the Edit menu.

Paste a cut or copied Choose Cut or Copy from the Edit menu. Switch to the other

object onto a different layout, and then choose Paste from the Edit menu,

layout

Delete an object Choose Clear from the Edit menu (or press Delete). FileMaker Pro

permanently doesn't place your selection on the Clipboard, and you can't paste

it anywhere.

Keep these points in mind:

To restore an object that you deleted, choose Undo from the Edit

menu before you do anything else in FileMaker Pro.

An object you cut or copied stays on the Clipboard until the next time

you cut or copy objects or infomiation (in FileMaker Pro or another

application), or turn off your computer.

To edit text in a text object, see "Working with text" on page 3-79.

Choose FileMaker Help Index from the gS or Help menu, and then type:

objects, ctianging
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Stacking objects and changing the stacking order

You can create a design in which you stack objects by creating or

dragging them on top of each other. Objects are preset to stack in the

order you create them—the first object created is on the bottom, and the

last one is on top. You can change the order in which objects are stacked.

ffwm
Before

Bring to front

Send to back

Bring forward

Send backward

After

1 . In Layout mode, select the object to move in the stack.
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2. Choose a command from the Arrange menu.

To move the object Choose

T(i Ihe lop of the slack
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Aligning objects to each other

You can align (line up) objects by their tops, bottoms, or sides. For

example, align a field label with its field so that the label is centered

between the field's top and bottom border.

When you align a group of objects, they align with the object farthest in

the chosen direction. When you align center points, the objects align

along an invisible vertical or horizontal line in the center of the objects.

You can also distribute the space evenly between objects by dividing the

space that separates the two outermost objects between all selected

objects.

IChent.firjst.
|

Client Firs)
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You can select from both columns.

Select the way you want

objects aligned vertically

See the results of your choices -

Set Rliqnment

Top to Bottom

() None

O Align lop edges

(^ Align centers

Q Align bottom edges

(3 Distribute space

Sample

D

L»ft to Right

<•) None

Q Align left edges

Q Align centers

Q Align right edges

Q Distribute space

Select the way you

want objects aligned

horizontally

Keep these points in mind:

To align new objects according to tine current settings, select the

objects to align, and then choose Align from the Arrange menu. (If the

settings are both None, the command is unavailable.)

To align two objects without moving one of them, select one object,

and then choose Lock from the Arrange menu. Next, select both

objects, and then choose Align from the Arrange menu. (For

information on locking objects, see "Protecting objects from change"

on page 3-52.)

'P Choose FileMaker Help Index from the 12) or Help menu, and then type:

aligning objects

Rotating objects

You can rotate fields, text objects, and graphic objects in 90-degree

increments.

To rotate a field, text object, or graphic object, select the object, and

then choose Rotate from the Arrange menu.

Continue selecting Rotate from the Arrange menu until the object is

rotated as you wish.
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Keep these points in mind:

For easy editing, a rotated field temporarily reverts to degrees

rotation when it is selected in Browse mode. The field assumes its

previous rotation when it is deselected.

Portals cannot be rotated.

^ Choose FileMaker Help Index from the SS or Help menu, and then type:

rotating objects

Changing the appearance of objects

You can change the appearance of a field or a text or graphic object, for

example by changing its size, border width, or fill pattern.

Resizing objects

To resize Do this

An object, using Select the object and drag a handle until the object is the size you want.

the handles To limit the change to only vertical or horizontal, hold down Shift as

you drag a handle. (Do this to make fields longer without changing

their height.)

An object, using Choose Size from the Show menu. Select the object to resize. Type the

the Size palette width and height in the lower two boxes, and then press Return.

A circle or square

Several objects at

once

Select the object. Hold down Option and drag a handle until the object

is the size you want.

Select the objects and drag a handle of one object until all objects are

resized.

Distance from left side of -

object to left edge of paper

Distance from right side of

object to left edge of paper

Width of object

^D:^ :
Size

1 958

1 014

Distance from top of object to

top edge of paper

Distance from bottom of

object to top edge of paper

Height of object

Keep these points in mind:

Resizing the first repetition of a repeating field resizes all repetitions.
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Resizing a grouped object resizes all the objects in the group. See

"Grouping and ungrouping objects" on page 3-47.

*y Choose FileMaker Help Index from the CS or Help menu, and then type:

resize objects

Changing an object's shape

To Do this

Reshape one object Select the object, and then drag a handle until the

object is the shape you want. (To change only the

height or width, hold down Shift as you drag.)

Reshape several objects at once Select the objects, and then drag a handle of one

object until the objects are reshaped.

Change a rectangle into a square or an Select the object. Hold down Option and drag a

oval into a circle handle to the shape you want.

Note If the AutoGrid is on, you reshape objects in increments defined by

the grid settings. To reshape objects in finer increments, choose AtitoGrid

from the Arrange menu to turn the grid off. See "Positioning and sizing

objects" on page 3-40.

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

reshape objects

•iSK^i;^^a5KSS!:;^ii^s5ES5ffis

Changing lines, colors, and patterns

To set or change preset fill color or pattern, pen color or pattern, or line

or border width, start with no objects selected. Then choose attributes

from the palettes.

Fill pattern palette Pen pattern palette

^^ , .1 .
Rll color palette %A^,,\ Pen color palette—Sj^Jg^—

J ffl ipt

Line width palette

Current line width

Fill sample 1 I Pen sample
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Keep these points in mind:

To remove a fill pattern or pen pattern from an object, select the

object, and then choose the transparent pattern.

To use the attributes of an existing object to set the preset attributes, hold

down Command and click the object.

Attributes you set in the Field Borders dialog box for pattern, color,

and width replace attributes set with the pen and width controls in the

status area, and vice versa. See "Adding borders, fill, and baselines to

fields" on page 3-73.

*? Choose FileMaker Help Index from the 09 or Help menu, and then type:

graphic tools

Protecting objects from change

Lock objects so you can't move them, change their size, or remove them

from the layout.

To lock objects, in Layout mode, select the objects, and then choose Lock

from the Arrange menu. To unlock objects, select the objects, and then

choose Unlock from the Arrange menu.

When you copy or duplicate a locked object, the copy isn't locked.

When you group objects that include a locked object, the entire group is

locked.

Note You can change the stacking order of locked objects. (See

"Stacking objects and changing the stacking order" on page 3-46.)

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

locking objects

Working with graphic objects

Draw graphic objects—lines, rectangles, squares, rounded rectangles,

ovals, and circles—anywhere on a layout. You can also import

QuickTime movies (in Browse mode) and bring in graphics created in

other applications.
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All objects have a border. (The border of a line is the line itself. ) All

objects except lines have afilL the area within the border. You can

change the border's width, color, and pattern, and the fill's color and

pattern before or after you draw an object.

^ Choose FileMaker Help Index from the [2J or Help menu, and then type:

objects, creating

Drawing objects in a layout

Before you draw an object, you select the appropriate drawing too! in the

tool panel. FileMaker Pro uses the preset line width, pen color, and

pattern, and it fills the object with the current fill pattern and color (for

all objects except lines). You can change these attributes before or after

you draw the object. (See "Changing the appearance of objects" on page

3-50.)

Status area control

No tools visible? If you don't see the status area with the tool panel on the

left of the window, choose Layout from the Mode menu, and then click

the status area control at the bottom of the screen.

To draw a Do this

Line, or Select the line tool, and then position the center of the crosshair pointer

straight horizontal, at the line's starting point. Drag the pointer until the line is the length

vertical, or you want. For a straight honzontal, vertical, or diagonal line, hold

diagonal line down Shift and drag the pointer until the hne is the length you want.

Q
Rectangle or

square

Rounded rectangle

Select the rectangle tool. Position the center of the crosshair pointer

where you want any comer of the rectangle or square to start.

For a rectangle, drag the pointer diagonally until the rectangle is the

size you want. For a square, hold down Option and drag the pointer

diagonally until the square is the size you want.

Select the rounded rectangle tool. Position the center of the crosshair

pointer where you want any comer of the rounded rectangle to start.

Drag the pointer diagonally until the rectangle is the size you want.

Oval or

circle

o

Select the oval tool. Position the center of the crosshair pointer where

you want the oval or circle to start.

For an oval, drag the pointer in any direction until the oval is the size

you want. For a circle, hold down Option and drag the pointer in any

direction until the circle is the size you want.
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An object is selected when you finish drawing it. To deselect an object,

click a blank area of the layout or any tool in the tool panel.

'P Choose FileMaker Help Index from the (^ or Help menu, and then type:

drawing

Adding graphics in a layout

You can add graphics anywhere on a layout. Use a graphic in a layout

instead of a container field whenever you want the same image (like a

company logo) on every record or report.

1

.

Copy the graphic from the application it was created in.

2. In the FileMaker Pro layout, choose Paste from the Edit menu.

3. Position and resize the graphic as needed in the layout.

See "Positioning and sizing objects" on page 3-40 and "Resizing

objects" on page 3-50. You resize the display of a graphic without

changing its original size.

Keep these points in mind:

You can import a graphic by choosing Import/Export from the File

menu, and then choosing Import Picture. See "Working with container

fields" on page 4-6.

To display a different graphic, sound, or movie in each record, add a

container field. See "Formatting graphics in individual container

fields" on page 3-67.

You can also import a graphic onto a layout. When you import a

graphic, you can choose to store the graphic in the database file or

externally. If you move or delete a graphic file that's stored

externally, FileMaker Pro can't display the graphic on the layout. See

"Importing graphics" on page 4-6.

'P Choose FileMaker Help Index from the CS or Help menu, and then type:

graphics
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1

Working with fields in a layout

When you first define fields for a new database file, FileMaker Pro adds

them to the Standard layout, with field labels for each field. Later, you
can add fields from the database file to the current layout, delete fields

you don't want displayed or printed from the current layout, and

determine the format in which you want data displayed in fields when
the current layout is used. (To prevent fields that you define later from

being added to the current layout, see "Setting layout preferences" on

page 9-3.) A field that doesn't appear on a layout still exists in the

database file, and its data can still be used in calculations and

summaries.

Fields on a layout are objects, which you can select, move, resize, and

reshape, just like other objects. Each field displays its tleld name,

formatted with the preset attributes for font, size, style, alignment, line

spacing, and color, so you can easily identify it. Fields of all types

(except container fields that don't hold text) display baselines to indicate

where the data appears when you add or edit records.

Fields display field names

Field tool

Employees
\
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Adding fields to a layout

You can add a field to a layout at any time. A field can be added

anywhere on any layout, as many times as you want. You can get

different results by placing the same field in different locations on the

layout. For example:

Add the same summary field to a subsummary part to calculate totals

for each group of sorted records, and to a grand summary part to get

totals for all the records in the file.

Add a field to the header or footer parts to repeat data from the first

record or the last record on the page as a header or footer. (You might

add a Last Name field to the header in a telephone directory.)

To add a field to a layout:

1

.

In Layout mode, hold down the Field tool and drag the field to the

layout part in which you want the field to be.

2. In the Specify Field dialog box. select options for the new field.

Choose from the

relationship pop-up -

menu, if necessary

Select the field to add

Select to use the field

name as the field label

i Specify Field i

Post Code

Home Phone

Title

Department

Salarg

Last Review Date

Next Review

-Q Create field label

;
Cancel

j [C^K^

3. Click OK.
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After you add fields to a layout, you can work with them in the following

ways:

To Do this

Redefine a field Double-click the field. In the Specify Field dialog box.

double-click a different field name. To include a tleld label,

first delete the original label on the layout. Then, in the

Specify Field dialog bo.\, select Create field label.

Display sample data from the Choose Sample Data from the Show menu,

current record (when the file

contains data), instead of field

names, in fields in the layout

Choose the preset values for See "Working with text" on page .^-79.

font, size, style, line spacing,

alignment, text color, and till

color of text entered in a field

Add distinctive borders and

baselines

See "Adding borders, fill, and baselines to fields" on page

,V73.

Change the display formats of See "Defining display formats for fields" on page 3-59.

text, numbers, dates, and times

in fields

Format a field as repeating, or See "Formatting repeating fields" on page 3-72 and

format its values as "Defining value lists" on page 3-75.

checkboxes, radio buttons, a

pop-up menu or a pop-up list

Keep these points in mind:

To define a new field for the database tile, which you can then add to

a layout, see "Defining database fields" on page 2-3.

When you copy fields (and field types) from a layout in one file to a

layout in another, be sure the field names match. When you move

fields from one layout to a layout in another file, you copy the field

characteristics for that layout (including dimensions and text styles)

but not the definition.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

fields, placing
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Adding merge fields

You can add a mergefield (a placeholder for a field's value) to a layout

to display or print a field's data when you browse and print records. Use

merge fields for documents like letters, envelopes, contracts, and so

forth. For example, when you add the merge field «First Name» to the

right of the text Dear, FileMaker Pro displays Dear Leon, when the First

Name field contains "Leon".

FileMaker Pro collapses unused Hnes, such as an empty «Address 2»
field.

1

.

In Layout mode, click where you want the merge field to appear.

2. Choose Paste Special from the Edit menu, and then choose Merge Field.

3. In the Specify Field dialog box, double-click the name of a field to

use as a merge field.

Select a field to use

as a merge field

Specify Field
;

* File I "Employees "

: Name
XiiAHmt

i: itij

Post Code

Home Phone

Title

Department

Salarg

Last Review Dale

Next Review

^L

Choose from tfie

relationsfiip pop-up menu,

if necessary

Keep these points in mind:

You can also add a merge field by typing the field name surrounded

by angle brackets (« ») on the layout. (Be sure that the field name

exists in the database and that you type it correctly.)

If you use a text field as a merge field, the merge field picks up the

text attributes (like style, color, and size) set for the data in Browse

mode.

Add symbols, like commas, and spaces where needed among merge

fields on the layout.
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Merge fields display as much text as fits in the boundary of the

defined field. You can adjust the size of the field to display as much
data as you want.

You format merge fields the same way you format other

FileMaker Pro fields. To assign fomiats to values in a merge field,

select the merge field and the« and» symbols, and then select

formatting options. See "Defining display formats for fields" below

and "Changing the appearance of text" on page 3-88.

"?
I Choose FileMaker Help Index from the [^ or Help menu, and then type:

merge fields

Z-L--<^:!^-j:S^VS^l.Z^:r:;S^C:iir^^-.^^^^ - .^ J.- ~ - n

Deleting a field from a layout

To delete a field from a layout, in Layout mode, click the field and press

Backspace or Delete. When you delete a field from a layout, the field

and its data remain in the database file. (To delete a field from a database

file, see "Changing field definitions" on page 2-25.)

*? Choose FileMaker Help Index from the (21 or Help menu, and then type:

fields, deleting

Defining display formats for fields

Display formats make data in fields look consistent when the data is

displayed or printed. The formats don't change the data as stored in the

file. For example, a number field can be formatted to display three

decimal places. You can do the following:

Set no formats in FileMaker Pro. When you set no fomiats,

FileMaker Pro displays numbers, dates, and times according to the

system formats set in the Numbers and Date & Time control panels

at the time the file was created. (See appendix B, "Working with

international files" and the documentation that came with your

computer.)

Set default display formats in FileMaker Pro for all text, number,

date, time, and container fields you plan to define (see "Setting

default display fomiats," below).

Define data formats individually in FileMaker Pro for existing text,

number, date, time, and container fields (see the sections beginning

on page 3-60).
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On a field by field basis, each layout can have a different set of formats.

For example, suppose you forniat number fields to display a currency

symbol, thousands separators, and two decimal places. If the currency

symbol is a dollar sign ($), the thousands separator is a comma {,), and

the decimal separator is a period (.), the value 5000 displays as

$5,000.00. However, only the value 5000 is stored in the file.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

formatting fields

Setting default display formats

Set default display formats for newly created fields. Default fomiats set

in FileMaker Pro override formats set in the Numbers and Date & Time

control panels and affect only FileMaker Fro files. Default formats

apply to newly defined fields added to the current and new layouts.

1

.

With no fields selected in Layout mode, choose Text, Number, Date,

Time, or Graphic from the Format menu.

2. In the Default Format dialog box, select options, and then click OK.

You can also set a default display format if you have just added a new

field to a layout.

1

.

Drag a new field to a layout. Before deselecting that field, choose

Text, Number, Date, Time, or Graphic from the Format menu.

2. In the Format dialog box, select options, and then click OK.

See the following sections for information on data formatting options

for each field type.

You can also set display formats for individually selected fields, which

replace the current default settings. See the following sections.

Choose FileMaker Help Index from the QS) or Help menu, and then type:

formatting fields

Formatting text attributes in individual fields

You can format the text attributes (such as the font, size, and style) for

data in all field types that contain characters. All the characters in one

field (including all repetitions of repeating fields) share the text

attributes. You can also format text objects in the layout.
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1

.

In Layout mode, select a field or text object, and then choose Text

from the Format menu.

To format more than one field at a time. Shift-click each field to

format, and then choose Text Irom the Format menu.

2. In the Text Format dialog box, select options, and then click OK.
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Formatting numerical values in individual fields

Format numbers for number tlelds, or calculation, summary, or global

fields that have a numeric result. You can format a field as a decimal

number or a Boolean number (to produce a true or false result).

A number field can hold up to 255 characters. However, for calculation

purposes FileMaker Fro uses only the first 15 numeric characters.

Adjust the length of the line by changing the width of the field on the

layout, if needed.

1

.

In Layout mode, select a number field, and then choose Number from

the Format menu.

To format more than one number field at a time, Shift-click each field

to format, and then choose Number from the Format menu.

2. In the Number Format dialog box, select options, and then click OK.

To display numbers Do this

Exactly as typed or

entered

Click Leave data formatted as entered.

As Boolean numbers

As decimals

Click Format as Boolean. To change the default values, type

up to seven characters for Show non-zeroes as and Show

zeroes as (such as True and False).

Click Format as decimal, and then select options. See the

table in the next section to change default decimal options.

With different text Click Text Format, and then select options. {See "Formatting

attributes text attributes in individual fields" on page 3-60.)

Choose options for Boolean

or decimal numbers

Define the symbols

.

for thousands and

decimal separators

! Number Format for "Salary"
I

O L*aT» data formatted as entered

O Format as Boolean

^.rii.iv,. nun-;*! oe= a:
|
Y^j [

Show ;*r

(•) Format as decimal

^ Fi>pd number of decimal digits |H
^ Use notation | Ciirretiog Oeading)

|

I I
Do not displdij number if zero

Separators ~

Decimal separator I

^ Use ttiousands separator ,

Sample — — - - - -

-$4,m7 00

Currency symbol

Format as:
I
-1234 ^

Q Use color: IWlB

Tent Format.

Cancel
J
[T

Set options for

negative values

Specify font, style,

size, line spacing,

alignment, and color
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Keep these points in mind:

Numbers with decimal digits that exceed the specified number are

rounded. If you specify 0. no decimal digits are displayed. If you

specify a negative value, numbers are rounded to the number of

positions left of the decimal separator. (For example, for the field

value 789.78, 2 fixed decimal places displays 789.78; fixed places

displays 790; and -2 fixed places displays 800.) For calculations and

summaries, FileMaker Pro uses the original, unrounded, number.

Only numbers are displayed and printed in a number tleld formatted

as Boolean or decimal (except for symbols set in the Number Format

dialog box). To display text and symbols (as in @1 .98 per pound) in a

number field, don't define a number format.

When you work with a file created with different system formats and

you want to use the formats set on your computer, choose Use System

Formats from the Format menu. See appendix B. "Working with

international files."

O i Choose FileMaker Help Index from the (2! or Help menu, and then type:

numbers, formatting

Changing options for numerical data

You can change the default symbols used as the thousands separator and

decimal separator. Unless you changed them previously, the default

settings are taken from the Numbers control panel. You can also change

the default format for negative numbers.

1

.

In Layout mode, select a number field, and then choose Number from

the Format menu.

2. In the Number Format dialog box, click Format as decimal, select

options, and then click OK.

To change the

default Do this

Number of decimal Select Fixed number of decimal digits, and type a new value,

digits

Notation symbol and Select Use notation, and then choose Percent (to display a percent

position symbol after the value. Currency (leading) (to display a currency

symbol before the value) or Currency (trailing) (to display a

currency symbol after the value.)

Currency symbol For Currency Symbol, select the current default, and type a new
one.



3-64 FileMaker Pro User's Guide

To change the

default Do this

Display of zero values Select Do not display number if zero.

Decimal separator For Decimal separator, double-click the current default, and then

type a new one.

Thousands separator Select Use thousands separator, douhle-click the current default,

and then type a new one.

Format for negative For Format as. choose an option. To display negative numbers in

numbers color, select Use COlor, and then choose a color.

^ Choose FileMaker Help Index from the (2) or Help menu, and then type:

numbers, formatting

M
::-v;f:ir:^!^igi:!--:f^^?s

Formatting date values in individual fields

Format dates in date fields, or calculation, summary, or global fields that

have a date result. You can also leave a date unformatted, so it will

display and print as typed. A date field can hold values from

1 January 0001 to 31 December 3000.

1. In Layout mode, select a date field, and then choose Date from the

Format menu.

To format more than one date field at a time. Shift-click each field to

format, and then choose Date from the Format menu.

2. In the Date Format dialog box, select options, and then click OK.

To display dates Do this

Exactly as typed or

entered

Click Leave data formatted as entered.

In a particular format

In a custom format

With leading zeroes (as

in 01/02/98) or leading

spaces in numeric parts

of dates

Click Format as. and then choose a format. To change the

default separator between parts of numeric dates, for Numeric

separator, type another ch;iracter.

Click Custom, and then choose options and separator characters

for day of week, month, date of month, and year.

Choose options for For day numbers, For month numbers, or both.

With different text Click Text Format, and then select options. (See "Formatting

attributes text attributes in individual fields" on page 3-60.)



Laying out and arranging information 3-65
|

Set font, style, size, color,

line spacing, and alignment

Date Format for "Last Reuieiu Date"

(•) Le«ve data formatted as entered

O Format as :
j
Z/2/^'S

Numerii; separator
|
/

|

O Custom :

|
|

[Vj
| <None>

Leading Characters

For d3L| numbers j -No

For month fmr.ibi-rj j <rVone> ]
- Sample

;
2/2/98

31

^TeKt Format..

Q
Choose options for day,

month, date, year, and
separator characters

Keep these points in mind:

Be sure to size the date field on the layout according to the length of

the date. For example, the date Wednesday, May 5, 1999 needs more
room than 5/5/99.

You can also set the format for the system date symbol (//). Select the

symbol first. See "Displaying special information" on page 3-83.

When you work with a file created with different system formats and

you want to use the formats set on your computer, choose Use System

Formats from the Format menu. See appendix B, "Working with

international files."

Choose FileMaker Help Index from the i^ or Help menu, and then type:

date fields

Formatting time values in individual fields

Format times in time fields, or calculation, summary, or global fields

that have a time result.

1 . In Layout mode, select a time field, and then choose Time from the

Format menu.

To format more than one time field at a time. Shift-click each field to

format, and then choose Time from the Format menu.
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2. In the Time Format dialog box, select options, and then click OK.

To display times Do this

Exactly as typed or

entered

Click Leave data formatted as entered.

In a particular format

With leading characters

Click Format as, and then choose a format. You can set a

different unit separator (like : or-), 24-hour or 12-hour time,

and a trailing or leading suffix (like AM or PM).

For Leading Characters, choose options for Hours. Minutes and

seconds, or both.

With different text Click Text Format, and then select options. (See "Formatting

attributes text attributes in individual fields" on page 3-60.)

Choose a time format

Set font, size, style, color,

line spacing, and alignment

j Time Format for "time" \

(j^ Leave data formatted as entered

Q Format as: | hhnimsa ^ |
S.?parator

(3 24 ^-)u^ notation
|
trailing ^\

(S) 1 2 hour notation

before noon
|
AM

after noon
[
Pr^

Leading Characters

Hour;
I
<None> !

Minutes and seconds | Zero y|

-ailing ^ I

-[TeHt Format.,

Keep these points in mind:

You can also set the format for the system time symbol (::) on the

layout. Select the symbol first. See "Displaying special information"

on page 3-83.

When you work with a file created with different system formats and

you want to use the formats set on your computer, choose Use System

Formats from the Format menu. See appendix B, "Working with

international files."

*? Choose FileMaker Help Index from the C£ or Help menu, and then type:

time fields

"rr'^!'SWSW?l3':'fflSW9!9(8asO(lBS(ESKSW!SlS9 «5WSSlffiB3S»"«rt«SM
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Formatting graphics in individual container fields

When you detlne a container field, FileMaker Pro displays the

boundaries of the field in Layout mode, as it does for other fields. You
can format the graphic in a particular way, to maintain the original

proportions of the graphic as it's entered in the field, or to align the

graphic horizontally or vertically within the boundaries.

You can change the dimensions of container fields on a layout without

affecting the original shape and size of the graphic.

1

.

In Layout mode, select a container field, and then choose Graphic

from the Format menu.

To format more than one container field at a time. Shift-click each

field to format, and then choose Graphic from the Format menu.

2. In the Graphic Format dialog box, select options, and then click OK.

To Do this

Determine how lo fit the

graphic in the frame

For <value> image toJit frame, choose an opm

Keep the graphic's onginal

proportions when it's in the

field

Select Maintain original proportions.

Set the horizontal and vertical For Alignment, choose options for a vertical and a

alignments horizontal aligninent.

Choose how to fit the -

graptiic in the frame

Cfioose how to align the -

graphic horizontally

I Graphic Format for "Picture" I

I
Peduce ^

I
image to fit frame

y Maintain original proportions

Alignment jcenlei •'}
| Center •^Y

'

Sample

<-f-4

Choose how to align

the graphic vertically
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Keep these points in mind:

For information about adding a graphic to a container field, see

''Working with container fields" on page 4-6.

You can also add graphics to a layout as objects. See "Adding

graphics in a layout" on page 3-54.

Display the same graphic

once on each page of a report

Enter a graphic in a

container field to

display a different

graphic in each record

Available Tours

Grand rvtonerch cune Deainsicn Alaska

7 nights ctuiae widrmt price 1^95

OSpnng ©Summer QAutumn O^'"'^'' 0'''"vear

iSlacier route between Vancouver and Anchorage Includes

Columb'aGlacier, College F|ord, Ketchikan, Juneau, Sitka, a/id

VaJdez Optional lanil tour to Denali Park

Ctuiae Oealnilcn Scandinavia

S749

Royal Cavalier

7 nights

OSpnnfl ©Summer ^Autumn o^i^'^' 0*"vew
Includes ajr fare trom New Votk 4 nights m Helsinki, 2 nights ir

Stockholm, 1 dayin Copenhagen

ciuiicaiiD Grand Bordeaux C'uiaeOea<nai<M Caribbean

TcuriEngti 1 1 nights cruiae iwideaaiE price $t524lo$3694

QSpting oSummer o*"'"i"" o^''^'*'' #A"V6W
SanJuan,Sl Thomas, Curacao, St Martin, and Cozumel Lu>ajry

accommodaiions No tipping policy

O Choose FileMaker Help Index from the (^ or Help menu, and then type:

fields, formatting

Determining data entry in fields

You can have the entire contents of a field selected when you select the

field in Browse mode (otherwise, FileMaker Pro places the insertion

point after the last character in the field). You can also allow or prevent

entry into a field (preventing entry is useful when you want users to see

the data in the field on a layout but not modify it).
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1. In Layout mode, select a field, and then choose Field Format from the

Format menu.

2. In the Field Format dialog box, select options, and then click OK.

To select all the field's contents when the field is selected, select

Allow entry into field, and then click Select entire contents of field on

entry.

To prevent entry into a field, deselect Allow entry into field. (To

allow entry into the field, select this option.)

*? Choose FileMaker Help Index from the ^ or Help menu, and then type:

fields, customizing

a^'lgigSiSgS£!55gSi^ffi8SKMS8aBjSgg;mgSg^»gS^^

Setting the tab order for data entry

When you press Tab in Browse mode, fields are normally selected from

left to right, top to bottom. You can change this preset tab order, set a

custom tab order, omit fields from the tab order, and create a tab order

specifically for repeating fields.

Note Setting a tab order has no effect on data entry when records are

edited using FileMaker Pro Web Companion Instant Web Publishing.

1 . Choose Set Tab Order from the Mode menu.

Each arrow indicates ttie field's

position in the tab order
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2. Select options.

To Do this

Renumber individual

arrows

Remove numbers from all

arrows and set a new tab

order

In the Set Tab Order dialog box, click Edit tab Order. In the

layout, click an arrow whose order you want to change, and

then type a new number.

In the Set Tab Order dialog box, click Create new tab order.

In the layout, click the arrows in the order you want.

Omit fields from the tab

order

Set a tab order for values in

repeating fields

As you set a new tab order, don't click arrows for the fields

to omit. For fields that already display a number, select the

number, and then press Delete.

See the information following these steps.

Restore the default tab

order (left to right, top to

bottom)

Click Revert to Default.

3. Click OK.

4. If you omitted fields, click Omit in the alert message.

Keep these points in mind:

A blank arrow indicates a field omitted from the tab order.

You can tab into a field that's formatted as radio buttons and

checkboxes, and use the keyboard to make a selection. See "Entering

data from a value list" on page 4-9.

You can tab into repetitions of repeating fields from left to right or top

to bottom. (For example, create a tab order that selects the tlrst

repetition for all fields before it selects the second repetition.) Start

setting the tab order with the topmost or leftmost repeating field. When

you create a tab order, the arrow blinks as you select the rest of the

fields for the tab order and stops when you return to the fu-st repeating

field selected. FileMaker Pro completes the tab order for the repeating

fields based on your previous selections.

Horizontal lab order for

repeating fields (left lo right)
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To enter all the values in a single repeating field before you tab into any

other field, double-click the field's arrow.

Vertical tab order for repeating

fields (top to bottom)

First

double-click

Second Third

double-click double-click

fiiw.tkisFJd.. fifitst HfiMiiimgnjd

O Choose FileMaker Help Index from the^ or Help menu, and then type:

fields, entering data

Adding scroll bars to fields

Add a vertical scroll bar to any field on your layout (except a container,

summary, or repeating field), to see more data than fits in the field.

Notes
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Scroll bars are always displayed if you set the field borders option for

the right side of the field. Otherwise, they display only when you tab into

the field. See "Adding borders, fill, and baselines to fields" on page

3-73.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

scroll bars

Formatting repeating fields

To fine-tune a repeating field, you can choose the number of repetitions

visible in the current layout, and the orientation of the repetitions.

Note Before you begin, you need to define a repeating field. See

"Defining database fields" on page 2-3 and "Defining repeating fields"

on page 2-11.

1

.

In Layout mode, select the repeating field to format, and then choose

Field Format from the Format menu.

2. In the Field Format dialog box, select options, and then click OK.

To Do this

Set the number of visible

repetitions in the repeating

field

For Show <va!ue> of field's <value> repetitions, type a

number.

Choose an orientation for

displaying repetitions

For Use <value> orientation, choose vertical to display

repetitions stacked (as in a column); choose horizontal to

display them side by side (as in a row).

Set the number of repetitions -

visible in a repeating field, and

their orientation

Field Format for "Date of trauei"

style

(i) standard field

I I
Include vertical scroll b

O I
Pop-up list

J
using value lisl

|
Define Value Lists ^

|

I I
triclud* "Other " item to allow entry of otfier values

I I
(Fiirlude "Edit, " item to allow editing of value list

Repetitions

Show l4 of field's 4 defined repetitions

Use
I

vertKsl

Behavior

[^ Allow entrij into field

I I
Select entire contents of field on entry

Cancel
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Note Data added to a repeating or calculation field with a formula that

uses repeating fields is always maintained and can be used, even if you

change the layout to display fewer repetitions or change the field to

nonrepeating.

O Choose FileMaker Help Index from the (2] or Help menu, and then type:

repeating fields

iVL-*yaffi3!K-sr-"':5'/rJS3;

Adding borders, fill, and baselines to fields

You can add or change the borders, fill pattern, and baselines (a

horizontal line in a field to help you align data) for fields, before or after

you add tlelds to a layout.

1

.

In Layout mode, to set attributes for new fields, start with no fields

selected. To change the attributes of existing fields, select the fields

to change.

2. Choose Field Borders from the Format menu.

3. In the Field Borders dialog box, select options, and then click OK.

To Do this

Set attributes for field

borders

Select any combination of Top. Bottom, Left, and Right. For

<l/a/ue> format, choose Borders from the pop-up menu, and

then choose a color, pattern, and width.

Add baselines for field data Select Text baselines. For <value> format choose Baselines

and set attributes for the from the pop-up menu, and then choose a color, pattern,

baselines and width.

Set a fill pattern for fields For <va/ue> format, choose Fill from the pop-up menu, and

then choose a color and pattern from the palettes.

Add borders between

repetitions in repeating

fields

Select Between repeating values. For <i/a/ue> format, choose

Borders from the pop-up menu, and then choose a color,

pattern, and width from the palettes. (See the examples

following these steps).

Choose which

portion of the field to

assign attributes to

Choose a color,

pattern, and width

Default Field Borders :

Field Borders

D Top n Left

I I
Texl baselines

I I
Between repeating values

I
Bwier.= »1 format

lais ^ Cancel OK
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Keep these points in mind:

Changes made in the status area to the preset pattern, color, and Hne

width settings replace settings in the Field Borders dialog box, and

vice versa. See "Changing lines, colors, and patterns'" on page 3-51

.

You can also use the fill controls in the status area to fill a field with

a color and pattern. See "Changing lines, colors, and patterns" on

page 3-51.

One box around all data In three

repeating fields

Alaska
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Defining value lists

To save time and ensure accuracy during data entry, define frequently

used text, number, date, or time values to display in a pop-up menu or

pop-up list, or as checkboxes or radio buttons. When you enter data,

choose from the list of defined values.

Choose from this list of

values during data entry
Season Q Spring

—
n S ummer
n Autumn

n Winter

DAI! year

Value lists aren"t attached to any field definition but can be shared by

several fields. The values in a value list can be user-defined or based on

the values in a field in the same file or in a different file.

After you define a value list, you can use it to validate any field. (See

"Choosing data entry options" on page 2-6.)

To define a value list:

1

.

Select a field on the layout for which you want to use a value list, and

then choose Field Format from the Format menu.

2. In the Field Format dialog box, for Style, select Pop-up list USing value

list <value>. and then choose Define Value Lists from the pop-up menu.

3. In the Define Value Lists dialog box, for Name, type a name for the

list, and then click Create.
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4. Define the value list.

To Do this

Create a list of values

Choose from existing

values in a different

field

Select Use custom values, and then type each value on a separate

line, in the order you want them to appear. Press Return to

separate each value.

Select Use values from a field, and then click Specify Field, in the

Specify Field for Value List dialog box, to choose from a field

in a different file, click Specify File, and then choose a filename.

For Use values from this field, click the name of a field, and then

click OK.

Choose from existing

values in a second

field

In the Specify Field for Value List dialog box, select Also display

values from, click a field name, and then click OK.

Select this option to display the values from a corresponding

field next to the values in your value list. For example, to help

with data entry, you could display part names next to part

numbers.

Produce a separator

line between items in a

pop-up menu or

pop-up list, or produce

spaces between radio

buttons or checkboxes

In the list of custom values, type a hyphen on a separate line

where you want the separator line or space to appear, and then

press Return.

Delete a value list In the list of names, select the value list, and then click Delete.

Duplicate a value Ust In the list of names, select the value hst, and then click Duplicate.

Names of value lists

Type a name for the current list

Determine which

values to display

in the list

Click to use field values

Define Ualue Lists
I

Value List Name

(•) Use custom values

Each value must be

separated by a

carrlaqe return

Add a divider by entering

a tiyphen " - " on a line

by Itself

Q Use values from a field

Red

Blue

Yellow

Green

Orange

Purple

[(
Saue ]| [ Duplicate"]

Type

custom

values
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Select a file containing

the field values you want

Select a field to

use its values

i
specify Fields for Ualue List

[Specify File..

Use values fro(

Cruise Ship

Cruise Oestinaf ion

Cruise wholesale pnc
Season

Notes

Tour length

Month

Low Temp
High Tennp

Ratnfatt

Destination

Logo

[ I
Also display values from

o

Ciui£e Ship

Ciuiit Destifidtiof.

Cruise v/holesale pnu
Season

Hotes

Tfjiji- length

Moh(h

Low Terfip

High Temp
Rainfall

Oestination

Logo

Select a second

field to display

values from

5. Click Save, and then click Done.

Keep these points in mind:

You can open the Define Value Lists dialog box quickly by choosing

Define from the File menu, and then Value Lists.

You format a value list as checkboxes, radio buttons, a pop-up menu,

or a pop-up list in Layout mode. See the next section.

You can also define a value list or attach value lists to fields in the

Validation dialog box (of Define Fields) or in the Sort dialog box.

You can edit a value list in Browse mode. See "Entering data from a

value list" on page 4-9.

^ Choose FileMaker Help Index from the 12^ or Help menu, and then type:

> value lists

Formatting fields with value lists

After you define a value list, you can make the following changes:

Display values in a pop-up menu, a pop-up list, with radio buttons, or

with checkboxes.

Add an Other item to checkboxes, radio buttons, pop-up menus, and

pop-up lists so you can enter a value that's not in the list.
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Add an Edit item to checkboxes, radio buttons, pop-up menus, and

pop-up lists so you can edit the values in the list.

'EJ Spring
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Text makes a layout easier to use and understand. When you add text to

the body of a layout, FileMaker Pro displays the text with every record.

Add text for labels or column headings that identify fields, instructions

on a form, report titles, page or record numbers, and so on. On some

predefined layout types, FileMaker Pro displays the field name as text.

Text typed or pasted on a layout is a text object (except when it's part of

a graphic), which you can select, group, move, shape, cut, or copy, as

any other object.

Note Text objects do not appear when you publish a database on the

Web using FileMaker Pro Web Companion Instant Web Publishing.

FileMaker Pro can use all the fonts installed in the System Folder of

your current startup disk. If you have Helvetica on your system,

FileMaker Pro uses it by default. Otherwise, it uses the Geneva

computer font. To update your list of fonts, see the documentation that

came with your computer.

You can set the font for text before you type it, or you can change the

font of existing text or field objects.

Ctianging these field

labels doesn't affect

the actual field names
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Typing text

Keep these points in mind:

You can also use drag and drop and context menus to edit text. See

"Using drag and drop to move information" on page 4-13 and

"Editing objects and data quickly using the context menu" on page

3-42.

Use standard editing conventions when working with text. For

keyboaid equivalents and other keyboard shortcuts, see

FileMaker Pro Quick Reference on the back cover of this user's

guide.

To use the attributes of an existing field or text object to set the preset

attributes for all text, hold down Command and click the field or text

object.

To change text attributes, see "Changing the appearance of text" on

page 3-88.

You can change attributes for the text in a field when you set the

field's format. See "Formatting text attributes in individual fields" on

page 3-60.

To check the spelling of text, see "Checking your spelling" on page

1-13.

When you add text, you see a temporary border around the object, to

indicate the object's boundaries. The border doesn't display or print

when you browse, preview, or print records.

iBioomsbuty^ Temporary border

To type text:

1 . In Layout mode, select the text tool in the tool panel.

Text tool 2. With the I-beam pointer, click in the layout where you want to add

text.

3. Type the text.

You can also type text with other tools selected. If you click on the

layout and begin typing, FileMaker Pro creates a text object where

you click.
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To control the size and position of the borders before typing:

1

.

In Layout mode, select the text tool, and then position the pointer

where you want the text to begin.

2. Drag the pointer until the border is the size you want.

3. Type the text.

Keep these points in mind:

The text appears in the cunent font, style, line spacing, color, and

alignment. To set or change text attributes, see "Changing the

appearance of text" on page 3-88.

To set an option to keep layout tools selected until you select another

tool, see "Setting layout preferences" on page 9-3.

FileMaker Pro adds text to a layout in different places, depending on
what you select.

When you select Text appears

Nothing on the layout and start In the last place you clicked,

typing

A text object and start typing In place of the selected text object.

An object (such as an oval) and start Within the boundanes of the selected object (the

typing text isn't actually inside the object but layered in

front of it).

'P Choose FileMaker Help index from the ^ or Help menu, and then type:

text, entering

text tool
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Selecting text

Editing text

Before you select text, select the object (in Layout mode) or field (in

Browse mode) by clicking it. Then:
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Keep these points in mind:

To restore text you deleted, choose Undo from the Edit menu before

you do anything else in FileMatcer Pro.

Text you cut or copy stays on the Clipboard until the next time you

use Cut or Copy.

To change the appearance of text, see "Changing the appearance of

text" on page 3-88.

To rearrange text on the layout, see "Arranging objects" on page

3-44.

O Choose FileMaker Help index from the C9 or Help menu, and then type:

text, editing

Displaying special information

You can display or T^nntfixed information (like the date as it was when
entered) or variable information (like today's date) when you print or

preview records. For example, display the current time in a report footer

each time you print the report. You can also display the date, time, or

user name as it is when you place it in the layout. This information stays

the same whenever you display, print, or preview records.

1

.

In Layout mode, click where you want the variable information to

display.

2. Choose Paste Special from the Edit menu, and then choose a

command.

To Insert
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Note Before you print a layout that displays the current page number,

you can specify the starting number in the Print dialog box. (See

"Printing" on page 6-12.)

O Choose FileMaker Help Index from the ^ or Help menu, and tlien type:

* variables

>.5«.^<M«^r*r»wwaBst«rw;-wf»s>«(i»B

Formatting text paragraphs

You can format text, and the data in text fields, as paragraphs. For

example, indent the first line of text, or insert tab stops in a text field. Set

formatting options individually or all at once.

Using the text ruler

Fonnat text on layouts and in text fields using the text ruler.

Choose a font
—



3. Select options.

To
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Do this

Indent the first line Drag the left Indent marker "^
. The first line indent

marker automatically follows.

To move the left indent marker by itself, press Option

and drag it.

Set the font Choose a font from the pop-up menu.

Set the font size Choose a size from the pop-up menu.

Set the font style Click one or more style controls (bold, italic, or

underline).

Set a tab Click a set tab button, and then click the ruler where

you want the tab. (Set up to 20 tabs for each text object

or field.) Select a left-align, center-align, right-align,

or decimal-align tab. Or double-click a tab marker to

display the Tab dialog box. (See the next section.)

Align text Click an alignment control. Select left, center, right, or

justified alignment.

Change the unit of measure Choose a unit from the pop-up menu.

Change the left or right margin Drag the left or right indent markers on the ruler.

Note After you set tab stops within a field, use the tab stops in Browse

mode by clicking inside the field, then holding down the Option key

while pressing Tab.

O I Choose FileMaker Help Index from the C£ or Help menu, and then type:

text ruler

Setting tabs using the Tab dialog box

1. Display the text ruler, as explained in "Using the text ruler" on page

3-84.

2. To display the Tabs dialog box. with text selected, double-click a tab

marker in the text ruler.

You can also choose Text from the Format menu, click Paragraph in

the Text Format dialog box, and then click Tabs.
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3. In the Tabs dialog box. select options.

To
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Formatting paragraphs all at once

1. Display the text ruler, as explained in "Using the text ruler" on page

3-84.

2. To display the Paragraph dialog box, with text selected, double-click

a blank area of the text ruler.

You can also choose Text from the Format menu, and then click

Paragraph in the Text Fomiat dialog box.

3. In the Paragraph dialog box, select options, and then click OK.

To
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Changing the appearance of text

You can change text attributes, like font or line spacing, before or after

you type text. If you change text attributes after typing text, the attributes

you set become the preset attributes for new text.

To set attributes for new text, start with no text selected. To change the

attributes of existing text, select the text, and then make your changes.

To set Do this

Font Choose Font from the Format menu, and then choose a font.

Size Choose Size from the Format menu, and then choose a size.

Custom font size Choose Size from the Format menu, and then choose CtJStom. Type a

value between 1 and 500. and then click OK. You see the new size

below Custom in the Format/Size menu.

Style Choose Style from the Format menu, and then choose a style. You can

apply more than one style to text. Use the Text Format dialog box to

set several options at once. See the next section.

Text alignment Choose Align Text from the Format menu, and then choose Left, Center,

Right, or Full. Then, you can also choose Top, Center, or Bottom. The

.setting applies to a whole field or paragraph, and not to individual

characters. (See the next table.)

Line spacing Choose Line Spacing from the Format menu, and then choose a

spacing.

Custom line spacing Choose Line Spacing from the Format menu, and then choose Custom.

For Line Spacing, select opiums, and then click OK.

Text color Choose Text Color from the Format menu, and then choose a color.

You can display text in various alignments, as shown in the following

examples.

For example, this

alignment Aligns text like this

Lett Mountaineering. Inc. sunglasses provide good looks and the

maximum protection against the sun's damaging ultraviolet rays.

Mountaineering, Inc. sungla.s.ses are endorsed by mountaineers and

skiers

Center Mountaineering, Inc. sunglasses provide good looks and the

maximum protection against the sun's damaging ultraviolet rays.

Mountaineering, Inc. sunglasses are endorsed by mountaineers and

skiers



Laying out and arranging information 3-89
|

For example, this

alignment Aligns text like this

Rigtlt Mountaineering, Inc. sunglasses provide good looks and the

maximum protection against the sun's damaging ultraviolet rays.

Mountaineering, Inc. sunglasses are endorsed by mountaineers and

skiers.

Full Mountaineering. Inc. sunglasses provide good looks and the

maximum protection against the sun"s damaging ultraviolet rays.

Mountaineering. Inc. sunglasses are endorsed by mountaineers and

skiers.

Top Mountaineering, Inc. sunglasses provide good looks and the

(when Left is also maximum protection against the sun's damaging ultraviolet rays,

selected) Mountaineering. Inc. sunglas.ses are endorsed by mountaineers and

skiers.

Center

(when Left is also

selected;
Mountaineering, Inc. sunglasses provide good looks and the

maximum protection against the sun's damaging ultraviolet rays.

Mountaineering. Inc. sunglasses are endorsed by mountaineers and

skiers.

Bottom

(when Left is also

selected)
Mountaineering. Inc. sunglasses provide good looks and the

maximum protection against the sun's damaging ultraviolet rays.

Mountaineering, Inc. sunglasses are endorsed by mountaineers and

skiers.

'P Choose FileMaker Help Index from the f^ or Help menu, and then type:

text, formatting
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Changing several text attributes at once

You can set or change any combination of the text attributes at one time.

1

.

In Layout mode, to set text attributes for new text, start with no text

selected. To change text attributes of existing text, start by selecting

the text object.

2. Choose Text from the Format menu.

3. In the Text Fonnat dialog box, select options, and then click OK.

For more information about the options, see "Formatting text

attributes in individual fields" on page 3-60.

Keep these points in mind:

Changes to preset options affect the text format of text objects and

fields you add later. See "Formatting text attributes in individual

field.s" on page 3-60.

You can set default paragraph styles for text and fields before typing

text or creating new fields. To format text in paragraphs and fields,

see "Formatting text paragraphs" on page 3-84.

Preset attributes apply to text objects that you create by selecting the

text tool and dragging to make a bounding box on the layout. If you

click on the layout and begin typing text, the preset attributes don't

apply.

Text attributes do not appear when you view data using Web browser

software.

^ Choose FileMaker Help Index from the ES or Help menu, and then type:

text, formatting



Chapter 4: Working with information in records

After you create a database and define fields, you can enter and work with data

in the file. This chapter explains how to:

add and edit data in a database

view records in a database

find groups of records to work with

delete records

sort records

For information on adding, editing, viewing, searching for. deleting, and

sorting records on the Web, see chapter 1 1. "Publishing files on the Web."

Important Before you read this chapter, be sure you know how to use

FileMaker Pro Help, as explained in the preface, "Getting help."

Working in Browse mode
When you finish defining fields for a new file, FileMaker Pro moves to

Browse mode, where you enter data into the file. (You also work in Browse

mode after you open a file or when you choose Browse from the Mode menu.)

In Browse mode you work with the contents of a file rather than the

appearance and layout.

When you work with a new database in Browse mode, you start with a

Standard layout. You can modify this layout and create additional layouts in

Layout mode (see chapter 3, "Laying out and arranging information"). If the

database you're using has several layouts, you can choose a different layout

from the layout pop-up menu at the top of the status area.

In Browse mode, you also view, change, find, omit, sort, copy, and delete

records.

You can work with all the records in a file or a group of records, in sorted order

or the order in which you added them to the file. When you choose a group of

records to browse, you temporarily separate those records from the others in

the file so you can work with them.
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Each file has one current record at a time, which is the record on the screen if

you're viewing individual records, or the record marked with a solid bar if

you're viewing records in a list.

Layout pop-up menu

Bool<-

Number of records in the file

Current sort status of

records

Status area -

J^

Vern Critser iPromotions Assistant 712 555-5245
Client First Client Last

,690 Fieldmg PI

PhonefExtension

] I

712 555-3322" ^ I
315 555-OOTr

Home Phone FftxHunber

:
Address 2

j
Toronto "1 |M5S2W8 1 |

Canada

City Post Code Country

IJaneT Svanson

Agent Name

1
115195 ~|

Date Entered

JW» Tfhd
I

list I tatels
]
'Lener

|

Browse |'^
|

Status area control

Zoom controls

Mode pop-up menu

*? Choose FileMaker Help Index from the ^ or Help menu, and then type:

records, overview

33

Adding data to a file

Add data to a file by typing, pasting, or copying data into blank fields of a

record. FileMaker Pro saves the file as you work. The following sections

describe how to add data to a file.
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Selecting a field for data entry

To work with data in a field, you first select the field. The boundaries of

a selected field are solid lines; boundaries of other fields are dotted lines.

To Do this

Select a field for data enti^ Click in the field. FileMaker Pro scrolls if necessary to

display the field's contents. FileMaker Pro extends a

field that's filled beyond the border, if the field has no

scroll bar. until you move out of the field.

Move to the next field in the field Press Tab.

order

Move to the previous field in the Press Shift-Tab.

field order

Keep these points in mind:

You can't press Tab to move to some fields (for example, calculation

and summary fields and fields omitted from the tab order) in Browse

mode. You must click in them to select them, as long as the fields

have been formatted to allow entry (by selecting Allow entry into field

in the Field Format dialog box in Layout mode). You can't add data

to calculation and summary fields, but you can copy their contents to

other fields.

To change the order in which pressing Tab or Shift-Tab moves you

through the fields, see "Setting the tab order for data entry" on page

3-69.

9 Choose FileMaker Help Index from the ^or Help menu, and then type:

entering data

Adding and duplicating records

You add records to a database by using the New Record and Duplicate

Record commands and then typing or pasting data into blank fields of the

record. If you specified entry options to enter values automatically, you

see those values entered in the record.
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Duplicate an existing record to quickly add a record with the same or

similar data. When you add or duplicate records, each new record is

placed at the end of the file. When you browse a group of records you

found (called thefound set), new records appear at the end of the group

(until you sort them).

To Do this

Add a record Choose New Record from the Mode menu. (You see a blank

record with one field selected. ) Type data into the fields. (See

the next section, "Entering and changmg data in fields.")

Duplicate a record Select the record to duplicate. Choose Duplicate Record from

the Mode menu. You can change data as needed. (See the

next section, "Entering and changing data in fields.")

Note To return the current record to the way it was before you began

adding or changing data, choose Revert Record from the Mode menu
before you select a different record or leave the current one.

*? Choose FileMaker Help Index from the gS or Help menu, and then type:

entering data

Entering and changing data in fields

You can enter information up to the limit for the field type (for example,

255 characters in a number field ), but you can see and print only as much

data as fits within the tleld boundaries. (You can change the boundaries

in Layout mode. See "Resizing objects" on page 3-50.)

To
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To Select the field, and then

Type in a time field Type the time as hours and minutes or as hours,

minutes, and seconds in the format used when the file

was created or the current system format for time (if Use

System Formats is set), separated by a nonnumeric

character like : (colon). Use 34- or 1 2-hour format, with

or without AM or PM. (AM is assumed for a time less

than 12:00.) You can type a negative 24-hour time (like

-08:40:00).

For information about system formats, see appendi,\ B,

"Working with international files."

Insert a lab character in a field Press Option-Tab.

Add data to a container field See "Working with container fields" on page 4-6.

Delete a character Place the insertion point to the right of the character,

and then press Delete. Or place the insertion point to the

left of the character, and then press Del.

Edit data quickly, using commands See "Editing objects and data quickly using the context

in a pop-up menu menu" on page 3-42.

Replace text Select the text, and then type the replacement. Click

twice to select a word, three times to select a line, four

times to select a paragraph, and five times to select the

entire field contents.

Keep these points in mind:

You can add a vertical scroll bar to a field. A scroll bar lets you see

all the field's contents without changing the field's boundaries. See

"Adding scroll bars to fields" on page 3-71.

In a date field, if you don't type a year, FileMaker Pro enters the

current year for you,

There are many other ways of entering data in a field, like inserting,

or copying it from another source, using a lookup, or having

FileMaker Pro automatically enter the data each time you create a

record. See the appropriate sections in this chapter: chapter 8,

"Importing and exporting data:" "Choosing data entry options" on

page 2-6; and "Looking up and displaying data from other files" on

page 10-1.

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

entering data
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Working with container fields

A container field can store a graphic, a sound, or a QuickTime movie.

Note Sounds and QuickTime movies are not supported in FileMaker Pro

Web Companion Instant Web Publishing.

Importing graphics

1

.

Select the container field to import into.

2. Choose Import/Export from the File menu, and then choose Import

Picture.

3. In the Import Picture dialog box, choose options for the graphic, and

then click Open.

To Do this

Choose the file to import Select the name of the file (switch to a different

folder if needed).

Store a reference to the graphic file Select Store file reference. (This keeps the file size

in the field down. However, if the file is moved or deleted,

FileMaker Pro can't display the graphic.) To store

the graphic in the file, deselect Store file reference.

Select a file -

Choose a file type -

Please select a file

iQClip Hit !
IF{ Airplane B&UI

^ Rider BGUI

5) Rrroiu 14-uiayl

[^ Rrroai Icuruel

[?] Rrrouil saw

[g Rrrow2 BfHiP

[^ Rsia BtVUI

g| Balloon IThinklngI BSUI

Shoui: [pTct)

n Store file reference -

Eject

Desktop

nppn
jl

Cancel ]

Select to store a

reference to the

graphic file in the field

9 Choose FileMaker Help Index from the (2) or Help menu, and then type:

importing data

Importing QuickTime movies

1 . Select the container field to import into.
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2. Choose Import/Export from the File menu, and then choose Import

Movie.

3. In the Import Movie dialog box. double-click the filename (change

folders, if needed).

Choose a QuickTime -

movie file

Select to see a frame of

the movie displayed
-

Create "]

I'Si QuickTime mouies '^
|

Q Bird Moiiie

Q Bird Mouie.no snd

Q Stream Mouie

Q Trees G Sun Mouie

Q Water Mouie

] Shou) Preuieui

^ Hard Disk

[ EJI-" 1

[ Desktop I

t Ope"
ll

j^ I
Cancel 1

To crop or scale the first frame of the movie, see "Defining display

formats for fields" on page 3-59.

9 Choose FileMaker Help Index from the (£ or Help menu, and then type:

importing data

Playing QuickTime movies

To control a QuickTime movie, click the field containing the movie, and

then use the movie controls.

Click the Play button to

start or stop the movie

Drag the scroll bar to go to a

specific frame of the movie

Click the Backward or Forward

button to step through the frames
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The movie in a container field is a reference to a QuickTime movie file.

If you move the database to a different computer, move the movie file

as well (unless you have access to it through an AppleShare network

server).

Pasting graphics, movies, and sounds from the Clipboard

Cut or copy a graphic, movie, or sound in a different application by

putting it on the Clipboard. Then paste it into a FileMaker Pro container

field.

1

.

After you cut or copy the graphic, movie, or sound to the Clipboard,

open the FileMaker Pro tile to paste into.

2. In Browse mode, display the record to paste into, or add a new record.

3. Select the container field, and then choose Paste from the Edit menu.

To delete graphics, movies, or sounds, select the container field and

press Delete, or use drag and drop to move the item to the trash (see

'Using drag and drop to move information" on page 4-13).

Note You can also drag and drop graphics and sounds into container

fields. See "Using drag and drop to move information" on page 4-13.

Choose FileMaker Help Index from the CS or Help menu, and then type:

playing

!t**iss£affi.i^sswagsitxaas£«isa?issiifflasa^^

Recording and playing sounds

With Sound Control Panel and a microphone, you can play and record

sound.
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Entering data from a value list

in Layout mode, you can define a list of values to enter or validate data

in one or more fields and format the values to appear in a pop-up list, a

pop-up menu, as radio buttons, or checkboxes. You can also include an

Other item (to add a value not in the list) and an Edit item (to add or

change values from Browse mode) in value lists. (See "Choosing data

entry options" on page 2-6 and "Formatting repeating fields" on page

3-72.)

To
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Type a value to -

enter in the field

Holiday

f
Cancel Iff OK

'P Choose FileMaker Help Index from the CS or Help menu, and then type:

entering data

Viewing and inserting data from another source

To maintain consistency across records, you can do the following:

View values in the index (when a field is indexed), which contains all

the values in the currently selected field and insert them into the

current field.

Insert the current date, time, or user name.

Working with the index

When you have field values indexed (by selecting storage options in the

Entry Options dialog box), FileMaker Pro indexes the values in each

text, number, date, time, and calculation field. You can view the values

in a field's index, and insert them into the field to prevent typing

duplicate values incorrectly. (To index fields, see "Indexing fields" on

page 2-12.)

Note Inserting values from the index is useful in Find mode. In Browse

mode, prevent errors by creating a value list and inserting values from

the list into the currently selected field instead of pasting values from the

index. (See "Defining value lists" on page 3-75.)

1 . Select the field to hold a value from the index.

To replace the current field value, select the data to replace. To select

the entire contents of the field, choose Select All from the Edit menu.
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2. Choose Paste Special from the Edit menu, and then choose From Index.

3. In the View Index dialog box. to view each word instead of each

value, select Show individual words.

4. Double-click a value to paste.

Indexed values in a field

^^m View IndcK |
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Keep these points in mind:

After you insert the current date or time into a field, that value doesn't

change. To display the current date or time, place a date or time

symbol on the layout. See "Displaying special infomiation" on page

3-83.

You can use a script to insert infomiation into a find request (for

example, have a script enter the current user name to find all records

specific to the current user). For more information, see "Displaying

customized layouts'" on page 5-32.

'7 Choose FileMaker Help Index from the i2i or Help menu, and then type:

entering data

Copying and moving values and records

You can copy values from any field type, including fields that are

formatted as radio buttons, checkboxes, pop-up lists, and pop-up menus.

To Do this

Copy or move a value from

one field to another

Select the field contents and choose Copy or Cut from the Edit

menu. Select the field to hold the data, and then choose Paste

from the Edit menu.

Copy or move a value from a Select the field contents and choose Copy or Cut from the Edit

field in one record to a field menu. Display the other record (see "Movmg through

in another records" on page 4-18). Select the field to hold the data, and

then choose Paste from the Edit menu.

Copy a value from the last

record you modified

Select the field to hold the data. Choose Paste Special from the

Edit menu, and then choose From Last Record.

Copy values in a record to

another application, like

word processing

With no field selected, choose Copy from the Edit menu. In the

other application, paste the record that's in the Clipboard.

Copy the found set of

records

See "Copying the found set" on page 4-29.

Duplicate data from another See "Adding and duplicating records" on page 4-3.

record in the current record
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Keep these points in mind:

You can also drag and drop information between fields, records, and

applications. See the next section, "Using drag and drop to move

information."

When you paste data into a field formatted as radio buttons,

checkboxes, or a pop-up list or menu, the appropriate value is

selected, replacing the entire contents of the currently selected field.

When you paste a value that's not in the field's value list, the Other

value is selected, if applicable.

When you copy a record, everything is copied except data in

container fields (including calculations with container results and

global fields of container type). Text fields are copied in

tab-delimited format, without styles, in the order they were created in

the file.

9 Choose FileMaker Help Index from the gS or Help menu, and then type:

copying data

deleting data

pasting

Using drag and drop to move information

You can use drag and drop to transfer information to or from

FileMaker Pro and other applications that are drag-and-drop capable

without using the Clipboard.

To use drag and drop, you need System 7.5 or later, or System 7.0 with

the Macintosh Drag and Drop extension.

You can use drag and drop in Browse mode. Layout mode, and Find

mode. In Layout mode, use drag and drop to transfer graphics or text. In

Browse mode, use drag and drop to transfer text, or the contents of a

container field, to another field. You can use drag and drop between

FileMaker Pro and other applications. Each application you're using

must support the type of data you're transferring (for example, you can't

transfer a graphic into a text field).

1 . Be sure both applications are open and visible on the screen in

Browse. Layout, or Find mode.
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2. Drag an object from one application to the other.

You see an outline of the object you're dragging while you hold the

mouse button down. If the other application can accept the object, the

destination area (for example, a field) is highlighted.

Keep these points in mind:

To disable drag and drop for text in fields, deselect Enable drag and

drop text selection in the General area of the Preferences dialog box.

See "Setting general application preferences" on page 9-2.

You can't use drag and drop with more than one object at a time into

FileMaker Pro.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

drag and drop

Replacing field values

You can replace the contents of a field in all or some records with a

different value (for example, replace the value Production Artist with

Production Specialist), a new series of serial numbers (when, for

example, records have become disordered), or an expression. You can

also modify a field's existing values by using an expression that includes

the field (for example, change the value Gross Pay to the expression

Gross Pay + 1000).

Before you begin, keep these points in mind:

You can't replace calculation, summary, or global fields.

You can't reserialize calculation, summary, global, or container

fields.

You may want to sort records before you reserialize them. For

example, sort suppliers by how frequently you use them, and then

reserialize the records. (See "Finding infonnation" on page 4-19,

"Omitting records" on page 4-26, and "Sorting records" on page

4-30.)

To replace data in fields in only a few records, go to each record and

change the value by selecting the contents of the field and then typing

the information you want.

Important You can't undo replacing field values. Before you begin,

consider making a copy of the file.
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To replace field values:

1. In Find mode, find the records whose data you want to replace.

2. If you want the data in a specific order, in Browse mode, sort the

records.

3. In Browse mode, in the current record, select the contents of the field

whose values you want to replace.

4. If you're replacing data (not assigning serial numbers), type the value

to replace the current data with.

5. Choose Replace from the Mode menu.

6. In the Replace dialog box, choose how to replace field values.

To replace each field

with Select

The value in the currently

selected field

Replace with <value>. FileMaker Pro replaces the

contents of the field for the entire found set.

A serial number

An expression you specify

Replace with serial numbers. Then type the starting value

for the serial numbers and how much to increment each

number by. (FileMaker Pro enters serial numbers

starting with the first record in the found set).

If you chose to automatically enter a serial number

when you defined the field, you can update the next

serial number value in the Entry Options dialog box by

selecting Update serial number in Entry Options? in the

Replace dialog box.

Replace with calculated result, and then click Specify. In the

Specify Calculation dialog box. define the expres.sion.

(See "Writing fonnulas for calculation fields" on page

2-20.) The expression result must match the field type

of the replaced field.

Select how to replace -

field values

Permanently replace the contents of the field

"Iniioice number" in the 4 records of the current

found set?

O Replace uiith: 53847"

(§) Replace uiith serial numbers:

Initial ualue: 04840

Increment by: I

Eil Update serial number in Entry Options?

O Replace uiith calculated result: [
Specify..
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7. Click Replace.

Note If the field that contains the replaced data is validated, FileMaker

Pro doesn't validate the new data. (See "Choosing data entry options"

on page 2-6.)

O Choose FileMaker Help Index from the CS or Help menu, and then type:

values

Working with records

After you add data to records, you can work with them in various ways,

as described in the following sections.

Browsing records

View records individually or as a list. When you're browsing individual

records, the current record is the one you're viewing. When you're

browsing records in a list, you see as many records as fit on one screen.

In a list, the current record is marked with a solid bar along the left

side.

To browse individual records, choose Browse from the Mode menu.

(Be sure View as Form in the Select menu is chosen.)

To browse records in a list, choose Browse from the Mode menu, and

then choose View as List from the Select menu. To work with a

particular record, click anywhere in the record to make it the current

record.
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Current record bar

When you view records in a

list, you see any header or

footer in the layout

<-(-+

Neiu Tours ;

Available Tours

Everywhere

Cruise Destination Caribbean

Cniise wholesnie price $1 521 tO $3694

Cruise Ship [Grand Bordeau»|

Tour length 1 1 niqhtS

Seoson O :3F'"n9 OSumiTier o Autumn o'*'"ite'" « All year

.. San Juan, St Thomas. Curacao, St Martin, and Cozurnel Luxuri/ ',o.

laccommodations No tipping policy

'"UJpI

Cruise Ship Explorer cruise Destination SOUttl Pacific

Tour length 21 nightS Cruise .holesale price J 3,995 tO $9,550

Season O Spring oSummer QAutumn QWinter ®Allyear

Notes Includes New Zealand, Australia, Tonga, and Fi|i

Spnng Tour Catalog

"RT "RH

Note You can also prepare a Columnar report layout to show records in

a list. See "Using Columnar report and Extended columnar layouts" on

page 3-9.

Opening a URL

If you have a valid URL (Web address) in a field, you can click on the

address, automatically open your Web browser, and go to the URL.

To open a URL from a field:

1

.

Press and hold the Command key, and then click any part of the URL.

2. Choose Open <URL> from the context menu.

Note This feature requires the Internet Config 1.1 (or later) tool. For

information on installing this extension, see your Mac OS

documentation.
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Moving through records

To move from one record to another, use keyboard commands or the

book in the status area. When you browse individual records,

FileMaker Pro displays the number of the current record in the

lower-right comer of the book. When you browse records in a list, the

current record is also identified by a solid bar to its left.
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Finding information

You find specific records using Find mode. In Find mode, you can get a

subset of the records in a file (called thefound set) to do the following:

Get specific information based on the data in text, number, date, time,

and calculation fields.

View, edit, perform functions on, calculate summaries for, sort, print,

delete, export, or copy the found set to a different file.

Find records that contain errors like empty fields, duplicate values,

invalid dates or times, or mistakes you might notice (like

misspellings) while viewing the index.

Further reduce the found set by omitting records from it.

To find records, you type criteria (the value or values to find) into fields

in a find request, which looks like a blank record. FileMaker Pro

searches through all the records to compare the criteria with the data in

the file. Records whose fields match the criteria are added to the found

set, and the found set becomes the records.being browsed.

Find requests can be as simple or complex as required, from a single

request for a name in a field to multiple requests using operators and

omissions.

Defining find requests

1

.

Choose the layout to use for finding records.

The layout must include each field you plan to enter criteria into.

2. Choose Find from the Mode menu.

3. In the find request, select the field to use for finding, and then type

values in the field.

You can combine values you type with operators from the Symbols

pop-up menu.
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You can't enter search criteria in container fields, summary fields, or

global fields.

To find values that are

Use this For example, enter this

operator in the field

Less than the value to the right of the

symbol
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See the following sections for more information about search criteria.

Click a page of the book to -

see anottier find request

Nunnber of the current request -

Number of existing requests -

Click to exclude records

that match the request

Click to begin searching -

Choose operators from the -

Symbols pop-up menu to

paste into the request

_?

Client Entrt)
|

<-M-

Omit

[LHl

Client Entry

r B V ' V ir L

Cliewi Firsi Criewt La
< 1ms than

i less *han or equal

> greater than

i greater than or equal

= exact nwtch

range

' duplicates

// todags date

? Invalid date or time

I?" one character

* zero or more characters

" " literal text

"» field content match

Hone Phone

Phone'Extension

Fuc Number

Dale Entered

«e»
I
^^f^nd

I
List Jt«beli5 I letter

]

4. Click Find in the status area, or choose Perform Find from the Select

menu.

To cancel before searching is finished, press Command-period.

Keep these points in mind:

To return the find request to the way it was before you began adding

criteria, choose Revert Request from the Mode menu.

Use the "=" operator when you want to find a value that is exactly as

you specify—although the field could contain additional values.

( "=John" could return "John," "John Smith," and "John Q. Public") Use

the "==" operator when you want to find exactly what you specify, in

the order you specify ( "==John" returns "John" only; "==John

Smith" returns "John Smith" only, not "Smith John.")

You can use the index (if the field's values are indexed) to insert

values into a find request. See "Working with the index" on page

4-10.
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You cannot find duplicate values in unindexed fields. For more

information, see "Indexing fields" on page 2-12.

You can perform finds on related fields. See "Finding and omitting

related records" on page 10-34.

Choose FileMaker Help Index from the CS or Help menu, and then type:

find requests, defining

Finding information in different field types

In specific field types, you can find:

text that matches a word, phrase, or a string of characters in a text

field or in a calculation field that produces a text result

text characters that aren't indexed (literal text)

numbers in a number field or in a calculation field that produces a

numeric result

dates in a date field or in a calculation field that produces a date result

times in a time field or in a calculation field that produces a time

result

Note To find data in a container field, create a text or number field that

describes or identifies the contents of the container field. Then find the

value in the text or number field.
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To find this in a text field Type this in the field Example

Words that start with specific The specific characters

characters

Chris Smith finds Chris

Smith, Chris Smithson, and

Smith Christenson

A word that is part of a field's An equal sign ( = ) before the

contents word

=John finds John and John

Smith (but not Johnson)

An exact word and nothing Two equal signs (==) before

else the word

==John finds John only

==John Smith finds

John Smith (but not

Smith John)

Exact matches on several An equal sign (=) before each

words in the same text field word in the search criterion in

that field

=Chris =Smith finds

Chris Smith or Smith Chris

(but not Christopher

Smithwicio

Words that vary by one or One wildcard character (@)

more characters for each unknown character

Gr(aY finds Gray and Grey

Words that vary by more than The wildcard character ( *

)

one character for all unknown characters

McK*ie finds McKechnie and

McKenzie

Whole words of literal text

(text exactly as it appears, but

regardless of uppercase or

lowercase I

Choose Literal text from the

Symbols list. Type the text,

including spaces and

punctuation, surrounded by

double quotation marks (
" ).

"Marten and Jones
Interiors" finds IVIarten

an(j Jones Interiors but not

Jones and Marten Interiors

Partial words of literal text

(text exactly as it appears, but

regardless of uppercase or

lowercase)

Choose Literal text from the

Symbols list. Type

characters, punctuation, and

spaces exactly as they appear

in the file, .surrounded by

double-quotation marks (
" ).

Type the wildcard character

(*) to find text in the middle

of the literal text string.

*"son i Phillips" finds

Johnson & Phillips and

Paulson & Phillips

"
, " finds Boston, MA and

Markley Insurance, Inc.

Keep these points in mind:

Searching for literal text takes longer than word searches. (See

"Indexing fields" on page 2-12.)

You can omit records when you define one or multiple requests. See

"Omitting records" on page 4-26.

'P Choose FileMaker Help Index from the (2] or Help menu, and then type:

symbols
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Finding numbers, dates, and times

To find Type this in the field Example

A number in a number field

or calculation field that

produces a numeric result
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Finding different sets of criteria

You can find all the records in a file (for example, after you've created

a found set), find records that match more than one set of criteria (logical

AND search), or find records that match either one set of criteria or

another (logical OR search).

To find Do this

All the records in a file Choose Find All from the Select menu.

A group of records thai match a

specific set of criteria

In one request, enter critena into as many fields as

needed to make your request specific (creating a logical

AND search), and then click Find (or choose Perform

Find from the Select menu). For example, type Johnson
and Personnel to tmd all people named Johnson who
work in Personnel.

Records that match one criterion or

another

Choose New Request from the Mode menu. (Or use the

bookmark to display the request to duplicate, and then

choose Duplicate Request from the Mode menu. I Enter or

edit the criteria, continue adding new or modified

requests for each set of criteria (creating a logical OR
search), and then click Find (or choose Perform Find from

the Select menu). For example, type New York in the

first request and Paris in the second request to find all

records that contain either New York or Pans.

^ Choose FileMaker Help Index from the gJS or Help menu, and then type:

recor(Js, fin(Jing

SffWaS^-«!TC!5STt»f&S»lit&»W

Repeating, editing, and deleting find requests

You can repeat the most recent find request to find records that match

the same criteria. If you add or delete records after defining the first

request, the result is a different set of found records. You may also edit

your requests before finding records again.
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You can delete requests as long as you keep at least one.

To
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To Do this

Omit a specific record Display or select the record to omit, and then choose

Omit from the Select menu.

Omit groups of records Display or select the first record in a number of

consecutive records to omit, and then choose Omit

Multiple from the Select menu. In the Omit Multiple

dialog box. type the number of records to omit, and then

click Omit.

Bring back all the records in the file Choose Find All from the Select menu.

Switch the found set with the

omitted set

Choose Find Omitted from the Select menu.

Find some records and omit others In one request, type the criteria for finding the records.

In a second request, click Omit, and then type the criteria

to remove records from those found. Then click Find (or

choose Perform Find from the Select menu).

Find records that don't match the

request

In one request, type critena for the records to omit.

Click Omit, and then click Find (or choose Perform Find

from the Select menu).

Note FileMaker Pro works through multiple requests in the order you

specify, so define the omit requests last. Otherwise, subsequent find

requests might include records that should be omitted.

The following example shows three find requests where one request

omits a group of consecutive records. Together, these three find requests

find all records of employees in Marketing and Operations and omit

those whose title is Director.

The first request finds all

records where Department

is Marketing, that is, all

employees in Marketing
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The second request finds all

records where Department

is Operations, that is, all

employees in Operations
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Copying the found set

You can copy the found set to the CHpboard to paste the records into a

different apphcation, htce a spreadsheet. Container fields aren't copied.

In Browse mode with no fields selected, press Option-Command-C.

FileMaker Pro copies the data to the Clipboard in tab-delimited format

(in fields, separated by tab characters), without text styles, in the order

they were added to the file.

'P Choose FileMaker Help Index from the C£ or Help menu, and then type:

copying records

Deleting records

You can delete an entire file of records, delete groups of records, or

delete single records. When you delete a record, you permanently

discard the data in all the fields in that record.

Important You can't retrieve deleted data, and you can't undo deleting

records. Before you delete records, it's a good idea to make a backup

copy of your file.

To delete Do this

One record Select the record to delete and choose Delete Record from the

Mode menu. In the alert message, click Delete.

A group of records Use Find or Omit Multiple to select a subset of records to delete,

and then choose Delete All from the Mode menu. In the alert

message, click Delete.

All records in a database Choose Find All from the Select menu, and then choose Delete

All from the Mode menu. (Or create a clone of the database

with no records. See "Saving a copy of a file" on page 1-11.)

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

records, overview
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Sorting records

FileMaker Pro stores records in the order they were added to the file.

However, you often want to work with records in sorted order. Sorting

temporarily rearranges all or a group of records (the found .set) based on

the entries in a field or set of fields, so you can browse, update, or print

the records in a different sequence.

You sort records by selecting fields whose contents you want to sort by.

The first sort field airanges the records based on the field's contents. The

second sort tleld arranges records when two or more records have the

same value in the first sort field, and so on. You can sort records in

ascending order, descending order, or in a custom order based on a value

list.

FileMaker Pro keeps the records in the sorted order until you perform a

find or sort the records again.

1

.

To sort some but not all of the records, find the records to sort.

See "Finding information" on page 4-19.

2. Choose Sort from the Mode menu.

3. In the Sort Records dialog box, choose fields for sorting, in the order

you want them sorted.

To Do this

Choose a sort field and sort it In the fields list, double-elick a field,

according to the selected order

Assign different sort orders to For each sort field, in the fields list, select a field, select

fields as you add them to the a sort order, and then click Move.

Sort Order list
Ascending order is first to last character in the alphabet

for text, lowest to highest for numbers, and earliest to

latest for dates and times. Descending order is last to

first character in the alphabet for text, highest to lowest

I lor numbers, and latest to earliest for dates and times.

Change the sort order for fields For Sort Order, select a field, and then select a sort order,

in the Sort Order list

Sort according to the order of In the fields list, select a field, select Custom order based

values in a value list (for on value list, and then choose or define a value list. (See

example, in the order months "Defining value lists" on page 3-75 and "Entering data

are arranged) from a value list" on page 4-9.)

Change the order of fields in For Sort Order, use the double-anow (to the left of the

the Sort Order list field name) to drag the field to a new position.
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To Do this

Remove a field from the Sort For Sort Order, double-click the field.

Order list

Remove all fields from the Sort Click Clear All.

Order list

Sort by summary fields Select Include summary fields. ( See "Sorting by summary

fields" on page 4-32.

)

Use a language for the order in Select Override field's language for sort, and then choose a

which fields are sorted that's language,

different from the one used for

indexing

Close the Sort Records dialog Click Done,

box without sorting

Select fields to sort

Select the sorting order

Horn*. Phone

department

Salary

last Review Date

Next Review

.I (s)
*

I.. O I--

I.. O '--'•

Sort Records
;

3 Sort Order

t Oepartmerit

* Last Name

I ]
Include summary fields

. dlue lisf <No Lists Defined

I I
Override field's Unqud^e for sort

|
English

4. Click Sort.

To cancel before sorting is finished, press Command-period.

Keep these points in mind:

To sort records that have container fields that you want in order,

create a text or number field that describes or identifies the contents

of the container field. Then sort by the text or number field.

To restore records to the order in which they were added to the tile,

choose Sort from the Mode menu, and then click Unsort in the Sort

Records dialog box.
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When you sort repeating fields, or related fields in portals, FileMaker

Pro uses only the first value in the repeating or related fields to sort

records. To sort records based on values other than the first value,

make separate records for each repeating value.

You can specify a sort order for related fields. If the match field in

one record in a file relates to the match field in more than one record

in a related file, you can specify that the related field in the first file

display a sorted value (or several sorted values if the related field is

in a portal displaying more than one row). For more information,

"Sorting related data" on page 10-43.

When you add a record to sorted records, FileMaker Pro tries to

maintain the sort order. It adds new records to the end of the group

the current record is in. For example, if you sort records by month and

add a record where the month is June, FileMaker Pro adds the record

to the end of the group of June records. The message in the status area

changes to Semi-SOrted to indicate the approximate order. When you

finish adding records, resort them.

To create a script with a sort order, define the sort order, and then

click Done. Then define the script.

"? Choose FileMaker Help Index from the gS or Help menu, and then type:

sorting records

tj:i«?:;^;>::j«iffiEiSSimSSSBB

Sorting by summary fields

You can include a summary field in the sort order. For example, sort on

a summary field named Monthly Sales Totals and on a field named Sales

Region to show monthly sales totals for different sales regions. (To sort

a summary field like Monthly Sales Totals, you must include a second

nonsummary field like Sales Region or Salesperson.)

Keep these points in mind:

Sorting by summary fields affects the order of printed or previewed

records but doesn't change the order of records in Browse mode.

A summary field selected for sorting is placed at the bottom of the

Sort Order list. Summary fields can't be sorted in a custom sort order.
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If data is already sorted appropriately for the summary report, you

don't have to re-sort when you add or remove summary fields in the

sort order. Add the summary field as described in the previous

section, and then click Done (not Sort).

"? Choose FileMaker Help Index from the (2j or Help menu, and then type:

summary fields



Chapter 5: Using ScriptMaker and buttons

FileMaker Pro includes ScriptMaker software, which you can use to

automate tasks like:

switching to another layout or mode

finding, sorting, and printing records

dialing phone numbers

This chapter tells you how to use ScriptMaker and how to define buttons

to perfomi script commands.

Note FileMaker Pro scripts are not available when you publish a

database on the Web using FileMaker Pro Web Companion Instant Web
Publishing.

Important Before you read this chapter, be sure you know how to work

with FileMaker Pro. as explained in the rest of this guide. You should

also know how to use FileMaker Pro Help, as explained in the preface,

"Getting help."
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Understanding scripts

A script is a command that tells FileMaker Pro to carry out one action

or a sequence of actions. You perform a script to carry out its actions.

For example, when you click the Letter button on the Client Entry

layout, a script displays the Letter layout. Then the script switches to

Preview mode and pauses so you can see what the letter looks like when

it prints.

CTignl Entry"}

gj Client Entry

|Bill^_
Clieni Fir

lAdlnigton [Marketing Assistant

Client rutc

1[6 15] 555-88991

^ 1(914) 555-t304~

F*x Hunbcr

lMernphl3_

Ci*y

[0^"

[Ml AdluigDnpiefers luxury accommodsQcina

Notes

ZS\

[Janet Svanaon

Agent Naaie

D*ie Entered

_r
New |[ Frnd B list |[ Labels || Letter

JIE
"Print Letter

"

* Go to Layout ["Letter "1

* Enter Preview Mode [Pause

* Page Setup (Restore, No dialog]

* Print [No dialog]

* Go to Layout [original layout

* Enter Browse Mode [

~M

Buttons on a layout

When you click the Letter button,

FileMaker Pro performs the Print

Letter script

Click to continue the

-

script—FileMaker Pro prints

the letter, and then returns to

the Client Entry layout in

Browse mode

Script

f Cw»MiMi«|

[ CjiwH
I

oQriS

Everywhere

\
Dear Billy Adlington,

i Thank you for reserving a cruise vilh us We value your business and appreciate

,
the opportunity to serve you

I

If you have any questions about your reservauons, please call us—ve vanl you to F

• be satisfietl vilh your cruise

Sincerely,

lanet Svanson

l»IM
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Scripts help you do a job the same way every time. They carry ou

simple steps, like changing the printing orientation for envelopes,

complex tasks, like preparing a large mailing.

You can perform additional scripts, called subscripts, within a script.

Subscripts make it easy to break a complex task into small tasks. For

example, you can find customers with a balance due with one script, and

then print form letters requesting payment with another script. The first

script contains a command that performs the second script (the

subscript). If a subscript is in a different file, it's called an external

script.

With FileMaker Pro, you can:

define a script that pauses to let you do unscripted tasks, like entering

data. When you resume the script, FileMaker Pro perfomis the

remaining script commands.

save settings, like find requests and sort orders, in a script.

print the commands and settings that make up a script. (See chapter 6,

"Previewing and printing information?')

define passwords that prevent other users from defining or changing

scripts. (See "Protecting your files" on page 7-9.)

perfomi a startup script, a script that runs when you open a

FileMaker Pro tile. For example, a startup script can switch to a data

entry layout whenever you open a customer order database.

FileMaker Pro can also perform a shutdown script every time you

close a file. (See "Setting document preferences" on page 9-7.)

send Internet mail using a separate email client (this requires an email

account).

launch Web browser software and have it display a specified URL
(Web address—this requires an account with an Internet service

provider).

^ Choose FileMaker Help Index from the ££ or Help menu, and then type:

scripts, overview
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Understanding ScriptMaker steps

A step is a FileMaker Pro command that you use in a script. Steps are

similar to the commands you access through FileMaker Pro menus. For

example, you can create a record by choosing New Record from the Mode
menu, or you can perform a script that contains the New Record/Request

step.

Keep these points in mind:

Many steps have options that you specify when you define a script.

For example, you can specify a field name in the Go to Field step.

FileMaker Pro Help contains detailed information about steps and

options.

Some steps, like Paste, can only be performed in certain modes or

when a specified field is on the current layout.

Some steps can display a dialog box when you perform a script. For

example, a script with the Sort step can display the Sort dialog box so

you can enter a sort order.

You can use status functions in steps to monitor the state of your

database. For example, a script can check whether a file is sorted. Or

it can display a customized message that tells users what to do when

a found set is empty.

For a list of status functions, see "Status functions" on page C- 1 6. For

examples using status functions, see "Displaying customized

layouts" on page 5-32 and FileMaker Pro Help.

For information about using script steps with related fields, see

"Working with related fields" on page 10-30.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

script steps

status functions
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Use this step
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Navigation steps

Use this step
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Editing steps

Fields steps

Use this
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Records steps

Use this step
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1

Windows steps

Files steps

Use this step
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Spelling steps

Use this step
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Miscellaneous steps

Use this step
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Defining scripts

Which fields and layouts will the script need? Some steps require a

field to be on the current layout (like Go to Field, Paste Literal. Paste

Result, and Replace), while others don't (Set Field). Use Go to

Layout to switch to a layout that has the fields your script requires.

Should the script switch among modes? For example, use Enter

Browse Mode before modifying data in fields and records, and use

Enter Find Mode before setting up a find request or finding data.

Should the script work on all records in the database, the current

found set. or a specific set of records? What if no records are found?

Use one of the find or omit steps to set up the correct records.

Which record should the script start with? For example, when using

the Loop step, decide whether the loop starts at the first or last record,

a specific record, or the current record in a found set. Use

Go to Record/Request/Page to select a starting record.

How should the script advance through multiple fields and records?

Use navigation steps to move through a found set.

Should the records be sorted before the script processes them? If you

use the Loop step, use Sort or Unsort before the loop to order your

records properly.

When should the script finish? After all records have been processed?

After a specified condition has been met? Use the If step to perform

a task when the script reaches a specified condition.

How will you document your script design? Use the Comment step to

make your scripts readable and understandable.

How will you test your script? Use the Pause/Resume Script step to

pause at specific points in your script.

Tip Save a clone (or copy) of your database, and then define and test

your script in it to preserve the original data. After testing the script,

import data from the original file into the clone.

Define scripts in ScriptMaker by choosing steps and arranging them in

the order you want FileMaker Pro to perform them. If you're using a

subscript, define it first, and then define the script that calls (uses) it.

1 . If you're defining a script to print, import, export, find, or sort, first

store the settings for the script.

See '"Storing .settings for a script" on page 5-15.
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2. Choose ScriptMaker from the Script menu.

3. In the Define Scripts dialog box, type the name of the new script, and

then click Create.

Scripts defined in the file

Scripts with checkmarks -

appear in the Script menu

Drag the double arrow to -

reorder the script in the

Script menu

Type the name of a new script
-

Define Scripts for "Clients"

^ « List by Company
•y * List by flreo

t Cancel
t Find
t Find Customer from Inuoices
t To Inuoices
t Labels
t Print letter
t Start Mailing
t Print Clients
t Print Neui Entry
t New Entry

[ Perfoi

(
"II...

[ Create

[ Rename

[ Diipln ale

Script Name: M Include in menu

Select to include the selected script in the Script menu

- Click to

add a new
script

4, In the Script Definition dialog box, choose steps for the script.
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FileMaker Pro includes preset steps when you create a script. You

can change or delete the steps.

To
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7. Click Done.

"} Choose FileMaker Help Index from the (2) or Help menu, and then type:

scripts, defining

Storing settings for a script

When you define a script, FileMaker Pro saves the current settings for

page setup, importing, finding, sorting, and exporting. FileMaker Pro

can restore the settings when you perform the script.

To store settings for a script, specify them before adding Page Setup,

Print, Import Records, Perform Find, Sort, or Export Records steps to a

script.

To specify Do this

Page setup Choose Page Setup from ihe File menu. Select the settings you want, and
options then chck OK. For information about the options, see the manual that

came with your printer.

Print options Choose Print from the File menu. Select the settings you want, and then

click Print. FileMaker Pro saves most print settings, including the

number of copies and the type of infoniiation to print ( like ReCOrdS being

browsed). See "Printing" on page 6-12.

Iinport order Import records using the field order you want to store. See "Importing

data into an existing file" on page 8-4.

Find requests In Find mode, create the find requests. You don't have to click Find to

perform the requests. See "Defining find requests" on page 4-19.

Sort order In Browse mode, choose Sort from the Mode menu, and then choose the

fields you want to sort by and the son order. Click Done. See "Sorting

records" on page 4-30.

Export order E.xpoil records using the field order you want to save. See "Exporting

data from FileMaker Pro" on page 8-9.

Keep these points in mind:

To use the settings when you perform the script, select the Restore

option for Page Setup, Import Records, Perform Find, Sort, or Export

Records steps.

A script can store only one of each type of setting, for example, one

set of find requests and one sort order. If you need more than one.

define a subscript that stores different settings. See "Defining scripts"

on page 5-12.
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To see the settings you stored with a script, print the script definition.

See chapter 6, "Previewing and printing information."

You can enter settings when you perform a script instead of using

stored settings. FileMaker Pro doesn't save the settings you enter

when you perform the script.

For example, if you add a Sort step and deselect the Restore sort order

and Perform without dialog options, the Sort dialog box appears when

you perform the script. If you select Restore sort order and deselect

Perform without dialog, the dialog box displays default settings that the

user can perform or modify.

*? Choose FileMaker Help Index from the ^ or Help menu, and then type:

scripts, managing
3S9&;asa«!a^'^'!»«r!»»s«!iTss:is^^

Changing and duplicating scripts

1. Change the settings stored for the script, if necessary.

See "Storing settings for a script" on page 5-15.

2. Choose ScriptMaker from the Script menu.

3. In the Define Scripts dialog box, select a script name.

To
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5. In the Script Definition dialog box, change the script steps, and then

click OK.

To Do this

Add a step

Delete a step

Select the step in the Available Steps list, and then click Wlove.

Select options for the step, if they're available.

Select a step in the sciipt, and then click Clear,

Change step options Select a step in the script, and then change the options.

Change the order of Drag the double arrow to move a step,

steps

Note If you're changing a script that was created with FileMaker Pro

for Windows, steps that work only in Windows are displayed in

italics. You can't change the options for these steps.

6. If you see the Script Settings dialog box, specify whether to keep or

replace the settings you previously stored with the script, and then

click OK.

FileMaker Pro
;

The follouMng information is needed to perform ttiis

script. Vou can;

• Keep ttie information already saoed for this script

• Replace it luith the information currently in use

Page Setup: O Keep O Replace
Import Order: O Keep O Replace
Fmd Requests: O Keep O Replace

Sort Order: (§) Keep O Replace
EKport Order: (•) Keep O Replace

Dimmed options aren't available

in the current script

Select an option to keep or replace

all occurrences of that setting type

(for example, all sort orijers)

stored with the script

7. Click Done.

O Choose FileMaker Help Index from the C£ or Help menu, and then type:

scripts, changing

scripts, defining
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Reordering scripts in the Script menu
FileMaker Pro lists scripts in the Script menu and assigns keyboard

shortcuts (like Command- 1) to the first ten.

1. Choose ScriptMaker from the Script menu.

2. In the Define Scripts dialog box. drag the double arrow to the left of

the script name to a new position.

3. To add or delete a script from the menu, select the script, and then

select or deselect Include in menu.

Scripts with checkmarks appear in the Script menu.

4. Click Done.

'P Choose FileMaker Help Index from the S5 or Help menu, and then type:

scripts, managing
^/3E2»2sTsSSJira;^^S:S5i55^-:*Sl<3RK

Deleting scripts

1

.

Choose ScriptMaker from the Script menu.

2. In the Define Scripts dialog box, select the name of the script, and

then click Delete.

3. Click Delete again, and then click Done.

Important When you delete a script, change scripts and buttons that refer

to the deleted script.

9 Choose FileMaker Help Index from the gS or Help menu, and then type:

scripts, managing
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Performing, resuming, or stopping scripts

To Do this

Perform a script from the Script Choose the script name from the Script metiu,

menu

Perform a script from the Choose ScriptMaker from the Scnpi menu. Select the script

Define Scripts dialog box name, and then click Perform.

Perform a script using a Type the keyboard shortcut. (See "Reordering scripts in the

keyboard shortcut Script menu" on page 5-18.)

Perform a script from a button Switch to a layout that contains a button for the scnpt. In

Browse or Find mode, click the button.

Perform a script when opening In the Preferences dialog box. set the option to perform a

or closing a FileMaker Pro file startup or shutdown script. See "Setting document

preferences" on page 9-7.

Continue a .scnpt after it pauses Click Continue in the status area, or press Return. If you

switch layouts while a script is paused and then continue the

script, remaining script steps occur in the new layout.

Stop a paused script Click Cancel in the status area, switch to another mode,

close the active window, or quit FileMaker Pro.

Stop a script (except when it is Press Command-period, hide or close the active window, or

paused

)

quit FileMaker Pro. If the script contains a Close or Toggle

Window step that hides the active window, FileMaker Pro

stops the current script and returns to the script that called

it (if there is one).

Note You can't stop a script that contains the Allow User Abort [Off]

step.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

scripts, performing
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Using buttons with scripts

A button is an object on a layout that you can click to perform one script

step or an entire script.

loolJJE

Client Entry

Clienl First Client Last

iPrmUns Assistant |(304) 555^^9966]

PhvMclExtcBsian

1(702) 555-9875

l4one Plionc

;usA
ijanet Swuon
Agent Nane

Dale Entered

New
II

Fina || List || Labels Uleiefl

Buttons

When you click the Letter -

button. FileMaker Pro

performs the Print Letter scnpt

I Specify Button 1

In Browsr or Find modr, clicking o

srircted srI of objects will

- Specify
I
Print Letter t")

Keep these points in mind:

To show borders around buttons in Layout mode, choose Buttons

from the Show menu. See "Showing button, text, and field

boundaries'" on page 3-43.

To set buttons so they don't print, see "Keeping objects from

printing" on page 6-9.

FileMaker Pro doesn't store settings (like find requests) with a

button, but you can define a script that stores the settings and then

define a button to perform it. See "Storing settings for a script" on

page 5-15.
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Defining buttons

Use the following steps to create a button labeled with text. To specify

a preference option for rounded or rectangular buttons, see "Setting

layout preferences" on page 9-3.

Note To create another type of button (for example, a circle with a

graphic), see FileMaker Pro Help.

1. If you're defining a button that performs an entire script, create the

script.

See "Defining scripts" on page 5-12.

2. In Layout mode, choose a layout, and then click the button tool.

See "Working with the drawing tools" on page 3-38.

Button tool

Button

border

It tools don't appear on the layout,

click ttie status area control

3. Drag the crosshair pointer on the layout to draw the button.
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4. In the Specify Button dialog box, select a step, set step options (if

they're available), and then click OK.

See "Understanding ScriptMaker steps" on page 5-4.

specify Button

In Browse or Find mode, clicking on the

selected set of objects will

Go to Field

Go to Next Field

Go to Previous Field

Enter Brovse Mode
Enter Find Mode
Enter Preview Mode

Sort/Find /Print

Find All

Find Omitted

Omit

Options

I I
Perform without dialog

Select a step

Set options for the step

5. At the insertion point, type a label for the button, and then press Enter.

6. Switch to Browse or Find mode to use the button.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

buttons
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Copying, changing, or deleting buttons

To Do this in Layout mode

Select a button Use the pointer tool. See "Selecting objects" on page 3-39.

Move a button Using the pointer tool, drag the button. See "Moving objects" on

page 3-44.

Change the appearance See "Changing the appearance of objects" on page 3-50.

of a button

Change a button label See "Typing text" on page 3-80 and "Changing the appearance of

text" on page 3-88.

Copy a button See "Cutting, copying, and pasting objects" on page 3-45. When
you copy a button, you copy the object and the button definition. If

you copy a button from another file, change the button definition if

fields, layouts, or scnpts don't match.

Change a button Double-click the button. In the Specify Button dialog box, select a

definition step and options, and then click OK. To modify a script that the

button performs, see "Changing and duplicating scripts" on page

5-16.

Delete a button Select the button, and then press Delete.

O Choose FileMaker Help Index from the S) or Help menu, and then type:

buttons

Working with Apple events

Apple events are Mac OS commands that automate, customize, and

control many Mac OS applications, FileMaker Pro can send Apple

events to any application that supports them. The application that

receives an Apple event is the target application.

FileMaker Pro uses ScriptMaker to send Apple events to other

applications. (See "Defining a script to send Apple events" in the next

section.) For example, a script can send Apple events to open a

spreadsheet application, send it data, and then create a chart.

Apple events are grouped into suites. FileMaker Pro supports the

Required suite, a special subset of the Core, Table, URL, and Database

suites, and its own FileMaker suite. It also supports the object model, a

standard way to refer to objects.
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FileMaker Pro can receive Apple events from scripting applications that

are designed to send Apple events, like the AppleScript Script Editor.

Applications can send events to FileMaker Pro to perform many tasks,

including:

requesting data from a record or list of records

requesting a list of scripts and performing scripts

requesting a list of fields and getting data from the fields

sorting or finding records

placing or modifying data in any record, field, or list of records or

fields

switching layouts

creating and choosing menu items

opening and closing databases

FileMaker Pro can also send commands written in the AppleScript

scripting language. Scripting languages u.se terms like "open" and

"field" instead of the four-character codes in Apple events. (See

"Defining a script to perform AppleScript commands" on page 5-28.)

Support for Apple events is a technical feature for FileMaker Pro

developers. To learn more about Apple events:

open the Apple Events Reference database (included when you install

FileMaker Pro using the Easy Install option). The database contains

a complete description of all FileMaker Pro events and objects,

including examples and usage tips.

contact the Apple Programmers and Developers Association

(APDA).

read third-party books about Apple events and scripting applications.

log into the scripting forums available on many online services.

Keep these points in mind: %
To determine if an application supports Apple events, refer to the

documentation or the application's scripting dictionary (called an

AETE resource). You can view the dictionary using the AppleScript

Script Editor.
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You can use the Perform Applescript step to communicate directly

with FileMat;er Pro. For more information, see the Apple Events

Reference database. You can also use an applet, droplet, or scripting

application that communicates with FileMaker Pro.

FileMaker Pro can't receive Apple events while performing a

ScriptMaker script.

FileMaker Pro can send Apple events with text or AppleScript

commands that are located in a related file. See chapter 10, "Using

data from related files."

To send Apple events to FileMaker Pro on a network, you need a

local copy of FileMaker Pro. Any commands you send to a guest

database are relayed to the host. See chapter 7, "Networking and

access privileges."

9 Choose FileMaker Help Index from the i2} or Help menu, and then type:

Apple events

".'SJSBs^:i'il^!J^-'i: t

Defining a script to send Apple events

Before you send Apple events, consider the following:

Use the Send Apple Event step to send Apple events to other

applications. Each Send Apple Event step sends one event. You can

include more than one Send Apple Event in a script.

When specifying a field value or script text, FileMaker Pro sends text

as a parameter with the Apple event. See the documentation that came

with the target application to determine what information it expects

to receive with an event.

1

.

Choose ScriptMaker from the Script menu.

2. In the Define Scripts dialog box, create a script or select an existing

script, and then click Edit.

3. In the Script Definition dialog box, double-click Send Apple Event in

the Available Steps list, and then click Specify.
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4. In the Specify Apple Event dialog box, click Specify Application.

Specify Apple Euent

Send the
|
dc 5

(g) Document

Zl'

O field value ( i.pt.ofg Ft^Ii] |

Q Script text

• Options - - ~ -

|~| Bring target application to foreground

^ Wait for event completion before continuing

[~| Copy event result to the clipboard

<y

Choose an Apple

event

Choose options

for the event

5. In the Open File dialog box, select the target application, and then

click Open.

6. In the Specify Apple Event dialog box. choose the event you want to

send from the pop-up menu.

See "Choosing an Apple event to send" on page 5-27.

7. Select options for the event, and then click OK.

Select To

Bring target application to

foregrouncJ

Wait for event completion

before continuing

Display the target application when it performs the Apple

event. Deselect this option to run the target application in the

background or to perfonii scripts inore quickly.

Wait for the Apple event to finish before reluming control to

ScriptMaker.

Wait for event completion

before continuing and

Copy event result to the

clipboard. Deselect Bring

target application to

foreground.

Copy the result of an event performed in the target application.

Use this option when sending events to an application that can

send an Apple event reply, like the HyperCard application. In

the next step, you can add ScriptMaker steps to paste the data

into a FileMaker Pro field.

8. In the Script Definition dialog box, finish defining or editing the

script, and then click OK.



Using ScriptMaker and buttons 5-27

9. If you are changing an existing script and the Script Settings dialog

box appears, select options, and then click OK.

See step 6 on page 5-17.

lO.ClickDone.

O Choose FileMaker Help Index from the £3 or Help menu, and then type:

Apple events

Choosing an Apple event to send

When you add the Send Apple Event step to a script, you choose an

event in the Specify Apple event dialog box. The following table

explains the options.

To Do this

Open the target application Choose open application. In the Open File dialog box. confirm

the target application you selected in step 5 in "Defining a

script to send Apple events" on page 5-26. or select a different

application. Click Open. .

Open a file Choose open document.

To open the saine file each time FileMaker Pro sends the

event, click Document, and then click Specify File. In the

Open File dialog box, select a file, and then click Open.

To open a file using a pathname that's stored in a field in the

current record, click Field value, and then click Specify Field.

In the Specify Field dialog box, select a field on the current

layout, and then click OK.

To open a file by specifying a path to the file, click Script text

and type a path in the text box. (For example. HD:Database

folder:Database file. ) This option opens the same file each

time FileMaker F^o sends the event.

Perform a script in the target Choose do script. The target apphcation must suppon the do

application script event.

To specify the file that contains the script, click Document,

and then click Specify File. In the Open File dialog box, select

a file and then click Open.

To perform a script that's stored in a field in the current

record, click Field value, and then click Specify Field. In the

Specify Field dialog box. select a field on the current layout.

(The field can contain a complete script or a script name

depending on how the target application supports the do

script event.) Click OK.

To send a script with the event, click Script text and type

script commands or a script name in the text box. The script

must be written in the target application's scripting

language, not AppleScript. This option sends the same

script each time FileMaker Pro sends the event.
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To Do this

Perform other types of

Apple events

Chouse Other. In the Speeify Event dialog box. type the Event

Class and Event ID (four-character codes specified by the target

application). Click OK.

To send an Apple event to the same file each time you

perform the scnpt. click Document, and then click Specify

File. In the Open File dialog box, select a file, and then click

Open.

To send text that's stored in a field in Ihe current record,

click Field value, and then click Specify Field. (The event mu.st

accept a text parameter. I In the Specify Field dialog box,

select a field on the current layout. Click OK.

To send a text parameter with the event, click Script text and

type the parameter in the text box. (The event must accept a

text parameter. ) This option sends the same parameter each

time FileMaker Pro sends the event.

*? Choose FileMaker Help Index from the ^ or Help menu, and then type:

Apple events

Defining a script to perform AppleScript commands

Use the Perform AppleScript step to perform AppleScript commands.

The AppleScript extension, or the Apple Event Manager and QuickTime

extensions must be installed on your system. (See the Apple Computer,

Inc. Web site at http://www.apple.com for more information.)

1

.

Choose ScriptMaker from the Script menu.

2. In the Define Scripts dialog box, create a script, or select an existing

script and click Edit.

3. In the Script Definition dialog box, double-click Pertorm AppleScript

in the Available Steps list, and then click Specify.

4. In the Specify AppleScript dialog box, select options, and then click

OK.

To Do this

Perform AppleScript commands that

are stored in a field

Click Field value, in the Specify Field dialog

box, choose a field that contains AppleScript

commands, and then click OK. The commands
are compiled each time FileMaker Pro

performs the script.
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To Do this

Perform AppleScnpt commands Click Script text, and then type AppleScript

(up to 32K) commands in the text box. The commands are

compiled when you click OK. and then

FileMaker Pro stores the source.

5. In the Script Definition dialog box, finish defining or editing the

script, and then cHck OK.

6. If you are changing an existing script and the Script Settings dialog

box appears, select options, and then click OK.

See step 6 on page 5-17.

7. Click Done.

See "Changing monitor settings" on page 5-37 for an example script.

O Choose FileMaker Help Index from the (21 or Help menu, and then type:

AppleScript

Examples of ScriptMaker scripts

The following sections show scripts that you can use as starting points

for your work. Before reading the examples, you should understand how

to use ScriptMaker. For information about script steps or more

examples, see FileMaker Pro Help.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

script examples

script steps
' s,'*-*^ ^Sj^*""^ wy^-'^^^—s

Entering and printing data

This example illustrates a simple way to automate data entry. When you

perform the New Entry script, it creates a record, and then pauses so you

can enter data. When the script pauses, you can:

resume the script by clicking Continue or pressing Enter. The script

loops (repeats steps) to create a record.

print the current record by clicking the Print button on the layout.

FileMaker Pro performs the Print Record script, and then returns to

the paused New Entry script.

stop the script by clicking Cancel.
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Click to resume

the script

Click to stop

the script

: Clients

Data OTtrtj \

*-H+

Records

;

37

f Continue j

Cancel j

Client Entry

t Loop

t New Record/Request

* Go to Field ("Client First")

* Pause/Resume Script [)

t End Loop

Everywhere

Client First Client Last PhenefExtcnsion
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Example step 3: Define the Print Record script

In ScriptMaker, define the Print Record script with the steps shown in

the previous figure. Choose the following options to use the stored

settings when you perform the script.

For this step
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Example step 2: Create the new script

Choose ScriptMaker from the Script menu. In the Script Name box, type

Find Information. Chck Create.

Example step 3: Define the Find Information script

In the Script Definition box, you see that ScriptMaker has automatically

specified six script steps for you.

1

.

Delete the Enter Browse Mode, Go to Layout, Page Setup, Unsort,

and Print script steps. You can delete these script steps by clicking to

select them, then pressing Delete.

2. For Options, be sure Restore find requests is selected. Click OK.

3. Click Done.

i Script Definition for "Find Information"

Avsilablf Steps "Find Informsiiu

Control
Perform Script

Pause /Resume Script

Exit Script

Halt Script

If

Else

End If

Loop

Exit Loop If

End Loop

Allow User Abort

Set Error Capture

Navigation
Go to Lag out

Go to Record /Request /Page

Go to Related Record

Go to Portal Row
Go to Field

Go to Next Field

Go to Previous Field

Enter Browse Mode
Enter Find Mode

t Enter Brows*. Mode [1

t Go to Layout ["Layout "l

t Page Setup [Restore, No dia

* Pwform Find [R»storel

' 11

33
Options

^ Restore find requests

Duplicate

Delete

Select the Perform Find script step, then be sure

Restore find requests is selected

Displaying customized layouts

In this example, a travel agency has a database that stores information

about its clients. One agent likes to view the information in a simple

layout that shows only the agent's name, and the client's name and

telephone number. Another agent prefers a more complex layout that

displays the agent's name, and the client's name, address, phone

number, and travel preferences.
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The following sections explain how to define a startup script that uses

the current user name to display the correct layout and client records.

Note For this example, you should know how to specify a user name

(see "Setting general application preferences" on page 9-2) and a startup

script (see "Setting document preferences" on page 9-7.)

Example step 1 : Define the startup script

In ScriptMaker, define the Custom Layout script with the steps shown

below.

"Custom Layout
^

Displays a welcome layout for all users-

Depending on the agent's user name, the script

shows the appropriate layout

In Find mode, the script pastes the agent's user

name into the Name field, and then finds the agent's

records

<^o to Layout [Refresh, "Veloome layout

'

If ("StatusCCurrentUserName) = "Lynn"'

Go to Layout ["Simple layout "1

End If

If ["StatusCCurrentUjerNamf) = "Ann" "1

Go to Layout ["Complex layout ")

End If

Enter Find Mode [1

Paste Result [Select, "Name", "StatusCCurrentUserName)'

Perform Find []

Example step 2: Set the startup option

In Document Preferences, set the option to perform the Custom Layout

script each time the file is opened.

Document Preferences I

I

General ]
^Use smart quotes (", " *)

1^ Stor^ compatible graphics

Vhen opening 'Clients':

Q Try default password
j

Q Switch to layout |
Chent Entry -I

^Perform script | Custom Layout
|
—

Vhen closing 'Clients':

Q) Perform script: j :unt^iiov.h'^ ^|

([
none ]|

Choose the Custom
Layout script
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Finding duplicate records

In this example, a travel agency uses a registration database to track

clients who sign up for a cruise seminar. The database contains duplicate

records because some clients called the travel agency to sign up and also

mailed in a registration form for the same seminar.

The following sections explain how to set up a database and define a

script to find duplicate records.

Note For this example, you should understand global fields (see

"Defining global fields" on page 2-9) and know how to define fields (see

"Defining database fields" on page 2-3.)

Example step 1 : Create a unique value for each record

The Seminar file contains records of clients who register for a seminar.

Each client has a unique identification number, the Client ID field. Some

records contain the same identification number—these are the duplicate

records you want to find.

Tip If your database doesn't have a unique identification field, define a

calculation field to create one from existing fields. For example,

combine first name, last name, and birthday to create a unique

identification for each client.

Example step 2: Add two fields

Define these fields in the Seminar file:

A text field, called Mark. When the script finds a duplicate record, it

places an x in this field to mark the record.

A global field, called Global, to store the unique identification while

comparing records. Global should be the same data type as the Client

ID field.

Example step 3: Display the Mark field

Create a layout that displays the Mark field, or add the field to an

existing layout. You'll use this layout to store Find settings in the

following step.
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Example step 4: Store settings

Store Sort and Find settings for the script.

To store this setting Do this

Sort In Browse mode, choose Sort from the Mode menu. If fields

appear in the Sort Order list, click Clear All. Click ClientlD.

choose Ascending order, click Move, and then click Done.

Find Choose a layout that displays the Mark field. In Find mode,

type X into the Mark field, and then switch to Browse mode.

(You don't have to perfonii the find request.)

Example step 5: Define the script

In ScriptMaker, define the Find Duplicates script.

"Find Duplicates
"

* Find All

* Sort [Restore. No dialog]

« Go to Record/Request /Pag* [First]

* Replace [No dialog ,
" Mark " ,

""]
t Set Field ["Global", "ChentlD"]

* Loop

* Go to Record/Request /Page [Exit after last. Next]

* If ["Global = 01^^10"]

* Set Field ["Mark", "x"']
* Else

* SetField ["Global", "ClientlD"]

t End If

* End Loop

* Perforn-i Find [Restore]

When you perform the Find Duplicates script:

1 . It finds all records, and then sorts them by the ClientlD field so that

records with the same ClientlD are grouped together.
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2. Starting with the first record, the script copies the value from the

CUentlD field into the Global field.

Record 5

Record 4

Record 3

Record 2 Mark

lobal

aaa

Mark

lobal

aaa

T^^rSr^TSE^SjS

Mark

ilobal
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If the values don't match, FileMaker Pro copies the ClientlD value

into Global. It doesn't change the Mark field.

Record 1

Client ID Mark

Global
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For information about Apple events and AppleScript, see "Working

with Apple events" on page 5-23.

Define this script

"Sel Monitor Depth"

Specify this AppleScript command when you -

add the Perform AppleScript step

Specify HppleScrlpt
;

(3 Field value | $pecifii Field )

^ Script text

tell application "Finder" to set monitor deptti Cmin monitor

depth)

D (r°^



Chapter 6: Previewing and printing information

Preparing to print

This chapter describes how to print the information in your

FileMaker Pro files, including records, forms, and definitions of fields

and scripts.

Note The information in this chapter does not apply to users working

with databases on the Web. When users work with databases on the

Web, the Web browser software governs printing.

Important Before you read this chapter, be sure you know how to use

FileMaker Fro Help, as explained in the preface. "Getting help." You

should also understand layouts and parts. (See chapter 3, "Laying out

and arranging information.")

With FileMaker Pro, you can print:

records you're browsing (the found set) or a record you select in

Browse mode, including data from related files.

FileMaker Pro formats the records using the current layout. For

example, use a Labels layout to print mailing labels.

If a layout contains a header, footer, and body, FileMaker Pro prints

as many records on each page as can fit between the header and

footer. If a record at the end of the page doesn't fit, FileMaker Pro

prints it on the next page. (See "Paginating a layout" on page 3-32 and

"Changing part types and options" on page 3-36.)

blank records to create a form using the current layout.

definitions of fields or scripts to see the structure of your database.
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Blank record

Current record

Contact List

Company Name Name Contact Tllle Phone

Found set -

Contact List

Company Name Name Coniacl TWb Phone

|snmh~Miirreorp
|
Jeremy Smiih ] t-tcMilcni

Contact List

Company Name Name

7
Contact Tltlo

AtMb ALcesionei

PnnTCo
TbcFraniei>

Wul End Corp

Smith's More Corp

Dennis Smith Miirkebng A^-ioci

Soma Long Buyer

Jcfuurer Norm Sales Muugcr
lohn Winford Pcnonnel Adm.

Pamela Day Promotions Am
Jeremy Smith Prdideni

l7.S5S-9K7ft

3I-SSS-2M((

I7.S55-6840

l5-SSS-68;9

12-S55-2846

33-555-465S

Field definitions -

Script definition -

«JJE£_ Fomula/Entry Option

Company Name Tea
Canlacl Rrsl Tort

Contaci l^si Tea
Co^HfiUiBS iBJfl-

Scnpl Step/Oplio Scnpl Parameters

FileMaker Pro uses the current

layout to print records

"^^

Conlad List

Sort Order

Company Name (Ascending)

Contact Last (Ascending)

Conlacl Fifsl (Ascending)

The margins, current layout, and printer and page setup options affect

how FileMaker Pro prints records.
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1

Displaying margins

In Layout mode, choose Page Margins from the Show menu to see where

a layout will print on a page.

Most printers can't print to the edge of the paper. If you place objects in

the margins or outside the area the selected printer can print to, you see

them in Browse and Find modes. You don't see the objects when you

preview or print.

Layout showing margins

Layout not showing

margins

\LMfr '2
I

i Clients
I

O o
^K^

F^^^

£13

^Q^

Smcerely,

|A,£eniHame-
|

Everywhere Travel

Bl l.ai)i>ij<

Margins—objects
in this area won't

print

Page break

The selected printer

can't print objects

outside this line

Page break

^ Choose FileMaker Help Index from the ^ or Help menu, and then type:

page margins
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Setting margins

You can set different margins for each layout.

1

.

Choose Page Setup from the File menu, confirm the printer and paper

settings, and then click OK.

To switch printers, see "Specifying a printer" on page 6-14. For

infonnation about other settings, see the manual that came with your

printer.

2. In Layout mode, choose a layout, and then choose Layout Setup from

the Mode menu.

3. In the Layout Setup dialog box, select Fixed page margins, type values

for the margins, and then click OK.

Select to specify sizes

Select to alternate margins—the -

inside margin prints on the left

side for the first page, on the nght

for the second page, and so on

i
Layout Setup ;

Layout Name Letter no. 2

^ Include in layouts menu

Print Options

n Print in :^ columns

(•) Across first O Oouin first

] FiHed page margins:

Top 0.45 Inside 0.42

Bottom 0.45 Outside 0.42

] Facing Pages

Type margin

sizes

4. Switch to Preview mode to check the margins.

Keep these points in mind:

If you don't select Fixed Page Margins, FileMaker Pro uses the

printer's default margins.

In Layout mode, choose Set Rulers from the Mode menu to change the

unit of measure for margins. See "Positioning and sizing objects" on

page 3-40.
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If you select the Print in <value> columns option for a layout and

change the size of the columns, the columns resize to fit the new page

width when you change the left or right margins. See "Arranging

records in columns" on page 3-20.

^ Choose FileMaker Help Index from the Q or Help menu, and then type:

page margins

Removing spaces at the end of fields and parts

FileMaker Pro can move information vertically or horizontally to close

gaps at the end of fields and parts when you print. This movement is

called sliding. For example, you can create a letter layout so the comma
in the greeting prints right after the last name, even though some names

are longer than others.

When objects slide:

fields shrink to eliminate empty space within the field boundaries.

Sliding does not remove empty space between fields.

objects (including fields) slide left or up corresponding to the amount

of space the fields to the left or above the objects shrink.
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You can set parts to shrink when the fields in them sHde up. When parts

shrink, FileMaker Pro can print more records on a page.

Printing without sliding objects Printing witti sliding objects

lour Catalog

? mgWs

J795

OSpnng ^Sutnn^er 0'^<''<"'^" QIVinr«r 0'^"V^*''

GItcier rou'e between Yaicouver wid Anehonoe
Includes Columb-s Glacier, CoUefle FionJ, lte(ch*an,

Junew, Sl(*ewav. Sitki, wtdValde: OpiiongJ Iwvd lourto

Denali Pwl^

7r»eWs

J7«

OSpnng vSummer AAutumn OVImiei OAllv^w

Includes «ir (we fmni New VorV < nights m Helsinki,

2

nights iiiStoekholm. I dRvinCpperhagen

dnndBondeauv Oanbbeati

1 1 nights

QSpnng OSumtne' O*""** OWiwer ®AII«w

SwJuwi.Si T>ioin&s,Cur««),Cwt9gen«.and

'.ojutnel LiiiaJiv MtommodWions No lipping policy

Slide objects left to -

remove space at the

right edge of fields

Slide parts up to get
-

different sized

bodies tor different

amounts of data

Slide objects up to -

keep extra space

from printing

Tour Catalog

;n>
7n*glns

17«
QSprliifl ^Sutnmei QAunjinn O^tntei Oi^V*

flluic route between Vwcoutti vK) J^chorag*

Includes ColumbiaGlwier, ColleBe Fjord, Keictiikm,

JuneuJ, SI'*gw«v.Sitl'>. cndVeJiltl Option*] l*nd tou

DenaiiPwV

,Ma> flovtl C ivitier Sctndmevie

OSpnng ^S tunmer 4> > utumii OWmief OAn\^

>f1[ 4n>glUsinHtlsinl'i,^

Cop«riht|)en

Eii'iiai 'jrend BordeeV' Cmbbi

•MiricE ttS;4tot3e94

^not OSpnnj OSuirwiei Q
Hot! SenJuan.Sl ITMxnu.tur

I

Cocumel Lunuryi

•inXcD E;9lDi«r South Piciric

witmit 21 nights

iiicmct 11,945 to »,;so

kM« OSpnng QS^uw O*"'"'™' 0'*nl« ®A1\«

una Includes New Zetland, Juslnlis TwtgB, and Fiii

Slide objects and

parts up to fit more

records on a page

In Layout mode, choose Sliding Objects from the Show menu to see which

objects slide and in which directions. The following layout illustrates

how fields are set to slide for the previous figure.

H»jd«r I

ShtpfDestinalion

Tour length

Wholesale price

Season

Notes

I
Bod^i

Tour Catalog
1

, . 1 .
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Keep these points in mind:

You can slide any object. Non-field objects, like the horizontal line in

the previous example, can slide if you place a sliding field above or

to the left of the objects. When a non-field object slides, it moves to

another place on the layout but doesn't shrink. When a field slides, it

moves to another place on the layout and shrinks if the data doesn't

fill the field boundaries.

When you slide objects or parts, FileMaker Pro prints the objects

relative to each other, not precisely as you placed them on your

layout.

If you leave blank space on a layout, FileMaker Pro keeps that space.

For example, if you create a body with one inch of space below the

lowest object, FileMaker Pro leaves one inch below the lowest object

when it shrinks the body.

You can also use merge fields to align text in form letters, envelopes,

or labels. (See "Adding merge fields" on page 3-58.) Use sliding

instead of merge fields to:

align non-text objects, like graphics

move the enclosing part up

align formatted fields, like value lists and repeating fields

enter data into the layout. If you use merge fields, you must use a

different layout for data entry.

Don't slide parts up on layouts that require a fixed vertical spacing,

like labels.

Headers, footers, title headers, and title footers never slide up.

For information about sliding related fields and portals, see

"Changing the appearance of related fields and portals" on page

10-28.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

sliding objects

Sliding objects and parts

1 . To slide objects left, align their top edges and align data in text fields

to the left.

See "Aligning objects to each other" on page 3-48 and "Formatting

text paragraphs" on page 3-84.
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2. In Layout mode, select the objects to slide, and then choose

Sliding/Printing from the Format menu.

To slide an object left, you must also select the field to the left of it.

To slide an object up, also select the field above it.

3. In the Set Sliding/Printing dialog box, select the sliding options you

want, and then click OK.

Select this option To

Sliding left Close up blank space to the right of the object, allowing objects

to slide left into the unused space. This option keeps punctuation

with data, moves the contents of fields closer to each other, and

Sliding up based on Close up blank space above an object.

Select All above to close up blank space above an object based

on the position of all objects above it. This option maintains

consistent vertical spacing among columns.

Select Only directly above to close up blank space above an

object based on the position of the objects directly above it.

This option allows the spacing in a column to adjust

independently of the other columns.

Select Also reduce the size of the enclosing part to close up the

space in the part that contains the fields. To slide the part up

relative to all objects, set this option for all the objects that are

sliding up. To slide the part up relative to a single object, set

this option for that object only.

! Set Sliding/Printing ;

vhen printing, remove blank space from within the selected objects bg

^ Sliding left : ^ Sliding up based on

(•) All above O Only directly above

m-

j I
Do no' pnnf the selected objects

Also reduce the size of the enclosing pari

4. Switch to Preview mode to see objects and parts slide.

See "Previewing before printing" on page 6-11.

'P Choose FileMaker Help Index from the £S or Help menu, and then type:

sliding objects
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Sliding repeating fields

If you set sliding options for repeating fields, be sure not to change the

way the information is aligned.

No. of people Dale of (ravel Per person

Nq-oI people
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You see nonprinting objects in Browse and Layout modes, but not

when you preview or print. Choose IMon-Phnting Objects from the

Show menu to display nonprinting objects with a gray border in

Layout mode.

'P Choose FileMaker Help Index from the 02 or Help menu, and then type:

printing, data

Printing Extended columnar layouts

For Extended columnar layouts, select the horizontal (landscape) page

setup option so that more columns print on a page. See "Printing" on

page 6-12.

Information to the

right of this line

won't print



Previewing and printing infornnation 6-11

Printing layouts with subsummaries

Before printing a layout with subsummary parts, sort the records by the

break field (the field that groups the records). See "Adding a summary

part" on page 3-31 and "Sorting records" on page 4-30.

Keep these points in mind:

Switch to Preview mode after you sort to see how your records will

print. See "Previewing before printing" below.

You can start a new page for each subsummary part. If you print

records in columns down the page. FileMaker Pro starts a new

column, not a new page. See "Arranging records in columns" on page

3-20.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

subsummary layout parts

Printing labels and envelopes

To print labels, set up a Labels layout (see "Setting up to print on labels"

on page 3-12). For information about printing envelopes, see "Setting up

to print on envelopes" on page 3-18.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

labels layout

printing, envelopes
^BSmacJsissn'Sm^s.^^sKssssa^ses^^^it^sxasst^

Previewing before printing

In Preview mode, you see how records will look when they're printed,

but you can't change records or layouts. To switch to Preview mode,

choose Preview from the Mode menu.
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Note You cannot use the preview feature to see how your database looks

when pubhshed on the Web. You must use Web browser software.

Choose a different layout

Click a page of the

book to see the next or

previous page

Move to view a different page Margin

Current page number

Number of pages to

preview/

Click zoom controls to

see objects in detail, or

to get an overview

loolJiiiB

First Name

Kim

Jack

Tracey

Julie

Patricia

Allison

Jamie

Last Name

Chen

Osborne

Kuehn

Blank

Lichtenstein

Kuehn

Blank

Title

Agent

Printer

Sales Manager

Sales Manager

Office Manager

Agent

Agent

-T"L
jm

Click to hide or show the status area

Eitension Depi

5842 Sale

6233

6222

6333

6444

6345

6957

Print

Sale

Sale

Adm

Sale

Sale

Sm

O Choose FileMaker Help Index from the CS or Help menu, and then type:

preview mode

Printing

You can print all or part of a database. See "Preparing to print" on page

6-1.

1. If you're printing records, switch to the layout you want to use.

2. If you have more than one printer, specify which one you want to use.

See the next section. "Specifying a printer."

3. Choose Page Setup from the File menu, confirm the options, and then

click OK.

For information about Page Setup options, see the manual that came

with your computer or printer.
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If you're printing records, browse the ones you want to print, and then

switch to Preview mode to chect: them.

Use Find, Omit, Find All, and Sort, if needed. If your layout has a

subsummary, sort on the break field. (See "Printing layouts with

subsummaries" on page 6-11.)

Choose Print from the File menu, and then select options in the Print

dialog box.

In the Print area, select To print

Records being browsed All records in the found set.

Current record The record currently selected in Browse mode.

Blank record, showing fields, and

then choose an option from the

pop-up menu

A blank record using the current layout. Use this option

to create a form that represents your database. Choose

as formatted to print the fields as specified in the Field

Borders dialog box. (See "Adding borders, fill, and

baselines to fields" on page 3-73.)

Script, and then choose a script

from the pop-up menu
Script definitions. Choose All scripts to print every

script definition in the file.

Field definitions A list of all the fields denned for the file, including

formulas and entry options.

Choose the data

to print

Printer: "Laser"

Copies: 1
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Specifying a printer

1

.

Choose Chooser from the Apple menu.

2. In the Chooser dialog box, select a printer, respond to any messages,

and then click the close box.

For infomiation about printer options, see the manual that came with

your printer.

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

print options
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Sharing files

You can share FileMaker Pro files with other users on a network. By

sharing files, you can work simultaneously with others in your work

group, and save disk space by keeping files in a central location.

You can also share your FileMaker Pro files on the Web using

FileMaker Pro Web Coinpanion. For more information, see chapter 1 1,

"Publishing files on the Web."

To be sure that the right people see the right information in your files,

you can set FileMaker Pro access privileges. This chapter explains how

to protect files using passwords and groups. You can use these same

passwords to protect files shared over the Web. For even more complete

protection, you can use FileMaker Pro Web Companion Web Security

databases. For more information, see "Database security" on page

11-18.

Important Before you read this chapter, be sure you know how to use

FileMaker Pro Help, as explained in the preface, "Getting help."

To share your FileMaker Pro files with other users, you need:

a computer running the Mac OS

a connection to a network

FileMaker Pro installed on your computer with the correct network

options selected

See the FileMaker Pro Installation and New Features Guide for

more infomiation.

Important Your FileMaker Pro licensing agreement requires that you

own the same number of copies of the FileMaker Pro application as the

number of people using FileMaker Pro at the same time.



7-2 FileMaker Pro User's Guide

The first person to open a shared file is the host. Any user who opens a

shared file after the host is a guest.
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Opening files as the host

To host a file, you must be the first user to open it.

1

.

Choose Open from the File menu.

2. In the Open File dialog box, select a file, and then click Open.

3. Choose Sharing from the File menu.

In the File Sharing dialog box, select Multi-User.

Note If Multi-User is dimmed in the File Sharing dialog box,

FileMaker Pro is unable to access the network. An explanation

appears below the Multi-User button. You can also get an explanation

by choosing Open from the File menu, then clicking Hosts.

To open the File Sharing dialog box, you must open the file using a

password that provides the Export records access privilege.

4. If the file uses information from other FileMaker Fro files (like

related databases, external scripts, or value lists), repeat steps 1

through 3 to open the files and set them to Multi-User.

Tip Group the files in a single folder to make it easy to locate them.

Adding an underscore character _ to the end of a database filename

(before the .FP3 extension, if any) prevents that database from being

listed in the Hosts dialog box. It also prevents the database from being

listed on the default home page if you are using FileMaker Pro Web
Companion Instant Web Publishing.

You can broadcast messages to guests who are using your database. In

the File Sharing dialog box, click Send Message. Type the message, then

click OK. Your guest(s) see the message in a dialog box. They can

dismiss the dialog box by clicking Cancel—or the dialog box dismisses

itself 30 seconds after appearing.

Keep the file open to make it available to guests. For the best

performance:

When you host a file, open it first on the computer that is directly

connected to the hard disk on which the file is stored, rather than on

another computer using Mac OS personal file sharing.

If you use a file sharing system (like AppleShare or the Mac OS
personal file sharing), host the file from your hard disk instead of

hosting it from a file server.
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Warning Anyone who opens a database file with the Export records

access privilege, including FileMaker Pro guests, can then publish the

database on the Web by enabling FileMaker Pro Web Companion. In

this case, your database is protected over the Web by any FileMaker Pro

access privileges that you have set. However, you should exercise

caution when granting access privileges. For more information, see

chapter 1 1, "Publishing files on the Web."

^ Choose FileMaker Help Index from the {^ or Help menu, and then type:

hosting files

^:.s:sMvjai»»,iiiiXi3B6^lS5^iSSRivn^i/!l!WVi**K'it.

Opening files as a guest

After the host opens a shared file, guests can connect to the file.

1. Choose Open from the File menu.

2. In the Open File dialog box, click Hosts.

3. In the Hosts dialog box, do the following.

For this protocol
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4. Select a file, and then click Open.

If the network is very busy, the file might not be listed. Use one of the

following procedures to check the network for a longer period of

time.

For this type of network Do this

AppleTalk with zones Hold down the Option key as you chck an item in Ihe

TCP/IP
lower Hst.

AppleTalk without zones Click Cancel to return to the Open File dialog box. Hold

MarlPX down the Option key as you click the HoStS button.

If you select a FileMaker Pro Server host (instead of a shared file),

you see the remote administer dialog box. See the FileMaker Pro

Server documentation for infomiation.

Keep these points in mind:

Close your connection to a shared fileif the host asks, or if you aren't

using the file.

If some menu commands, layouts, or fields are dimmed, you may
have limited access to the file. See "Protecting your files" on page

7-9.

For information on sharing your file over the Web, see chapter 1 1,

"Publishing files on the Web."

Choose FileMaker Help Index from the CS or Help menu, and then type:

sharing files
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Working with shared files

When a shared file is open, the host and guests have access to the same

infonnation. FileMaker Pro saves a shared file on the disk where the file

resides. It saves changes that the host and guests made to the file,

including changes to records, layouts, and scripts.

FileMaker Pro limits access to some commands and records to keep

users from interfering with each other.

This user Can perform these tasks

Host and all guests

(every user)

Host or one guest

(only one user at

a time)

Host only (all guests

must close their

connections to

the file)

Find. sort, or browse records

Specify a page setup and print

Switch layouts or modes

Import or export data

Check the spelling of a found set

Perform a script hy choosing it from the Script menu or clicking

a button defined for the script

Change global values. Only the host's changes are saved with the

file. When guests open a file with global fields, they see the

current values. If the host changes a global value, guests don't see

the change until they close the file and then reopen it.

Open the ScriptMaker dialog box

Define or change relationships

Define or change passwords

Define or change value lists

Edit a record or layout. Others can view the record, but no one can

modify it until the current user moves to another record or presses

Enter in Browse mode. In Layout mode, the current user must

move to another layout or switch to another mode.

Define fields or change field definitions

Reorder layouts

Define, delete, or change groups and access privileges

Save copies of a file with the Save a Copy As command

Switch the file status between multi-user and single user

Close a shared file

While you are working with a shared file, you might see the

pointer change.

This pointer Means FileMaker Pro is

Waitmg to receive data from the network

Cp Waiting for the host to finish processing a request from another user
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Keep these points in mind:

Sorting, replacing data, viewing and printing summary report layouts,

and other calculation-intensive tasks performed on many records

affect the performance of the host and guest computers. Perform

these tasks on a small found set, or schedule tasks so they're

performed during low usage periods.

FileMaker Pro saves the host's sort order, find requests, and page

setup. If you're a guest, you can save your settings by defining a

script. See "Storing settings for a script" on page 5-15.

With FileMaker Pro for Windows, you can combine information

from other applications using Object Linking and Embedding (OLE).

When you share FileMaker Pro for Windows files, users of

computers running the Mac OS can cut, copy, and paste OLE objects

as graphics, but can't edit them. The following table explains how
OLE works with cross-platform networking in FileMaker Pro.

With this configuration You can do this

A computer running Windows is the On a computer running the Mac OS, you can

host and a computer running the view embedded and hnked objects as graphics.

Mac OS is the guest.

A Mac OS-based computer is the On a computer running Windows, you can

host and a computer running embed, link, and edit objects. On a Mac OS-
Windows is the guest. based computer, you view the objects

as graphics.

Mac OS-based computers are host When you use FileMaker Pro to open a database

and guest. that has OLE objects, you view the objects

as graphics.

Computers running Windows are Host and guests can embed, link, and edit objects,

host and guest.

When you share a file with system formats that are different from the

settings on your computer, you can choose which formats to use. See

appendix B, "Working with international files."

O Choose FileMaker Help Index from the G3 or Help menu, and then type:

sharing files
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Closing shared files

If you're a host, you can close the files you're hosting. If you're a guest,

you can close your connections to shared tiles.

Important Leave FileMaker Pro by choosing Quit from the File menu. If

you turn off your computer without quitting the program, you can

damage open files and lose your changes.

1 . Choose Close or Quit from the File menu.

To
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Passwords and groups are related. You can define a password for each

employee in your company, and then associate passwords with groups

to limit access to each department's data. For example, in a tile

containing employee information, only passwords in the Human
Resources group can see salary information.

When you open a file with a password, FileMaker Pro knows:

activities you're authorized to do with the file

groups associated with your password

layouts and fields you can see

Important FileMaker Pro passwords work independently of operating

system access privileges. Shared FileMaker Pro files are available on

your network even if you haven't shared them with your operating

system's file sharing features. To restrict access to shared FileMaker Pro

files, use FileMaker Pro passwords.

Note When you assign passwords to a database, those same passwords

are required when opening the database over the Web, unless Web
Security database passwords are in effect. For more Web-related

password and access privilege options, see "Database security" on page

11-18.

The following example shows two layouts for an Employees database.

The Salary List layout displays data that is confidential (like salary) and

data that everyone can see (like phone number). The Network List

layout displays network addresses that only network administrators can

access. The file has two groups. Human Resources and Network

Administration.

Passwords in this group Can do this

Human Resources See and change any field on the Salary List layout. They

can't see the Network List layout.

Network Administration See (but not change) the names and phone numbers on the

Salary List layout. They can't see the salaries. They can see

and change any field in the Network List layout.
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You can define a blank password that gives all users limited access to

a file. When users open the file, they can press Return at the password

prompt to access the file.

When you open a file, FileMaker Pro can try a password without

prompting you. Define the password, and then see "Setting document

preferences" on page 9-7 to set the option.

If you create a script that opens a second file when your primary file

opens, and both files have the same password, FileMaker Pro enters

the password for the second file and opens it automatically—it does

not prompt you for the second file's password. If you don't want this,

specify a different password for the second file.

You can protect all FileMaker Pro files, not just shared files on a

network. For example, you can define a password so other users can't

open a file on your computer.

To define passwords:

1. Open the file.

2. Choose Access Privileges from the File menu, and then choose Define

Passwords.

3. In the Define Passwords dialog box, specify the password.

To Do this

Define a password Type up to 31 characters in the Password box. Passwords

aren't case sensitive. If you type spaces, users must type them

to open the file.

Define a blank password Leave the Password bo,\ blank, and then select a limited set of

privileges in the next step.
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Blank password -

Passwords defined -

in the file

(no passuiord)

ship

train

jet

ferry

Password:

(Leaue blanic for no passiuordl

Access the entire file

^Browse records

Q Print records

Q Export records

^ Override data entry

^Design layouts

H Edit scripts

^ Define value lists

^Create records

^ Edit records

[^Delete records

earnings

Available menu commands Normal

Create Recess..

[
Change ) ( Groups...

[ Delete )
[[

Done

Deselect to limit access

Select the access privileges

for users of this password

Select the menu
commands for users of this

password

Click to associate

passwords with existing

groups

Click to define

groups

4. Select the activities that users with this password can perform.

Select To let users with this password

Access the entire file

Browse records

Print records

Pertbrm any task with records, layouts, and scripts. This

privilege creates a master password. It's the only privilege that

can define or delete passwords, or change field definitions,

document preferences, groups, or other users' passwords.

See data in records. (Define groups to limit the fields and

layouts that users can see.)

Print one or more records

Export records Export one or more records, or copy the found set. This

privilege also provides access to the File Sharing dialog box,

allowing users to enable FileMaker Network Sharing and

Companion Sharing (for example, Web Companion shanng).

Override data entry

warnings
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5. Choose the menu commands that users with this password can access,

and then cHck Create.

Select To

Normal Enable all menu commands associated with the pnvileges you selected

in the previous step

Editing Only Enable only basic data entry commands for the current file. (Available

menu commands depend on the level of access you selected in the

previous step.)

None Disable all commands that work on the current file

Note All options let users switch between database windows,

perform scripts on the Script menu, click buttons on layouts, open

FileMaker Pro Help, change preference options (except Document

Preferences), and open, create, or close FileMaker Pro files.

6. Repeat steps 3 through 5 for additional passwords.

7. Detlne groups or close the Define Passwords dialog box.

To Do this

Create groups Click GrOUpS in the Define Passwords dialog box. At the

prompt, type a master password, and then click OK to see the

Define Groups dialog box. See step 3 in "Defining groups" on

page 7-17.

Associate passwords

with existing groups

Click Access in the Define Passwords dialog box to see the

Access Privileges dialog box. See step 4 in "Defining groups"

on page 7-18.

Close the Define Click Done. At the prompt, type a master password, and then

Passwords dialog box click OK.

Important After you define a master password, write it down and store it

in a secure place. If you forget it, you can't regain full access to the file.

O Choose FileMaker Help Index from the O or Help menu, and then type:

defining passwords
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Deleting or changing passwords

To Do this

Delete a password Choose Access Privileges from the File menu, and then choose

Define Passwords. Select the password m the Define Passwords

dialog box. and then click Delete. In the confirmation dialog box,

click Delete, and then click Done. When prompted, type the master

password, and then click OK.

Change a password if Choose Access Privileges from the File menu, and then choose

you know a master Define Passwords. Select the password in the Define Passwords

password dialog box. Edit the password, revise the privileges, and then

click Change, Click Done. When prompted, type the master

password, and then click OK.

Change your own Choose Change Password from the File menu. In the Change
password if you don't Password dialog box, type the old password. Type the new
know a master password password, type it again to confirm it, and then click OK.

Keep these points in mind:

Notify users if you change their passwords.

If you change passwords while a file is s"hared, the changes don't take

effect until guests close and reopen the file.

*? Choose FileMaker Help Index from the SB or Help menu , and then type:

(deleting passwords

passwords, ctianging
'-S'>i^^s^s>jfs^jBxissxtxssafzxM-.r'^ti;>i'^^

Defining groups

After you define passwords, define groups to restrict access to specific

fields and layouts. You can:

associate a group with more than one password. For example, you can

assign separate passwords for each person in an accounting group.

All users have access to the same layouts and fields (determined by

the group), but only the managers can make changes to the file

(detennined by their passwords).

associate the same password to more than one group. For example, to

give an accountant access to the layouts and fields for the Sales and

Inventory groups, associate the accountant's password with both

groups.
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Master passwords

appear in bold text

The following illustration shows the access privileges for a file created

by a Marketing department. The file has three groups: Marketing,

Accounting, and Sales. When you select the Sales group, you see that the

Advertising Costs layout is not available to Sales.

Sales can see and change these layouts

Sales can see

but can't

change these

fields

Password associated with the Sales group

Sales can't see these layouts

Tip To see the associations between layouts and fields, choose Access

Privileges from the File menu, and then choose Overview. You must be the

host and set the file to Single-User, or have all guests close the file. (See

"Opening files as the host" on page 7-3.)

For example, if you want to delete a field but aren't sure which layouts

will be affected, select the field in the Access Privileges dialog box.

Layouts with solid bullets contain the selected field.

Before you define groups, consider these points:

Groups give database administrators a way to manage user access to

layouts or fields. Users don't need to know about groups. If you don't

need to restrict access to layouts or fields, don't define groups.
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Define passwords before defining groups. (See "Defining

passwords" on page 7-11.) Master passwords can access the entire

file and aren't associated with specific groups.

You can limit what users can do with specific fields or layouts

without changing the access privileges of their passwords. For

example, if passwords associated with a group have Edit record

privileges, you can prevent users from editing specific fields or

layouts by setting the group access privileges to Not accessible.

To define groups:

1

.

Open the file.

You must use the master password. If the file is shared, you must be

the host. (See "Opening files as the hosf" on page 7-3.)

2. Choose Access Privileges from the File menu, and then choose

Define Groups.

If the file is shared and guests are connected, ask them to close the

file. (See step 2 in "Closing shared files" on page 7-8.)

3. In the Define Groups dialog box, type the group name, click Create,

and then click Access.

Groups definedin the file

-

Type a new group name

Define Groups for File "Products"

Marketing

Recounting

Sales

Group Name:

Access..

Passwords.

Create

Click to associate

passwords with a group

Click to define or change

passwords
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4. In the Access Privileges dialog box, select a group.

Selected group -

Key.

Groups

Accounting

Sales

Master password

Access Priuile |es for File "Products"
;

• Tram -
• Bo^t

" AirpUne

• Car

layouts Fields

Current Inventori

Margin Report

Advertising Cost,

o

• Item number
• Item name
• Description

• Vendor

o Status

• Price

• Cost

« No in stock

o

I

• Accessible » Not accessible o Read only . . . . iff^^^*^^
1 i The« hnts .r» tetkM un.,1 a r-up 's sfi«t»<i 1

Bcerl
) [

Done
] [[

sauc

5. Associate passwords for the group by clicking bullets next to

the passwords.

Click the bullets, not the names of the passwords. A solid bullet

indicates that the group can use the password.

6. Set the access privileges for layouts and fields by clicking the bullets

next to them.

Click the bullets, not the layout or field names.

7. Click Save to save the current settings, or click Revert to return the

settings to the way they were last saved.

8. Click Done, and then click Done again.

Choose FileMaker Help Index from the ^ or Help menu, and then type:

groups
I
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Deleting or changing groups

To delete or change groups, you must have the master password, be the

host, and set the file to Single-User (or have all guests close the file). See

"Opening files as the host" on page 7-3 and "Closing shared files" on

page 7-8.

To Do this

Delete a group Choose Access Privileges from the File menu, and then choose

Define Groups. In the Define Groups dialog hox, select the group

name and then click Delete. In the confirmation dialog hox, click

Delete and then click Done.

Change password Choose Access Privileges from the File menu, and then choose
associations or access Overview. In the Access Pnvileges dialog hox, select a group. Click

privileges for a group the bullets next to the passwords, layouts, and fields you want to

change. Click Save, and then click Done.

*} Choose FileMaker Help Index from the 02 or Help menu, and then type:

groups

w-K;-;,-.--.-:^i;5sj3SrKS^5SSJSSsspas is;is»r-.^3srr-r^i-,srE335S3e^a





Chapter 8: Importing and exporting data

You can exchange information with FileMaicer Pro files or with files

created in other applications. This chapter describes the import and

export features of FileMaicer Pro.

Note You cannot import or export data from your database using a

Web browser.

Important Before you read this chapter, be sure you know how to use

FileMaker Pro Help, as explained in the preface, "Getting help."

Understanding import and export

With FileMaker Pro, you can:

import— bring data from another file into a FileMaker Pro file

export— save FileMaker Pro data in a format you can open in

another application

For example, suppose you have a FileMaker Pro database that contains

temperature and rainfall data for many travel destinations. To create a

chart for a travel .seminar, you export the temperature data from

FileMaker Pro, and then open the exported file using a charting or

similar software application which supports the importing of data, such

as Clarislmpact software or Microsoft Excel. Exporting the data is faster

and more accurate than retyping it in another application.

File containing exported

FileMal(er Pro data

FileMaker Pro data you want to chart

Data displayed in Clarislmpact
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Keep these points in mind:

To exchange small amounts of data between files (for example, a few

records), use Copy and Paste, or drag and drop. See "Copying and

moving values and records" on page 4-12 and "Using drag and drop

to move information" on page 4-13.

To quickly exchange larger amounts of data, import or export records.

You can define FileMaker Pro scripts to exchange information with

other files. See chapter 5, "Using ScriptMaker and buttons."

You can import data into (or export from) shared FileMaker Pro files.

See chapter 7, "Networking and access privileges."

When you exchange information between FileMaker Pro files on a

Mac OS-based computer and a Windows-based computer, you may
see differences in filenames and character set mapping.

You can't import or export layouts from one FileMaker Pro file to

another, but you can:

copy and paste objects from one layout to another

copy layouts and field definitions (but no data) to a new

FileMaker Pro file by saving a clone of the file. See "Saving a

copy of a file" on page 1-11.

copy fields to a layout in another file if the field names are

identical in both files. See chapter 3, "Laying out and arranging

information."

For information about importing or exporting data in related files, see

"Working with related records" on page 10-31.

O Choose FileMaker Help Index from the g9 or Help menu, and then type:

• exporting, data

importing data
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Understanding file formats

Every application uses & fileformat, the organization of information

within a file. The following table describes the file formats that

FileMaker Pro supports. For more information about the formats, see

FileMaker Pro Help.

Format

FileMaker Pro

Merge

HTML Table

Edition File

ClarisWorks 2.0/3.0/4.0

DBF

Excel

Use to

Import data from a FileMaker Pro 2.0, 2.1, 3.0 or 4.0 file,

or export to another FileMaker Pro 3.0 or 4.0 file. (If you

import a FileMaker Pro 2.0 or 2. 1 file, the file is first

converted to FileMaker Pro 4.0 format, then the data is

imported. See the FileMaker Pro Inslalkuion and New
Features Guide for more information.)

Tab-Separated Text
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Most file formats don't support importing or exporting text attributes

(font, size, or style). In these cases. FileMaker Pro imports or exports

the text but not the attributes.

Some formats don't support repeating fields. See "Exporting

repeating field data" on page 8-14.

'P Choose FileMaker Help Index from the i2i or Help menu, and then type:

file formats
;,-.^ 'T^^iSJiss'iSSsatijj&i^i'/i-t'Ss

Importing data into FileMaker Pro

You can import data into a new or existing FileMaker Pro file.

To Do this

Import data into an existing See the following section.

FileMaker Pro file

Import data from another application See "Importing data into a new tile" on page 8-9.

into a new FileMaker Pro file

Keep these points in mind:

The file you're importing from must be in one of the formats listed in

"Understanding file foiTnats" on page 8-3.

FileMaker Pro imports data in the order it appears in the file you're

importing from.

You can import data from any field type into any compatible field

except container, calculation, summary, and global fields. You can

import container fields if you're importing from another

FileMaker Pro file.

To insert graphics, sounds, or QuickTime movies into your file, see

"Working with container fields'" on page 4-6.

Importing data into an existing file

You can import data into an existing FileMaker Pro file from another

FileMaker Pro file, or from another application. You choose whether

FileMaker Pro adds or replaces records in the file you're importing into:

The Add new records option copies all records to the end of the file

you're importing into.
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The Replace data in current found set option replaces records in the file

you're importing into. The following figure illustrates this option.

Source file Destination file

When replacing data. -

FileMaker Pro doesn't import

these records because the

source file has more records

than the destination file

1 Paris

2 New York

3 Sydney

4 Buenos Aires

5 Tokyo

-* 1 Pars

-* 2. h\e^ York

-*- 3. Sydney

To import data into an existing file:

1

.

If you're replacing records, make a backup

copy of the file you're importing into.

2. If you're importing records from a FileMaker Pro file, open the file,

and then browse the records you want to import.

FileMaker Pro imports the records in the found set in the order

they're sorted. Use Find, Omit, Omit IVIultiple, or Sort, if needed.

3. Open the FileMaker Pro file you want to import records into.

If you're replacing records in the file, use Find. Omit, or Omit Multiple

to browse the records you want to replace. Sort the records in the

same order as records in the file you want to import.

4. In Browse mode, choose Import/Export from the File menu, and then

choose Import Records.

5. In the dialog box, select the name of the file to import, and then click

Open.

For Show, choose a file type to narrow the choices, or choose All

Available to see all the files you can import.

6. In the Import Field Mapping dialog box, match the fields you want

to import.
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Important Check each arrow and field name to be sure the correct data

moves into the correct fields.

To Do this

Change the order of Choose an option from the View By pop-up menu. (Options

fields in the Fields in hst change the order by which you view fields in the dialog box,

not the order of the fields in the file. ) To list the fields by:

names that match, choose Matching Names

the order used the last time FileMaker Pro imported data into

this file, choose Last Order

the order the fields were created, choose Creation Order

name in alphabetical order, choose Field Names

the types of fields, choose Field Types

a custom order (created by dragging field names), choose

Import Order

Change the order of Move the pointer over a field name in the Fields in list. When the

one field in the file pointer changes to a double arrow, drag the name to a new

you're importing into location. This changes the order you view fields in the dialog

box, not the order of the fields in the file.

Prevent data from

being imported

Click the arrow between the field names. The arrow changes to

a dotted line.

View the data in the file

you're importing from

Click the Scan Data arrows to see the data in each record.

Create a field in the file

you're importing into

Click Define Fields, in the Define Fields dialog box, create the

field, and then click Done. (See "Defining database fields" on

page 2-3.) If you're importing into a shared file, only the host

can create fields.

Change or delete a field Click Define Fields. In the Define Fields dialog box, make your

in the file you're changes, and then click Done. (See "Changing field definitions"

importing into on page 2-25.) If you're importing into a shared file, only the

host can change or delete fields.
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Arrows show how
FileMaker Pro imports data

from one file into the other

Fields in the source file

Import Field Happing :

Data in "New Tours"

CRUISE SHIP
CRUISE DESTINATION

CRUISE WHOLESALE PRICE

SEASON
NOTES

TOUR LENGTH
MONTH

LOV TEMP
HIGH TEMP
RAINFALL

DESTINATION

View By
|
Import Order

Fields in "Package Info
'

^
Cruis* Ship
Cruise Destination
Cruise vliolesale price
Season
Notes
Tour length
Month
Lov Temp
ttigh Temp
Rainfall

Destination

2] Scan Data [] Field

(•) Add new records

Q Replace daia tn cur-rent f.^und se*

Fields in the

destination file

Dotted lines

show data that

won't be

imported

7. Select an option to add or replace records, and then click Import.

To Do this

Add new records to the end of the Select Add new records,

file you're importing into

Replace existing data in the file Select Replace data in current found set. FileMaker Pro

you're importing into replaces field values in the to'jndsetofthe t~ile you're

importing into.

8. If you see the Import Options dialog box, select options, and then

click OK.

FileMaker Pro displays this dialog box if your file has lookups or

fields that automatically enter data, or if you're importing data from

a FileMaker Pro file with repeating fields and select the Add new

records option.

To Do this

Enter default data into

fields that are defined with

Auto Enter options or as

lookups

Select Perform auto-enter options while importing.

After importing data, FileMaker Pro enters default data

into fields with Auto Enter options. Some Auto Enter

options (like modification date, time, and name, and

lookups) overwrite the imported data. (See "Choosing data

entry options" on page 2-6 and "Defining a lookup" on

page 10-U.)
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To

Import data into

repeating fields

Do this

Select Keeping them in the original record to import the

records as repeating fields.

Select Splitting them into separate records to place each

repeating value in a separate record. For example,

choose this option to split line items on an invoice—if

you have five repealing values, you get five separate

records. Each separate record is identical except for the

repealing field values. You can then sort the newly

separated items, or total them using a summary field.

Import Options :

^ Perform auto-enter options while importing

Imodification date, serial number, lookups, etc.

I

Import ualues In repeating fields bg:

(i) Keeping them in the original record

O Splitting them into separate records

Cancel ^^

Keep these points in mind:

The records you import become the found set. After importing, check

the data in the found set.

If you select the Replace data in current found set option, be sure your

records are correct before discarding the backup copy of the file.

FileMaker Pro doesn't validate imported data.

To stop importing, press Command-period. To delete the records

already imported, choose Delete All from the Mode menu.

Important If you delete the found set after using the Replace data In

current found set option, you delete your original found set (which

might be all your data).

'P Choose FileMaker Help Index from the CS or Help menu, and then type:

importing data
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Importing data into a new file

You can bring data from another application into a new FileMaker Pro

file with one Standard layout and one columnar report. Every record is

copied into the new file.

1

.

In FileMaker Pro. choose Open from the File menu.

2. In the dialog box, select from the pop-up menu the type of file you

want to import, select the file from the list, and then click Open.

3. In the Name converted file dialog box, type a name for the new file,

select a location, and then click Save.

FileMaker Pro creates a text field called fr for each field in the new

file, where x is 1,2, 3, and so on, until all fields are named.

Note If you're importing from a format that contains the field names

(like DIF), FileMaker Pro uses the names instead of £v.

Some formats (including ClarisWorks and DBF) create number, date,

and time field types in addition to text.

If you are importing a Microsoft Excel file which contains more than

one worksheet, FileMaker Pro displays the Select Worksheet dialog

box from which you can select the worksheet that you want to import.

To stop the import, press Command-period. You can delete the records

already imported by choosing Delete All from the Mode menu.

^ Choose FileMaker Help Index from the ^ or Help menu, and then type:

importing data

Exporting data from FileMaker Pro

You can export FileMaker Pro data to a new file, and then open it in

another application.

Keep these points in mind:

To use an exported file, open an application that can read the file

format, and then open the file. See "Understanding file formats" on

page 8-3 for file formats you can export.

You can export data in container fields to FileMaker Pro format.
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Use the procedure in this section to export summary data. To export

subsummary data, see "Exporting subsummary data" on page 8-12.

To export repeating field values to SYLK, WKS, or DBF formats, see

"Exporting repeating field data" on page 8-14.

For information about exporting data from related fields, see

"Working with related files and fields" on page 10-30.

You can' t export data from a FileMaker Pro file to a remote database,

like SQL Server.

To export data:

1

.

Open the FileMaker Pro file and browse the records you want

to export.

Use Find, Omit, or Omit Multiple to create a found set.

2. Sort the records in the order you want them exported.

3. In Browse mode, choose Import/Export from the File menu, and then

choose Export Records.

In the dialog box, type a name, and then select a location for the file.

Important If another file with the same name already exists,

FileMaker Pro replaces the file.

Type a name for the

-

exported file

Iq EuergLllhere Trauel Data ] ^ Hard Disk

[
Ejetl

)

[~Desktop
]

( Neil) Q 1

OalaOut.TKT

^1 Seminar

Type: | Tab-Separated TeHt

Cfioose a file type tfiat

the target application

supports

4. Choose a file type from the Type pop-up menu, and then click Save.

5. In the Export Field Order dialog box, change the field order as

needed.

To Do this

Export field,s Double-click a field to move it to the Field Order list. To

export all fields, click Move All.
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Do this

Export fields from a Choose a relationship from the Relationship pop-up menu,

related file and then move fields to the Field Order list. (See

"Understanding relationship,s" on page 10-9.)

Prevent data from Select a field in the Field Order list, and then click Clear. To

being exported move all fields out of the list, click Clear All.

Change the export order In the Field Order list, drag the double arrow for the field

name.

Relationship pop-up menu

Select fields from this list
-

Choose a formatting option

tHpoft Field Order I

Current File '"Package Info")

Cruise Shtp

Cruise Destination

Cruise wtiolesale price

Season

Notes

Tour length

Month

Low Temp
High Temp
Rainfall

Destination

Ship photo

Clear Rll

^ Oont format output

O Format output using current lagout

Field Order

« Month

* Low Temp
* High Temp
* Rainfall

t Destination

Summaiize bij...
|

Cancel ]
f[ EkpoM |

FileMaker Pro

exports these

fields

6. Select a format option for the fields, and then click Export.

Suppose the current layout has a number field that's formatted to

display two decimal digits and a currency symbol ($). When you

enter 3.7 into the field, FileMaker Pro displays $3.70 in Browse

mode. You can export the value with or without the formatting.

To export Select this option

Unformatted values (for example, .^.7) Don't format output

Values with the number, date, and time Format output using current layojt. Symbols and

formats from the current layout (for other non-numeric values are exported as text.

example, $3.70) You cant select this option for SYLK, DBF, or

DIF formats.

*? Choose FileMaker Help Index from the (^ or Help menu, and then type:

exporting, data

rAT^tiSiiSiS.'ffiSXa
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Exporting subsummary data

When you export subsummary data, you must specify how to sort and

summarize the records.

Note To export summary data, see the previous section.

1

.

Open a FileMaker Pro fde and browse the records you want to export.

Use Find. Omit, or Omit Multiple, if needed.

2. Sort the records in the order you want them exported.

Sort on the break field (the field that groups the records), and then

switch to Preview mode to verify the subsummary results. (See

"Adding a summary part" on page 3-31 and "Sorting by summary

fields" on page 4-32.)

3. In Browse mode, choose Import/Export from the File menu, and then

choose Export Records.

4. In the dialog box, type a name, and then select a location for the file

you're exporting to.

Important If another file with the same name already exists,

FileMaker Pro replaces the data in it.

5. Choose a file type from the Type pop-up menu, and then click Save.

6. In the Export Field Order dialog box, select the fields to export.

For information about the Export Field Order dialog box, see step 5

in "Exporting data from FileMaker Pro" on page 8-10.

7. To export subsummary values, select a summary field in the Field

Order list, and then click Summarize by.

8. In the Summarize by dialog box, choose one or more fields to

summarize by.

Move the pointer to the left of the field name, and then click to

choose it. ^
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When you ctioose a field,

FileMaker Pro displays a

checkmark

Click the left side of the field

;
Summarize bj)

J

y Department I

Last Name
I

The file is sorted by

these fields

9. Click OK.

Relationship pop-up menu -

This field IS summarized by

-

Department—FileMaker Pro

exports the subsummary values

It you don't select a field to

summarize by, FileMaker Pro

exports a grand summary
(one summary value for

every record) -

Select a format option -

Last Narr.e

Current Fil» I
" Emploijees from •*•

Address

City

State

Zip

Home Phone

Title

Department

Salary

Last Review Date

Next Review

Mail Stop

Extension

Picture

Field Order

I(S)

Don't format output

Q Formal output usinq current layoi

t First Name

t Last Name

t Total Employees by Departm

t Total Employees

o

\
Summarize by...

J

( Cancel
) ((

EHport
]|

lO.Repeat steps 7 through 9 to export additional subsummary values that

are sorted by the same break field.

Repeat steps 2 through 9 to export subsummary values that are sorted

by other break fields.

11.Select a format option for the fields, and then click Export.

See step 6 on page 8-11 in "Exporting data from FileMaker Pro."

Choose FileMaker Help Index from the ££ or Help menu, and then type:

subsummary layout parts

'^y?s--T;asgjS
,'..i«(-i^4£:s3i.tii;;siK2j3£'ss*sw:*3?&a£*r*ii«viiS5K»



8-14 FileMaker Pro User's Guide

Exporting repeating field data

Some file formats (like SYLK, WKS, and DBF) can only interpret one

value per cell or field. When FileMaker Pro exports to these formats, it

exports only the first value in a repeating field. To export all repeating

field values, split the fields into separate records.

1

.

Make a clone of the file you want to export.

See "Saving a copy of a file" on page 1-11.

2. Open the clone, and then import the data from the original file.

See "Importing data into an existing file" on page 8-4.

3. When you see the Import Options dialog box, select Splitting them into

separate records, and then click OK.

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

repeating fields



Chapter 9: Customizing FileMaker Pro

You can customize FileMaker Pro by setting preferences for the

application, for individual files, or for working with files on the Web.

This chapter explains the preference options.

Important Before you read this chapter, be sure you know how to use

FileMaker Pro Help, as explained in the preface, "Getting help."

Setting application preferences

Application preferences apply to any file you open. Preferences remain

in effect until you change them.

To set application preferences:

1

.

Open a FileMaker Pro file.

2. Choose Preferences from the Edit menu, and then choose Application.

3. In the Application Preferences dialog box, choose a preference from

the pop-up menu, and then set the options.

Choose a preference type -

flpplicalion Preferences
I

^General
Layout

Memory
Modem
Dialiny

Pluy-lns

nd drop text selection

OS in Now Filo diolog

y oponod filos 4

User Name

(8)SL|Stom "MoniVaters"

O Custom

:

Network protocol | AppleTalk ^
|

Set options to customize

the way you work

'P Choose FileMaker Help Index from the SS or Help menu, and then type:

application preferences
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Setting general application preferences

In general application preferences, you set options for dragging and

dropping text, displaying template files, and the number of previously

opened files that are listed in the File menu. You can also specify your

user name and network protocol.

P
\ Application Preferences

\

I

General [

^Enable drag and drop te.l selection

^Show templates m New File dialog

^ Show recently opened files ^^^

: User Name - —
(g) System "MeniVaters*

O Custom

:

Network protocol | AppleTalk |

Do this To

Select Enable drag and drop

text selection

Use drag and drop to transfer text without using

the cupboard

Select Show templates in New File dialog Display a hst of template files when you start

FileMaker Pro or choose New from the File menu

Select Recently opened files Display recently opened files in the File menu. You
can also select how many files appear in the menu, up

to a maximum of nine files.

For User Name, select CjStom, and Specify a custom user name. If you don"t specify a

then type a name in the text box custom name, FileMaker Pro uses the System user

name from the Chooser or the Sharing Setup

control panel.

Choose a network from the Network Select a network connection. Changes to this setting

protocol pop-up menu don't take effect until you quit FileMaker Pro, and

then start it again.

O Choose FileMaker Help Index from the Q or Help menu, and then type:

general preferences
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Setting layout preferences

In layout preferences, you set options for the way you like to work in

Layout mode.

; Application Preferences
\

\
layout !-

[ I
Always lock layout tools

^ Add newly defined fields to current layout

Vith button tool:

. (•) create rounded buttons

. Q create rectangular buttons

(LgoneJ)

Select To

Always lock layout tools Keep a layout tool selected until you select a different one

or press Enter. If you don't select this option.

FileMaker Pro returns to the arrov pointer after you use a

tool.

Add newly defined fields to

current layout

Add new fields to the current layout when you define them

Create rounded buttons Create buttons with rounded comers

button tool

using the

Create rectangular buttons Create rectangular buttons 11^^ using the button tool

'P Choose FileMaker Help Index from the Q or Help menu, and then type: ^
layout preferences
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Setting memory preferences

Changes you make to FileMaker Pro files are stored in an area ofRAM
called the cache, and are saved periodically to the hard disk. In memory
preferences, you choose when FileMaker Pro saves your changes.

: flpplication Preferences \

I

Memory [

Sav* chAngvs to disk : -

i
(S) during idle lime
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3. Perform the script.

9 Choose FileMaker Help Index from the ^ or Help menu, and then type:

Dial Phone script step

scripts, overview

setting preferences

Setting modem preferences

For information about the settings you should use, see the

documentation that came with your modem.

Options are preset to standard -

Hayes-compatible settings

Hpplicatlon Preferences j

r Modem Commands

[ Setup
1
ATQ0V1E1S0=Q

I
Prefix [dt

HanQ up *ATH -

Connection

Output
I

Modem Port ^
|

Speed
I
2400 baud -r

|

AT Is an attention command for

Hayes-compatible modems—for

example, +++ ATH Instructs the

modem to hang up

Click to restore preset

modem preferences

For Do this

Setup

Prefix

Type the command (all uppercase or all lowercase) lo initialize your modem.

Type the command (all uppercase or all lowercase) for starting a call.

Hang up Type the command (all uppercase or all lowercase) for disconnecting a call.

Output Choose a port from the pop-up menu. If you choose Speaker, you don't have

to set the other inodem preferences.

Speed Choose a baud rate (the speed for transmitting data between your computer

and the modem) from the pop-up menu.

9 Choose FileMaker Help Index from the QS or Help menu, and then type:

modem preferences
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Setting dialing preferences

You can store a phone number in your database and set FileMaker Pro

dialing preferences to dial it in different ways.

Note FileMaker Pro uses these preferences when you select the Use

Dialing Preferences option in the Dial Phone script step.

The following example shows dialing preferences for an office. When
dialing another extension in the same office, you might not want to dial

the exchange. And when dialing a number outside the office, you might

need to dial a prefix for a local area code, or several prefixes for a long-

distance call.

FileMaker Pro matches the text in the left column of the Dialing

Preferences dialog box with the phone number in your database. When
it finds the longest matching entry in the left column, it dials the

corre.sponding entry in the right column. In this example, if the number

in your database is 408 555-3930, FileMaker Pro dials 3930.

This is the longest entry -

that matches the example

phone number

- flpplUation Preferences^
I

Dialing [ ~ -
,

Vh«[> dialing i phone number , look for and roplace

givon loxl

M location
|
Office ^ '—

If text begins wifh Replace with

["Qs
I h. ^

—

-

1
408 555

I

>

I I

I I
-- b-' I

I I I I

Always append

[f DoncHI

Set preferences for different

locations

With most modems, include a

comma for a two-second delay

For



Customizing FileMal<er Pro 9-7

Note Some modems won't accept more than 32 characters, so be careful

when inserting or appending long numbers.

*y Choose FileMaker Help Index from the !^ or Help menu, and then type:

Dial Phone script step

phone dialing
si-!ra-r'^*?i»K^;KR»i

Setting up plug-ins

A plug-in is a file that adds features to FileMaker Pro. In plug-ins

preferences you can set options for these plug-ins. Select the checkbox

next to the plug-in you want to work with, then click Configure. If the

checkbox is already selected, click the plug-in name to highlight it, then

click Configure.

See "Publishing files on the Web" on page 1 1 - 1 for more information on

using the FileMaker Pro Web Companion plug-in.

Select the plug-in you

want to enable

flpplication Preferences
\

I

Plug-Ins {
Enabled Plug-In N.jme

[3 Veb Companion

[Configure..

((
Done 1|

Click to configure the plug-in

Setting document preferences

Document preferences affect the current database file. You can set

different document preferences for different files.

Note A shared file has the same document preferences for every user.

You can change the document preferences if you have the master

password or if there isn't password protection in the file. See "Defining

passwords" on page 7-11.
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To set document preferences:

1. Open a FileMaker Pro file.

2. Choose Preferences from the Edit menu, and then choose Document.

3. In the Document Preferences dialog box, choose a preference type

from the pop-up menu, and then set the options.

Choose a preference type -

Document Preferences j

] General [
^Use smart quotes (", " ")

^Stor* compatible graphics

Vheit opening 'Clients'

QTry default password

Q Switch to layout

^Perform script
I
Custom Layout ^

|

Vhen closing "Clients':

r~] Perform script j unkm

Changes to document

preferences affect only

this file

Choose a script to run

when the file is opened

Choose a script to run

when the file is closed

Setting general document perferences

Select To

Use smart quotes Use curly apostrophes ('
) and quotation marks (" "I. Ifyou

use a font that doesn't have smart quotes, FileMaker Pro

substitutes plain marks ('
"). When you change this option,

FileMaker Pro uses the new setting when you type in the

file (existing marks do not change). If you deselect this

option, FileMaker Pro uses plain marks.

Store compatible graphics Store graphics in a cross-platform format. You can

deselect this option to conserve disk space. Changing this

option affects only the objects you create after the

change.

Try default password, and then

type a password

Automatically enter a password when you open the file.

If the password isn't valid, FileMaker Pro prompts you to

type another password. To temporarily bypass the

default password and enter a different one, press Option

while opening the file.

Switch to layout, and then

choose a layout from the

pop-up menu

Display the specified layout when you open the file. If

you don't select this option, FileMaker Pro opens the

layout you displayed when you closed the file, or opens

a layout you specify in a startup script. (See the Perform

script option below.)
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Select To

Perform script, and then

clioose a name from the

pop-up menu

Perform a startup or close script when you open or close

the file. For example, you can define a startup script to

hide the status area or set the window size. If another

script opens the file, FileMaker Pro doesn't perfbmi the

startup script.

O Choose FileMaker Help Index from the^ or Help menu, and then type:

document preferences

Setting document spelling preferences

You can choose to have FileMaker Pro check your spelling as you type.

You can also define where the Spelling dialog box appears onscreen. For

more information on setting spelling preferences, see "Checking your

spelling as you type" on page 1-15.

Document Preferences ;

I

Spelling ^|

Sp«1l «5 you type

® Off

Q Beep on questionable spellings

Q Flash menu bar on questionable spellings

Dialog placement ;

(•) Automatic

(3 User defined

Setting Web Companion preferences

In Web Companion preferences, you set options for FileMaker Pro

records that are published on the Web. You can set options for Table

View, Form View, searching, and sorting.

To set Web Companion preferences, choose Preferetices from the Edit

menu, and then choose Web Companion.

For more information on setting preferences for FileMaker Pro Web
Companion, see "Setting up FileMaker Pro Web Companion" on page

11-7.



Chapter 10: Using datafrom relatedfiles

There are times when one database file doesn't suit all your data

management needs. Perhaps you have data in one file that you want to

use in another file. Or you've tried to expand a file by adding several

fields to it, and now the file's subject has become unclear. Or you have

the same values in several files, and you're constantly updating them to

keep them all the same. With FileMaker Pro, you can access data from

other files to use in the current file, by either defining lookups or

creating a relational database. This chapter explains how.

Important Before you read this chapter, be sure you understand how to

create a FileMaker Pro file (see chapter 2, "Creating a database file"). You
should also know how to create a layout and work with data (see

chapter 3, "Laying out and arranging information," and chapter 4,

"Working with information in records"). In addition, be sure you know
how to use FileMaker Pro Help, as explained in the preface. "Getting

help."

Looking up and displaying data from other files

When you have data in one file that you want to use in the current file,

you can access, display, and work with that data in two ways:

A lookup copies data from another file into a field in the current file.

After data is copied, it becomes part of the current file (as well as

existing in the file it was copied from). Data copied to the current file

doesn't automatically change when the values in the other file change.

A relational database allows data from another file to be displayed,

edited, and used in the current file, without having it copied to the

current file. The data is always part of the other file only. Data

displayed in the current file changes whenever the values in the other

file change.
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To establish a connection between files for lookups and relational

databases, you detlne a relationship, an expression that tells

FileMaker Pro how to match records in one file with records in another.

Then you choose the fields that contain the data you want to work with.

Client ID rR20 :
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This term Means

Match fields A field in the master file and a field in the related file that contain

values you want to use to find matching records. (A match field is

sometimes called a key field.)

For lookups, the values in the match fields don't have to be equal

to each other. For example, you can set an option to copy the next

lower value when the match fields aren't equal.

For relational databases, the values in the match fields must be

equal to each other.

Lookup source field A field in the related file that contains the data you want to copy,

(for lookups only) It's the field the data is copied from.

Lookup destination field A field in the master file that you want to contain the copied data,

(for lookups only) It's the field the data is copied lo.

Relationship An expression you define that contains requirements which, when

met, establish a relationship between values in the match fields. (A

relationship is sometimes called a link or a join expression.)

Related record A record in the related file whose match field (according to the

relationship used) contains a value that's equal to the value in the

match field of the master file.

Related field A field in the related file that contains data you want to access and

work with in the master file. After a relationship has been

established between data in the match fields, the data in a related

field can then be used in the master file.

You place a related field in a layout of the master file, either by

itself or in a portal. You can then work with the related data in all

modes.

In the master file, a related field name appears as

Relationship name. .Relatedfield name or as

..Relatedfield name

Portal An object in a layout of the master file in which you can place

related fields. Use a portal when you want to access and work with

data from more than one related record in records of the master file.

You only need to place related fields in a portal if you want to work

with data from more than one related record.

Portals display data from related records in rows, one record in

each row.

Understanding lookups

You look up data by first setting up a relationship between matching

data in the master file and a related file, and then defining a lookup to

copy data from a field in the related file into a field in the master file.
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When you type a value in the match field of the master file,

FileMaker Pro uses the relationship to find the first record in the related

file whose match field contains a matching value. Next, it copies the

value from the lookup source field into the lookup destination field,

where the value is then stored. Data that's copied into the master file

doesn't change when the value in the related file changes, unless the

match field in the master file is changed. In that case, the lookup will be

performed again.

After a value is copied into the lookup destination field, you can edit,

replace, or delete it like any other value. You can also update data in the

master file to match data that changed in the related tile. (See "Updating

lookup values" on page 10-14.)

Lookup destination field

Master file
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Trip ID •T10

Trip Name : Oak-Lon

Route

ID Origin



Using data from related files 10-7

Related fields in a portal

Related fields not in a -

portal—the first record in

tfie related tile is accessed

Match field for

the relationship

Master tile

When the related field isn't in a portal, the value from the first related

record is accessed.

(Watch field for the relationship

Trip ID ; T1 oa

Route

ID ^jjCDrgin Jgfestlratja

:Rrn
I
ijal lat>:l: B':>st':>n

Related file

Master file

Because data from a related file is displayed in—and not copied into

—

the master file, you always see the data in its current state.

^ Choose FileMaker Help Index from the SB or Help menu, and then type:

relational databases
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Lookups and relational databases: a comparison

Whether you define a lookup or create a relational database depends on

how you plan to use the data from another file. Use the following

information to help you decide.

Use lookups to:

Copy data from a different file (or the current file) and keep it as

copied. For example, use a lookup to copy values from a Current

Price field to a Price field in an invoice file. Even if the price in the

original file changes, the value in the invoice file stays the same.

Maintain a file that already contains lookups, when you don't want to

change the files to a relational database.

Use a relational database to:

See and work with data in its most up-to-date state. This is important

when you need current data, like values in a Days Past Due field from

a related file.

Set up and manage data efficiently and with flexibility. Instead of

creating many database files that together store multiple occurrences

of data, you store single occurrences of values in smaller files. You

can then work with the data in many ways. You make any changes to

data in only one place, which promotes data accuracy.

Save disk space, because data is stored in only one place.

Note A complex set of lookups or a complex relational database may

require an administrator who understands the design and how to

maintain it. The administrator might also train others to use the database.

*? Choose FileMaker Help Index from the C9 or Help menu, and then type:

lookups, overview

relational databases
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Understanding relationships

Whenever you want to use data from another file—either for a lookup or

in a relational database—you must first define a relationship from the

master file to the related file. A relationship is an expression that

includes the name of the match field in the master file, the related

filename, and the name of the match field in the related file.

Master file
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Once a connection is established between two files, you then have

access to data in the related file in any of the following ways:

Define a lookup, to copy data from one related record for each record

in the master file (establishing a one-to-one correspondence between

data in the master file and data in the related file).

Place one or more related fields in a layout of the master file, to

display data from one related record for each record in the master file.

This establishes a one-to-one correspondence between data in the

master file and data in the related file.

Add a portal in a layout of the master file, and then place one or more

related fields in the portal to display data from more than one related

records for each record in the master file. This establishes a one-to-

many correspondence between data in the master file and data in the

related file.

Keep these points in mind:

To define a relationship for a lookup, see "Defining a relationship for

a lookup" on page 10-13. To define a relationship for a relational

database, see "Defining relationships for a relational database" on

page 10-21.

Each relationship involves only one master file and one related file;

however, you can define many relationships from a master file and

many relationships to a related file. The related file of one

relationship can be a master file for a different relationship.

You can define many relationships between the same two files. For

example, the relationships can specify different match fields.

The match fields for a relationship can have different names; what

determines that the relationship is established is that the fields have

matching values. Be sure the fields are the same type and are indexed;

otherwise, the relationship might not find the records you expect.

You can define a relationship from one file to the same file (a self-

join.) For example, use a self-join in a portal to display a subset of

data in the current file, like all the employees of each manager.

If the master file is protected with passwords, you must have the

master password to define relationships. (See "Defining passwords"

on page 7-11.)

*? Choose FileMaker Help Index from the ^ or Help menu, and then type:

relationships, understanding
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Defining lookups between files

Important Before you begin, be sure you understand the information in

the previous sections that explains lookups and how they differ from

relational databases.

Defining a lookup

1. In Browse mode or Layout mode in the master file, choose Define

from the File menu, and then choose Fields.

2. In the Define Fields dialog box, double-click the lookup destination

field (the field to copy data to). Or create a field, and then double-

click it.

3. In the Entry Options dialog box, select Lool<ed-up value.

4. In the Lookup dialog box, choose the relationship to use from the

relationship pop-up menu.

Or define a relationship by choosing Define Relationships from the

pop-up menu. See "Defining a relationship for a lookup" in the

following section.

5. In the list of field names, select the lookup source field (the field to

copy data from).

6. Select options for the lookup.

To Do this

Determine what to do when values in For If no exact match, then, select an option to copy

the match fields are not equal no value, copy the next lower or next higher value

that's in the lookup source field, or display the

message or data you type in the text box (up to

255 characters).

Prevent null (empty) data in the Select Don't copy contents if empty. (Deselect this

lookup source field from being option to allow empty data to be copied.

)

copied to the lookup destination field
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Select the lookup -

source tield

; Lookup *oi Field "Unit Price" ;

Lookup i value from the firs*

matching record given bij the relationship

(Match a new entry in "Product ID " with " Products Product IC> " >

I

Products

Copy from "Products"

Product ID

Product Name
Unit Price

L*J Don't copy contents if empty

If no exact match , then

o

^

; (•) do not copy

O copy nox( lower

i O copy next higher

I O use
I

Choose the relationship to

use, or define a new one

Select an option for

lookups with unequal data

in match fields

7. Click OK, click OK again, and then click Done.

Keep these points in mind:

Be sure the lookup source field and lookup destination field are the

same field type; otherwise, you might get unexpected results.

To change a lookup, in the Entry Options dialog box, be sure Looked-

up value is selected, click Specify, and then make your changes. To

stop using a lookup, deselect Looked-up value in the Entry Options

dialog box.

When data in the related file changes and you want the master file to

contain the new values, you can look up the data again. See

"Updating lookup values" on page 10-14.

'P Choose FileMaker Help index from the 12) or Help menu, and then type:

lookups, defining

..J I f¥MwiwfMTBiiMWnwH»iiiiiiiirrffliitniHnntiti^^
.r.»>>-^^,i^^t^-Y,jr,.^„.j-,wv.tn»i..v. .«^ .>.«; ...fi^ i^p n^jn^>yi«^i^|y^^p^fY'
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Defining a relationship for a lookup

1 . In the Define Relationships dialog box, cHck New.

Relationships currently

defined for the master file

; Define Belalionships for "Inuoices" i

PeUtionships provide access to data in ottier files

Relationship Name Relationstiip

2 relalionshiplsJ

Related File

* Customers
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Keep these points in mind:

You can define a relationship for a lookup when you define the

lookup. See the previous section.

To change a relationship, see "Changing relationships" on page

10-29.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

lookups, defining

Updating lookup values

If you change data in the match field of the related file or in the lookup

source field, FileMaker Pro doesn't automatically update the data in the

lookup destination field. To update the data, you need to look it up again.

Important You can't undo your actions when you update lookup values.

1

.

In the master file, locate the records that contain the values to update.

If necessary, find or omit records first. (See "Finding information" on

page 4-19 and "Omitting records" on page 4-26.)

2. Select the match field in the current file, and then choose Relookup

from the Mode menu.

3. When you see an alert message, click OK.

To define a script to update lookup values automatically, see chapter 5,

"Using ScriptMaker and buttons."

^ Choose FileMaker Help Index from the CB or Help menu, and then type:

lookups, updating

Working with relational databases

The rest of this chapter explains how to plan, create, and work with

relational databases.

Important Before you begin, be sure you understand the information in

the previous sections that explain relational databases and how they

differ from lookups.
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Planning a relational database

An efficient relational database organizes and stores infomiation that

you can retrieve and use to suit your needs. Related database files work

together to ensure that the correct data is available when you need it.

It's a good idea to plan a database on paper first. Follow these general

steps to plan a relational database:

1. Begin by asking questions, like these:

What information will the database hold?

What database files are needed?

What fields will each database file contain?

What common data exists among the database files?



10-16 FileMaker Pro User's Guide

Keep each file simple. For example, a Route file might have fields for

a route identification number, the departure city, and the destination

city. A Trip file might have fields for a trip identification number and

trip name. You can combine data from the Route file in records of the

Trip file.

e^
l>t.ytU<UM

T^15~

Client file

«M«r27

.

0%i^i*.

I

i P»rf«'«wlgftl.

w«?

Route file Trip file

3. Determine the match field or fields for each file.

Each database file has at least one field that can be used to determine

whether or not a new record should be added to the file. This field is

a match field. Often this field contains a value unique to each record.
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For example, in a Client file you might want to assign each client a

unique, identifying number. You wouldn't enter a client number into

the file unless you had a new client to add, so the existence of a client

number determines the existence of a record.

CHuJiffM

UMt
Ci*f

pt^e<»u

Client file

(Jj^lO )

0*¥*-

0^it^*^*i^^^

'''

%^S2^-

jOv^
V&iUi'<*iic^

Route file Trip file

For each file, decide which fields will store data and which ones will

use data from other files.

The fields in each database file all store a single occurrence of the

subject of the database file. For example, the fields in the Client file

(client identification number, name, address, and phone number)

together store all the information about one client. Other data can be

combined as needed from other database files.
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Based on the file's subject, you can see where it makes sense to store

the data and where to use stored data from a different file. For

example, you might want to use trip information in a Client file (to

see which clients took which trips), so you could use the Trip fields

in the Client file.

\Shtct

i&^
'PttUtCoM

\W^
t^^
TvTjii AUiK-

Clientfile

C^a^fP ")

Oufi*^

Oc'pUt-di^ie^

Route file

WiW

Og>?*
'

i,<t?*
'

«ii -

Trip file

Determine the relafionships between the files.

Each database file is related in some way to all the other database

files. What defines a relationship between files is that their fields

contain common data. Between match fields that have common data,

draw a line from one file to another.
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1

Cuei4}U4**t

stua

C4^

P»lUt<UiU

Route file

Client lite

Trip tile

Determining relationships between database files lets you see where

you can use data stored in one file in another file. Establishing these

relationships promotes consistent data entry and retrieval and reduces

the existence of duplicate data among the database files.

6. Consider who will use the database and whether you want to restrict

access to some files or fields.

For information about setting up passwords and access privileges, see

"Protecting your files" on page 7-9.

Choose FileMaker Help Index from the j

relational databases

or Help menu, and then type:
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Creating a relational database

After you've planned your relational database, follow these general

steps to create it (detailed instructions follow);

1

.

Define the relationships to use.

2. Depending on whether you want to work with data from one related

record or more than one in each record in the master file, add related

fields directly in the layout or in a portal in the layout.

For a related field by itself, add the related field directly in the

layout.

For related fields in a portal, create the portal in the layout, and

then add the related fields in the portal.

You add related fields and portals in Layout mode and then work with

' data from the related records in all modes.

Deciding where to place related fields

You can display related fields directly in a layout or inside a portal.

Place related fields directly in the layout to display data from the first

related record in the related file, even when the match field in the related

file contains more than one occurrence of the same value. (A related field

directly in a layout establishes a one-to-one correspondence between

data in the master file and data in the related file.)

Place related fields in a portal in the layout to display data from all

found related records in the related file. (A portal establishes a one-

to-many correspondence between data in the master file and data in

the related file.)
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Related fields In

Layout mode

Invoice

to \CusiQmst ID
I

Cusloner Han« ]. First INamr] |,-Las'Ni>me |

Address i, Addre^i ~A

~l l-5tMe

Agent Nane lAjentHame
"

Invoice ID | Invoice ID

Order Owe [Order Date

Product ID Product Nttfie Extended Price

\. f'n-i<AQ> \i>
j [.

Froj'j.i'.risj-.? l.,E.4enJ^jP"o^

m.

[Layout *1

Related fields in

Browse mode

Invoice

Ever\'^V1iere

Custoner ID
'

sioder Navie C'enm; Coplev

Address 500 Burmeistei

Hilton Head . SC

Agent NMie MndyBose

Invoice ID ^

Order Dale S"5/95

Related fields in a layout

Related fields in a portal

Product ID Product Nane Extended Price

'- wibbe^i^ travel book

Polo sh>n svitb ship logo 536 95

Tote] 1106 IS

°o|JiiPl ei-'"" I^ISI ""Kla

- Data from one

related record

- Data from all

related records in

ttie related file

O Choose FileMaker Help Index from the g£ or Help menu, and then type:

related fields

ri.^^rf^:^\1E?73rT:^Wr,--:'--j3C~

Defining relationsiiips for a relational database

1. In Browse mode or Layout mode in the master file, choose Define

from the File menu, and then choose Relationships.

2. In the Define Relationships dialog box, click New.
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Relationships currently -

defined for tfie master file

Define Relationships for "Inuoices"
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6. Select options for the relationship.

To do this while browsing

records in the master file Select

When you delete a record m the master When deleting a record in this file, also delete related

file, delete related records (in the reCOrdS. (See "Deleting related records" on page

related file) 10-34. ) Related records may not be visible on the

current layout.

Add records to the related file Allow creation of related records. (See "Creating

related records" on page 10-32.)

Sort related records before displaying Sort related records, then specify how you want

them in the master file related records sorted. (See "Sorting records with

related fields" on page 10-35.)

7. CHck OK. and then cHck Done.

Keep these points in mind:

A match can be defined only on fields that can have an index.

You can define a relationship when you add a related field or create

a portal in a layout. See the following sections.

To change a relationship, see "Changing relationships" on page

10-29.

O Choose FileMaker Help Index from the gS or Help menu, and then type;

relational databases

Creating a portal to hold related fields

Important Before you begin, be sure you want to create a portal to hold

related fields. (See "Deciding where to place related fields'" on page

10-20.)

1. In Layout mode in the master file, select the Portal tool.
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Portal tool

If you don't see layout

tools, click the status

area control
Drag ttie pointer to

draw ttie portal

Click in the layout where you want the portal to start and drag the

pointer diagonally until the portal is the size you want.

In the Portal Setup dialog box, choose the relationship to use from the

Show records from pop-up menu.

Or define a relationship by choosing Define Relationships from the

Show records from pop-up menu. See "Defining relationships for a

relational database" on page 10-21.

- Pnrt«l SPtlip =^=^
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4. Select options for the portal, and then cUck OK.

To Select

Delete records in the related file by selecting Allow deletion of portal records

a portal row in Browse mode, and then

choosing Delete Record from the Mode menu

Specify the number of rows to display in For StlOW <value> rows, type a number
the portal

Display a scroll bar on the right side of Show vertical scroll bar

the portal

Display a background color and pattern for Alternate background with, and then choose a

every other row of the portal till color and pattern from the palettes

First portal row

Portal

Relationship for the portal

5. Place related fields in the portal (see the next section).

Keep these points in mind:

You can display objects other than fields in a portal. An object is in a

portal if its upper-left comer is inside the portal. An object placed in

the first row of a portal is displayed once for each related record.

A portal can't contain another portal. If you place a portal in a portal,

they overlap.

You can place a portal in any layout part. See "Working with layout

parts" on page 3-24.
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To number rows in a portal, use Paste Special to paste the record

number into the first portal row.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

portals, creating

Placing related fields in a layout or portal

Use the following steps for adding related fields directly in a layout or

in a portal.

Important Before you begin, determine where to place related fields (see

"Deciding where to place related fields" on page 10-20). If you're

placing related fields in a portal, create the portal first (see "Creating a

portal to hold related fields" on page 10-23).

1 . In Layout mode in the master file, hold down the Field tool and drag

the new field onto the layout or in the first row of a portal.

Field tool

-

Portal -

|la[|tni> ! ~|

+-Hf

Ha
o o

^Fl^.M

£202

IS

"
ffl ipt

.Qb

Invoice

Ever>'Where
r H X ' V EL

Cusioner ID ICitsMmer ID ~1

Cusioner Nasie [.JirstName] [..LastNaffie
I

Address |, Addias;
|

[..City [.-State

Agent Nane ^^etuNafrie
'

Invoice ID llfivotcft ID ~

Order Due lOnlerPale

I
Huder |-

Producl ID Product Nane Extended Price

I
FiiiJ...;' ID

I
Uni'. PrK

1
E-Jended Price I

Total ITo'aJ

Bl 'ayut l»|llll{ 1»|S

- Related

fields in a

layout

~ Related

fields in

the first

row of a

portal

2. In the Specify Field dialog box, choose a relationship from the

relationship pop-up menu.

You can define a relationship by choosing Define Relationships from

the pop-up menu. See "Defining relationships for a relational

database" on page 10-21.
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3. Double-click the name of a related field.

i Specify Field

Invoice ID

Product ID

Unit Price

Extended Price

: Product Name

n Create field label

(
Cancel

] | OK j]

- Ctioose ttie relationsliip to

use, or define a new one

Fields in tfie related file (based on

tfie current relationship)

Note To prevent users from changing data in a related field, deselect

Allow entry into field in the Field Format dialog box (in Layout mode) for

the related file. (See "Determining data entry in fields'" on page 3-68.)

O Choose FileMaker Help Index from theQ or Help menu, and then type:
~^

related fields

0!fflSS®SSSWrag»SiiS«S!KS!«»B

changing related fields and portals

In Layout mode, related fields and portals are layout objects that you can

change hke any other FileMaker Pro object.

^ Choose FileMaker Help Index from the CS or Help menu, and then type: |

related fields

^?r:5«CfSS»«!K.-r.^

Selecting, moving, or deleting related fields and portals

To Do this in Layout mode

Select a related field Click the field.

Select a portal Click the portal area outside any fields.

Change the tab order of

related fields

See "Setting the tab order for data entry" on page 3-69.

Move or delete the field label of Select the label, and then move or delete it.

a related field

Move related fields or portals See "Moving objects" on page 3-44. To move related fields

with a portal, select the fields and the portal.
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To Do this in Layout mode

Delete related fields or portals In Layout mode, select the field or portal, and then press

from a layout Delete. FileMaker Pro deletes the objects, not the

relation.ships, field definitions, or data.

Changing the appearance of related fields and portals

To Do this in Layout mode

Change the fill color or pattern. See "Changing lines, colors, and patterns" on page .^-5 1

.

pen color or pattern, or line width

of a related field or portal

Change the color or pattern of Double-click the portal. In the Portal Setup dialog box,

alternating rows in a portal select Alternate background with, and then choose a fill color

and pattern from the palettes. Click OK.

Resize related fields or See "Resizing objects" on page .^-50. Resizing the first row

portal rows of a portal resizes all rows.

Change the number of rows Double-click the portal. In the Portal Setup dialog box. type

displayed in a portal a new value for Show <value> rows. Click OK.

Show or hide a portal scroll bar Double-click the portal. In the Portal Setup dialog box,

select Show vertical scroll bar. Click OK.

Change the data format of See "Defining display formats for fields" on page 3-59.

related fields The changes only affect the format on the current layout.

Change the appearance of a See "Working with fields in a layout" on page 3-55. The

related field in the current layout changes only affect the appearance on the current layout.

Slide related fields and portals to See "Removing spaces at the end of fields and parts" on

remove blank space between page 6-5. Objects in a portal don't slide or shrink, but when

layout objects a portal slides, objects within the portal slide with it.

Copying and pasting related fields and portals

To Do this in Layout mode

Cut, copy, and paste See "Cutting, copying, and pasting objects" on page 3-45.

related fields If you paste a related field into another file. FileMaker Pro

j

looks for a matching related field name in the new file. If

the matching name exists, FileMaker Pro pastes the field in

the layout with that same name. Otherwise, a template field

(a field with no association to any field in the database file)

is pasted.

Copy and paste portals See "Cutting, copying, and pasting objects" on page 3-45.

To copy and paste related fields with a portal, select the

fields and the portal. If you paste a portal into another file,

FileMaker Pro looks for a matching relationship name in

the new file.
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Choosing a different relationship for a portal

1. In Layout mode, double-click the portal.

2. In the Portal Setup dialog box, choose a relationship from the pop-up

menu, and then click OK.

If you change the relationship after adding related fields to the portal, the

fields don't change, but FileMaker Pro matches records based on the

new relationship. Remove the fields from the portal, and then add related

fields based on the new relationship, if needed.

Changing relationships

When you change a relationship, your changes affect which records are

found in the related file and displayed in records of the master tile.

When you delete or change a relationship, all records involved in that

relationship are affected by your changes.

1

.

Choose Define from the File menu, and then choose Relationships.

2. In the Define Relationships dialog box, select a relationship, and then

select an option.

To Click

Delete the relationship Delete, and then click Delete in the confirmation

message. Be sure to delete all references to the

relationship in the master file.

Quickly create a

similar relationship

Duplicate. To make changes, with the duplicate selected,

click Edit. Then see the next step.

Change the relationship Edit, and then see the next step.

3. To edit the relationship, make your changes in the Edit Relationship

dialog box, click OK, and then click Done.

To Do this

Rename a relationship For Relationship Name, type a new name.

Change options for a relationship Select or deselect options.

Choose a different related file Click Specify File. In the Open File dialog box.

double-click the name of a related tile. Then, in the

Edit Relationship dialog box. select the match fields

you want.
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To do this with

related fields Keep these points in mind

Define a calculation formula

in the master file thai refers

to a related field

Set the order for related

fields (for columnar reports

exporting, and so on)

Insert a merge field from a

related file

Summarize data that's in a

portal

Define a script step to work

with related fields

In the Specify Calculation dialog box, choose a relationship

from the relationship pop-up menu. Then select a related field,

(See "Understanding formulas" on page 2-1.^.)

References to related fields can become invalid when you create

or delete a field, change the field type or number of repetitions,

or have a missing field definition or mismatched field types (for

example, when a field is deleted in the related file). When a field

reference is invalid, FileMaker FYo alerts you.

You can place a related field anywhere in the field order

—

before, after, or between fields in the master file.

In the Specify Field Order dialog box. choose a relationship

from the relationship pop-up menu. Then select related fields

in the field list, in the order you want.

In the Specify Field dialog box. choo.se a relationship from the

relationship pop-up menu. Then select a related field. (See

"Adding merge fields" on page 3-58.

1

Make the field a calculation field, and then define a formula

that includes an aggregate function. For example, for a field

tfiat calculates the total of values in the related field Price

(which is in a portal and uses the relationship Line Items),

define the formula: SumfLine Items : : Price) for the

Total field. (See "Functions" on page 2-20 and "Aggregate

functions" on page C-6.

)

In the Specify Field dialog box for the step, choose a

relationship from the relationship pop-up menu. Then ^

related field.

-Meet a

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

related fields

Working with related records

The following table explains how to work with related records in some

areas of FileMaker Pro. For other areas, see the following sections.

To do this with

related records Keep these points in mind

Duplicate related records

(in Browse mode)

To duplicate a master record (and display related data), be

sure no records in a portal are selected, and then choose

Duplicate from the Edit menu. (See "Adding and duplicating

records" on page 4-.3.)

To duplicate a related record that's in a portal, select the

record, and then choose Duplitate from the Edit menu. The
Allow creation of related records option must be selected for the

portal relationship.
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To do this with

related records Keep these points in mind

Import and export

related records

You can't impon related fields, but you can import directly

from a related file. (See "Importing data into FileMaker Pro"

on page 8-4.)

To export related fields, use the relationship pop-up menu to

choose the fields in the Export Field Order dialog box. (See

"Exporting data from FileMaker Pro" on page 8-9.)

Replace related records See "Replacing field values" on page 4-14.

Preview and print

related records

FileMaker Pro prints related records and portals you see in

Preview mode. (See chapter 6, "Previewing and printing

information.")

To prevent related fields and portals from printing, see

"Keeping objects from printing" on page 6-9.

When you print a portal that displays a scroll bar,

FileMaker Pro prints only the records displayed in the portal

when the portal isn't scrolled.

Work with records in

shared files

FileMaker Pro limits access to some commands and records to

keep users from interfering with each other. (See "Working

with shared files" on page 7-6.)

When you make changes to a master record. FileMaker Pro

prevents other users from changing the same record.

When you make changes to a related field, FileMaker Pro

prevents other users from changing the associated related

record and master record.

Other users can access the record after you select a field in a

different record, select a different record in the same file, or

leave the master record.

'P Choose FileMaker Help Index from the £IS or Help menu, and then type:

related records

Creating related records

You can add records to the related file as you enter data in a record in

the master file.

To add related records from the master file, the Allow creation of related

records option must be selected for the relationship. (See "Defining

relationships for a relational database" on page 10-21.) When this option

is selected, typing in a related field that has no corresponding related

record creates a related record based on the match field in the master file.
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1

|L«)Wi1 !

looUiipi

2J
Everywhere

Line Items

Match field
-

Invoice ID

Product ID

Unit Price

Oty

Extended Price

3

ET1

36 95

2

73 9

Product Neme PolO Shltt With Ship loqo

Invoice ID

Produci ID

Unit Price

Oly

Extended Price

Produci Nene

J2E

3

ET3

29 95

1

29 95

Travel bag

Related records from the Line Items file-

Type in the last row ot the portal to add a -

related record to the Line Items file

'°°U-^eI

Related file

Master file

Agent Nuie M!}^.^!!:^

Invoice ID 3

Order Due '8n5(95

Product ID Product Name

Cajibbea/i travel book J32 25

Polo shiit wtih shift I090

Travel bag

Extended Price

total H::h I

l$m

To Do this

Create a record in the master t"ile In Browse mode, choose New Record from the

Mode menu.

Add a record in a related file If the related field is in a portal, type data into the

field in the last row of the portal, and then press Tab.

If the related field isn't in a portal, type data into the

field, and then press Tab.

Note If a related file is locked or write-protected. or the user doesn't

have access privileges to create records, FileMaker Pro doesn't add new
records. See "Working with related records" on page 1 0-3 1 and

"Defining passwords" on page 7-11.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

related records
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Deleting related records

While browsing through records in a master file, you can delete records

from a related file when one or both of the options for deleting records

are selected.

Important You can't undo deleting data or records. Before deleting,

consider making a backup copy of your files.

To delete records, in Browse mode, choose Delete Record from the Mode
menu. (See "Deleting records" on page 4-29.) FileMaker Pro deletes

information based on the following:

When a portal row is selected (by clicking inside the row but outside

any fields in the row) and Allow deletion of portal reCOrdS is selected in

the Portal Setup dialog box, FileMaker Pro deletes the associated

related record. (See "Creating a portal to hold related fields" on page

10-23.)

When anything other than a portal row is selected, FileMaker Pro

deletes the master record. If When deleting records in this file, also delete

related records is selected in the Edit Relationship dialog box, all

related records are also deleted. (See "Defining relationships for a

relational database" on page 10-21.)

Note Delete All deletes the records in the found set of the master file. If

When deleting records in this file, also delete related records is selected for the

relationship, FileMaker Pro also deletes the related records.

*? Choose FileMaker Help Index from the gS or Help menu, and then type:

related records

Finding and omitting related records

You can include related fields in find criteria when you find records in a

master file. (For more information, see "Finding information" on page

4-19 and "Omitting records" on page 4-26.)

When you find records using related fields in a portal, FileMaker Pro

displays all records related to the found set of records in the master file,

not just related records that satisfy the find criteria. For example,

suppose you search for records whose Item field (which is in a portal)

contains Computer. The found set includes all records in the master file

that contain Computer in any row of the portal.



Using data from related files 10-35

1

ItenxlD, Item

1100 :^ Computer

V202
i

Desk

Ti53
';'" "Lamp

T229":' Bookcase

T448"T "Chair

Records in master file

You can omit master records that include related fields, but you can't

omit related records.

^ Choose FileMaker Help Index from the (2) or Help menu, and then type:

related records

Kaxe^'aKs^si!ix!Wxvimasmss^:SSS

Sorting records with related fields

(For general information on sorting records, see "Sorting records" on

page 4-30.)

You can sort on related fields when you sort records in the master file.

When you sort on a related field, the value from the first related record

FileMaker Pro finds in the related database is used for sorting unless you

specify otherwise. (See "Sorting related records" below.)
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1. In the Sort Records dialog box, choose a relationship from the

relationship pop-up menu.

2. Select related fields in the order you want them sorted, and then

click Sort.

Note You can place a related field anywhere in the field order—before,

after, or between fields in the master file.

Sorting related records

You can sort related records before displaying their values in the master

file. Normally, FileMaker Pro looks in the related file, finds the first

record that matches according to the specified relationship, and displays

the related values in the master file. However, you can have

FileMaker Pro sort related records first, and then display values from

those sorted records in the master file. Instead of displaying the first

related record, FileMaker Pro displays the first value encountered after

sorting. The displayed value could be a highest value, a lowest value, or

a value sorted using a custom order based on a value list.

Sorting related records is especially useful if you are using a portal to

display multiple related records. You can use this feature to have related

records appear in the portal in the sorted order you specify.

1

.

Choose Define from the File menu, and then choose Relationships.

2. Select the relationship you want to work with.

3. Click Edit.

4. In the Edit Relationship dialog box, select Sort related records.

5. In the Specify Sort dialog box, define how you want fields in the

related file to be sorted before they are displayed in the master file.

O Choose FileMaker Help Index from the [21 or Help menu, and then type:

related fields

sorting records

Invoicing example

The following sections contain a step-by-step example for setting up a

relational invoicing system, using a sample travel agency named

Everywhere Travel.
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Example step 1 : Plan the system

In addition to booking cmises. Everywhere Travel sells souvenirs, like

shirts and ship photographs. The company followed the procedure in

•'Planning a relational database" on page 10-15 to design the following

database files for tracking and billing the souvenir sales.

A Customers file stores information for each customer, including a

unique identification number. When a new customer calls to place an

order, an agent creates a record in the Customers file.

[Layw

!_1 iT

RecoriJs

34

ooj^OB

Customers

Everj-'Wlieie
r R * ' V E L

Cusioner ID I

Nane Javier Hernandez

Address 34479 Werner BlvcJ

City Santa Bartoara

Slate CA

Customer ID J

Nane Billy Adiington

Address 61 3 Main St

City Memphis

Stale TN

Customer ID 3

Nane Danielle Bradbury

One record

per customer

A Products file stores information about available products.
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One record per product -

Everywhere

Product ID ET1

Product Nane PolO Shirt With Ship logO

Unit Pnce $36 95

Product ID ET2

Product Nane Photograph of ship at sunset

Unit Pnce $12 50

Product 10 ET3

Product Nuie Travel baq

Unit Price $29 95

IOOU^BI Brovse l^j

Current price

of the

product—if

you change

this value,

FileMaker Pro

doesn't save

the old price

A Line Items file stores the order number, product identification

number, price, and quantity of each item in every invoice. For every

Hne item in the Invoice, there's one record in the Line Items file.

This record describes one -

item ordered in Invoice 1

Another item ordered
-

in Invoice 1

[laijout "1

4-(-t
Line Items

Evei^'Where
r R A " V C L

Invoice ID 1

Product ID ET3

Unit Price 29 95

Oty I

Extended Price 29 95

Product Nane Travel bag

^QEJ

Invoice ID

Prodgcl ID

Unit Pnc«

Oty

Extended Price

Product Nuie

1

ET4

32 25

1

32 25

Caribbean travel book

IE

Price when the

customer

places the

order— the

price might be

different from

the current

price in the

Products file

Quantity

ordered by

the customer

An Invoices file is used for order entry and billing. When a customer

places an order, an agent enters a customer identification number to

display the customer's name and address. The agent enters data in the

Product ID field for each item ordered. FileMaker Pro enters data in

the Invoice Number and the Order Date fields.
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One record per order -

Agents type the Product ID -

and quantity, and

information from trie

Products file displays

<-f-+

lOOJJliP

Invoice

Agents type the Customer ID and data

from the Customers file displays

EverV'VVliere

Customer ID '

Cusioner Nane Javier Hema/ide:

Address ^<i47^ Werner Blvd

Agent Nane l^avid Mchaels

Invoice ID '

OrderDale 8iHre6

Product ID Product Nane

Caribbean rravel book

Polo shin wilh ship logo

Expended Price

Total ir-.f, ill

n»ia

Data from

Customers

file

The following figure shows how the database files are related.

Line Items relationship -

Lookup

Invoice
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Tip If you use fields that contain identification numbers, plan the field

foimats when you plan the database files. For example, customer

identification numbers can be telephone numbers, serial numbers, or a

combination of a telephone number and first name.

You can enhance this simple invoicing system in many ways.

For example:

Place a button in the Order Entry layout in the Invoices file that

agents click when a new customer calls. The button performs a script

that switches to the Customers file, pauses for the agent to enter

information, and then switches back to the Invoices file.

Use the Line Items file to create reports, like how many items were

sold in February.

In the Products file, include fields for product information, like

weight, color, and so on.

Create a Vendors file with information about companies that supply

products. Define a Vendor ID field in the Products file, and then

define a relationship to a Vendor ID field in the Vendors file.

Example step 2: Define fields

After you plan the invoicing system, create the database files and define

the fields. (See "Defining database fields" on page 2-3.) Create the files

that contain lookup source fields first.

1 . Define these fields in the Customers file:

Field names Field type Select this Auto Enter entry option

Customer ID Number Serial number

First Name, Last Name, Text

Address, City, State
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2. Define these fields in the Products file:

Field name
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Example step 4: Define fields that use relationships

When the relationships are defined, you can create the loolcup

and calculations.

1. Define these fields in the Line Items file:

Field name Field type Comments

Unit Price Number A lookup to Unit Price in the Products tile. Use the

Products relationship.

Extended Price Calculation Enter the calculation Unit Price * Qty. Use fields

from the current file (not the Products relationship).

Product Name Calculation Use the related field Products : : Product Name. For

Calculation result is, choose Text.h

2. Define the Total field in the Invoices file.

The Total field is an unstored calculation that adds the extended price

of all line items. Use the Line Items relationship to define Total as:

SumiLine Items: : Extended Price)

Example step 5: Create layouts

Create layouts in the master files for data entry and reports. (See

chapter 3, "Laying out and arranging information.")

File Layout names Description

Invoices Order Entry Standard layout with a portal.

Place these fields from the Customers file

directly in the layout: First Name, Last

Name, Address, City, and State.

In the Portal Setup dialog bo.x, choose the

Line Items relationship and Allow deletion of

portal records. Place these fields from the

Line Items file in the first row of the portal;

Product ID, Product Name, Unit Price, Qty,

and E.xtended Price.

Customers
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Example step 6: Enter data

Enter data in the Products and Customers files, and then test your

database by creating records in the Invoices file. (See "Adding data to a

file" on page 4-2.)



Chapter 11: Publishingfiles on the Web

With FileMaker Pro 4.0, you can publish your database on the World

Wide Web—without any additional software—using FileMaker Pro

Web Companion and your Internet access. Your file can be viewed,

edited, sorted, and searched by anyone who has Web browser software

and access to the Internet. You can also choose how much or how little

access users have to your files.

This chapter explains what you need to do to publish your databases on

the Web.

About the World Wide Web
The Internet is a network of computers joined by data lines that

communicate using common software standards. The World Wide Web
is part of the Internet.

In the most basic sense, the World Wide Web is a very large collection

of documents, ox pages, stored on computers around the world called

World Wide Web servers. Each computer connecting to the Internet has

a unique address, called an IP (Internet protocol) address. Web pages

travel from one IP address to another—first a Web browser requests

specific Web pages, then the Web server delivers the requested page to

the Web browser.
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About FileMaker Pro Web Companion
There are two ways you can publish your database on the Web:

FileMaker Pro Instant Web Publishing and FileMaker Pro Custom

Web Publishing.

Instant Web Publishing lets you publish your database on the Web
quickly and easily. You do not need to change your database, use any

additional software, or design Web pages. You can control database

privileges such as viewing, adding, editing, deleting, searching, and

sorting records. Users see clear, consistent Web pages which let them

open your file and work with it easily.

Publishing a database on the Web

Total records 3

Unsorted

U'

Prodnct Name
Kmtshin

Unit Piice
19 99

Custom Web Publishing allows you to customize the appearance of your

FileMaker Pro data on the Web. You need to create formatfiles, which

are Hypertext Markup Language (HTML) pages that contain Claris

Dynamic Markup Language (CDML) tags, or commands. The CDML
tags enable HTML pages to interact with FileMaker Pro. For an

overview, see "Custom Web Publishing" on page 1 1-25. For

step-by-step instructions on Custom Web Publishing, see the CDML
Reference database inside the Web Tools folder.

Important Regardless of the publishing method you choose, it is strongly

recommended that you publish your database by running it on a

computer with a full-time Internet connection.
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What the Web Companion does

FileMaker Pro Web Companion functions as a Web server by

communicating with Web browsers that request data from, or submit

data to, a FileMaker Pro database. Similar to other Web server

applications, the Web Companion delivers HTML Web pages and

image files to the Web browser. The Web Companion supports the

HTTP-Put and HTTP-Get commands. For more information about these

HTTP commands, refer to an HTTP reference.

The Web Companion also acts as a Common Gateway Interface (CGI)

application, by handling the interaction between FileMaker Pro and

Web browser software.

Note You can also publish databases using other common gateway

interface (CGI) applications, which you must purchase from third-party

vendors.

Why publish a database on the Web?

When you host a database on the Web, the number of people who can

use your file is potentially large: the only requirements are Web browser

software and access to the Internet (or an intranet). Your file is available

to anyone, using virtually any kind of computer, virtually anywhere in

the world. You can, however, limit access using passwords.

You can also publish your database on the Web so that you can access it

anywhere—on the road, at another office, or at home.

Publishing your database on the Web—an overview

The following section provides an overview of the steps required to

publish your database on the Web using Instant or Custom Web
Publishing.

Instant Web Publishing

1. Create a database, or select an existing database to publish.

Perform the following steps on a computer connected to the

Internet or an intranet via TCP/IP.

2. Make sure that the Web Companion plug-in is enabled in Application

Preferences.

3. Make sure that Instant Web Publishing is enabled in the Web
Companion Configuration dialog box.
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4. (Optional) Change the default configuration of the Web Companion

in the Web Companion Configuration dialog box.

5. (Optional) If you have created a custom home page, move it to the

Web folder and specify it as your FileMaker Pro home page in the

Web Companion Configuration dialog box.

6. Open the database in FileMaker Pro 4.0.

7. Enable Web Companion Sharing in the File Sharing dialog box.

8. (Optional) Choose the layouts that specify which fields will appear

in Table View, Form View, and Search View, and select sort options.

9. Give your users information about accessing your database.

These steps are described in detail in the rest of this chapter.

Custom Web Publishing

1. Create a database, or select an existing database to publish.

2. Create format files, which contain HTML and CDML tags. Format

files determine how Web users interact with your FileMaker Pro

databases.

Perform the following steps on a computer connected to the

Internet or an intranet via TCP/IP.

3. Move the HTML pages and format files to the Web folder, in the

FileMaker Pro 4.0 folder.

4. Make sure that the Web Companion plug-in is enabled in Application

Preferences.

5. (Optional) Disable Instant Web Publishing in the Web Companion

Configuration dialog box.

6. Choose the home page and change any other settings in the Web
Companion Configuration dialog box.

7. Open the database in FileMaker Pro 4.0.

8. Enable Web Companion Sharing in the File Sharing dialog box.

9. Give your users information about accessing your database.

For step-by-step instructions on Custom Web Publishing, see the CDML
Reference database inside the Web Tools folder.

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

Web, publishing databases on
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Getting ready to publish your files on the Web
To publish a file on the Web you need:

a FileMaker Pro database

a Mac OS-based computer, or an Intel-compatible 486/33 or higher

personal computer, with access to the Internet (or an intranet)

FileMaker Pro 4.0 (for Mac OS or Windows), with the Web
Companion installed. (The Web Companion is automatically

installed when you do an Easy Install.)

optional: a custom home page, or HTML files containing CDML
tags, for use with FileMaker Pro Custom Web Publishing

Internet access

It is best if the machine running your FileMaker Pro database has a

full-time dial-up, ISDN, Tl, T2, or T3 connection to the Internet (or

similar capabilities). If you want to publish your database within your

company or workgroup, you can use an intranet.

Without continuous Internet access, you can publish a database on the

Web—but your database is only available while your machine is

connected to the Internet. For more information, see "Helping Web
users find your database" on page 1 1-23.

If you are not sure of the type of Internet access available to you, consult

your Internet service provider or network administrator.

'P Choose FileMaker Help Index from the (^ or Help menu, and then type:

Web, publishing databases on

Preparing files for the Web
If you are using FileMaker Pro Instant Web Publishing; you can publish

all the fields in your database, or you can designate layouts for use with

the Web Companion that don't show all fields. If you designate a layout,

the Web Companion publishes only the fields contained in the layout

you have specified. See "Setting options for Web display" on page

1 1-12 for more information on how these layouts will be available to

you when you're ready to set up browser views.
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If you want, you can create a new layout for use with the Web
Companion. A simple. Standard layout is sufficient, as text styles,

special backgrounds, and colors do not appear on the Web using

FileMaker Pro Instant Web Publishing. Date and number formats, as

well as repeating fields, do appear over the Web. For information on

working with layouts, see chapter 3, "'Laying out and arranging

information."

Ifyou have specified one or more passwords using FileMaker Pro access

privileges to limit access to your database, users are required to enter a

password when viewing your database on the Web.

If you are using FileMaker Pro Custom Web Publishing, you will need

to move any HTML pages and format files you have created into the

Web folder, which is inside the FileMaker Pro 4.0 folder.

Security considerations before you publish a database

There are some important security considerations to keep in mind before

sharing a FileMaker Pro 4.0 database on the Web:

If you have chosen a layout with related fields in the Web Companion

View Setup dialog box, those related fields appear when a Web user

opens the master database—even if the related databases are

protected with FileMaker Pro access privileges. Keep this in mind

when designating layouts for use with published databases.

If your database uses related fields, and you are using Instant Web
Publishing with the built-in home page (available in the Web
Configuration dialog box), the related database(s) are also made

available on the Web because they appear in the list of open databases

on the built-in home page. For information about hiding databases

from the built-in home page, see "Helping Web users find your

database" on page 1 1-23.

Warning Anyone who opens a database file with the Export records

access privilege, including FileMaker Pro guests, can then publish the

database on the Web by enabling FileMaker Pro Web Companion on his

or her computer. In this case, your database is protected over the Web
by any FileMaker Pro access privileges you have created. However, you

should exercise caution when granting access privileges to guests. For

more information, see chapter 7, "Networking and access privileges."
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Setting up FileMaker Pro Web Companion
Once you have prepared your files for the Web, set up FileMaker Pro

Web Companion:

1

.

Choose Preferences from the Edit menu, and then choose Application.

2. Choose Plug-Ins from the pop-up menu.

3. Select the Web Companion checkbox.

For information on configuring FileMaker Pro Web Companion, see

"Configuring FileMaker Pro Web Companion" on page 1 1-8. In most

cases, you will not need to change the configuration default settings.

Select Web Companion

i Application Preferences i

I

Plug-Ins
-^^l

PluQ-l

Bl Veb Companion

Description

Select the Web Companion checkbox to provide

access to your databases on the Veb Also set up

Companion Sharing (choose Sharing from the File

menu)

[Configure..

I
Done

4. Click Done.

You only need to set up this preference once.

For each database you want to publish on the Web:

1. Open the database.

2. Choose Sharing from the File menu.

Note If you see an alert informing you that your password does not

enable you to open the File Sharing dialog box, you must reopen the file

using a password that provides the Export records access privilege.
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3. Select Web Companion in the Companion Sharing area.

Select Web Companion

File Sharing for "Trauel log.FP5" i

FileMaker Netvork Sh^rtng

(g) Singlt-User Q Multi-User

Select Multi-User to share this file using "TCP/IP"

Companion Sharing

Select the Veb Companion checkbox to shar^ the current database on the

Veb Click Set Up Vievs to set up the database for the browser

[cancel
) | OK ]]

4. Click OK.

Note These settings apply only to the database that is currently open.

You need to set up other databases separately if you want to host them

on the Web.

*? Choose FileMaker Help Index from the !2! or Help menu, and then type:

Web Companion
r.^--?r^?B;:Ka&>iffi«Ksj;s.

Configuring FileMaker Pro Web Companion
The Web Companion Configuration dialog box contains options you

can change as needed. Since the default values are appropriate for most

uses, you may not need to change these settings.

These are the default settings:

Instant Web Publishing is enabled

a built-in HTML file for your home page is available

English is set as the default language

the TCP/IP port number is set to 80
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To change the configuration settings for FileMaker Pro Web
Companion:

1. Choose Preferences from the Edit menu, and then choose Web
Companion.

You see the Web Companion View Setup dialog box. For

information on setting up views, see "SeUing up Instant Web
Publishing" on page 11-12.

2. Click Configure.

You see the Web Companion Configuration dialog box.

mcb Companion Configuration
;

-Veb Companion User Interface -

^ Enable Instant Veb Publifhing

Home Page
|

iBuilt-ini

Language
|

English ^
|

Remote Administration

O Disabled

(S) Requires passv/or<] ••••

O Requires no password

TCP/IP Port Number 80

-Log Activily-

(•) None

O E-tended

Securitti

(•) FileMaker Pro Access Privileges

O '^*l> Secunlu Database

Cancel (^O

3. Choose the configuration options you want (see below).

Enabling Instant Web Publishing

If you want to pubHsh your database using FileMaker Pro Instant Web
Publishing, be sure Enable Instant Web Publishing is selected. If you are

exclusively using FileMaker Pro Custom Web Publishing, you can

deselect this option.

Specifying a home page for your database

If you are familiar with HTML editing, you can create a personalized

Web page that can be used instead of the FileMaker Pro Web
Companion Built-in home page.

If you want to use a home page other than the one that's built into

FileMaker Pro Web Companion, create the home page and move it into

the top level of the Web folder in the FileMaker Pro 4.0 folder. Then

choose the home page file from the Home Page pop-up menu.
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By default, the Built-in Web page is used. This page automatically

updates to include links to all databases being shared using the Web
Companion.

Here are suggestions for items to include on your custom home page:

a link that contains the IP address of your published FileMaker Pro

database

a description of what your database contains

your email address, or an automated email link, so users can contact

you if they have questions

your logo, or other graphics

For more information, see "Helping Web users find your database" on

page 1 1-23.

Choosing a language

You can specify the language used in both the FileMaker Pro Instant

Web Publishing interface and in the Instant Web Publishing Help.

Choose a language from the Language pop-up menu.

Note Choosing a language affects the FileMaker Pro Instant Web
Publishing interface only. It has no effect on your data.

Creating a Web activity log

You can have FileMaker Pro Web Companion keep a log of the activity

your database receives from Web users. This Web activity log is a text

file named Web. log, located in the same folder as the FileMaker Pro

application.

For no activity log, or to stop keeping an activity log if one already

exists, select None.

For an abbreviated activity log, select Brief.

For a detailed activity log, select Extended.

Remote password administration

You can specify a password to control several remote administration

activities:

remote administration of the Web Security databases

remote uploading of files to the Web folder and remote downloading

of database files from the Web folder, in the FileMaker Pro 4.0 folder
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You can specify whether you want to require a password before

allowing remote administration:

To require a password before allowing remote administration, select

Requires password.

To allow remote administration without a password, select Requires

no password.

To prevent remote administration, select Disabled.

Note When creating a password, use only the characters A through Z,

numerals, or a combination of the two. Do not include spaces in your

password. This minimizes the possibility that you will choose characters

that may be interpreted incorrectly over the Web.

Web security

You can set up FileMaker Pro access privileges before publishing your

database on the Web, or you can control access to your databases with

even greater precision by using the Web Security database.

To use FileMaker Pro access privileges for access control, select

FileMaker Pro access privileges. To use the Web Security database, select

Web Security Database. For more information, see "Database security" on

page 11-18.

Specifying a port number

The port number specifies the number of the TCP/IP port where Web
browsers can find FileMaker Pro databases. If port number 80 is already

in use (for example, in running a Web server), consider changing TCP/IP

Port to 591. Port number 591 has been registered with the Internet

Assigned Numbers Authority (lANA) for use with FileMaker Pro Web

Companion.

Note If you use a port number other than 80, users cannot access your

database unless they append a colon, and the new port number, to your

IP address (12.34.56.78:591).

9 Choose FileMaker Help Index from the ^ or Help menu, and then type:

Web Companion



11-12 Fi leMaker Pro User's Guide

Setting up Instant Web Publishing

In a browser, users can see different pages, or views, of your database:

a Table View, for working with several records at a time

a Form View, for working with one record at a time

a search page, for finding information

a sort page, for sorting information (if enabled)

Setting options for Web display

You can choose which fields display in Table View, Form View, and the

Search page. You can also set options for the Sort page.

Users see only the pages and features that you have given them access

to. For example, if sorting is disabled, Web users do not see the Sort

page. By default, all fields are shown in each view, and sorting is

disabled.

To set options for each type of Web page:

1

.

Choose Preferences from the Edit menu, and then choose Web

Companion.

2. Choose an option from the pop-up menu for the type of page you

want to work with.

Choose an option

; U)eb Companion Uieiu Setup ]

fTable View [
. In the browser. Table Viev displays multiple records in tabular form

Users will see the fields from the la^iout you choose below

Choose layout for browser vievinq

Layout
|
Data entry 3-

Field Name

Trip ID

Route ID

Origin

Destination

[ Configure...

- Select a layout

List of fields for

the selected layout
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3. From the Layout pop-up menu, select the layout that contains the

tlelds you want displayed for Table View. Form View, and Search.

(For information on the Sort view, see below.)

A list of that layout's fields appears below the pop-up menu.

4. Click Done.

Note Selecting a layout does not display that layout over the Web—it

only indicates which fields you want the Web Companion to publish on

the Web. If the layout you select has special date or number formats, or

repeating fields, these do appear over the Web.

Related fields do not appear if you have chosen All Fields (no layout) in the

pop-up menu. Instead, choose a layout which contains the related field

or fields you want to publish on the Web.

Warning If you choose a layout for use on the Web and it uses related

fields, those related fields appear when a Web user opens the master

database—even if the related databases are protected with

FileMaker Pro access privileges. Keep this in mind when choosing

layouts for use with published databases.

Setting sort options

You can specify the order in which data is sorted, or you can allow users

to define how the records are sorted. You can also specify that records

not be sorted at all (they appear in the order they were added to the

database).
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In the Web Companion View Setup dialog box, choose Sort from the

pop-up menu and then choose the options you want.

Choose Sort

Uleb Companion Uieu> Setup

fSorl

jjlll Records can b? sorted in the browser Choose a method

Q Do not sort records

(•) User defines sorting by specified fields in the browser

Q Predefine sorting by specified fields before downloading to the browser

Sort Fields

Field Name

Trip ID

Route ID

Origin

Destination

I Specify

Configure..
I

none ))

Do not sort records

If you do not want users to sort data in the Web browser, select Do not

sort records. This can help speed up access for those who are using your

database. Data is not sorted when it appears on the Web, and the Sort

button does not appear.

User defines sorting

If you want to let the user define how data is sorted, select User defines

sorting by specified fields in the browser. You specify the fields (including

fields from related files) on which the user can sort.

For information on specifying sort fields, see "Sorting records" on page

4-30.

Note If a user sorts the data in a particular order, it does not affect the

record order for other u.sers on the Web.

Predefine sorting by specified fields before downloading

If you would like to automatically sort records before the user sees them,

select Predefined sorting by specified fields before downloading to the

browser. Then specify the sort order. (You can include related fields in

this sort order.)
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1

The Web user sees the data sorted in the order the fields appear in the

Sort Order hst, and the Sort button does not appear.

You can choose either ascending or descending order. You can also

choose to have data sorted by a custom order based on a value list. The

data are sorted in the same order they appear in a predefined value list.

For information on specifying a sort order, see "Sorting records'" on

page 4-30.

Choose FileMaker Help Index from the (21 or Help menu, and then type:

Instant Web Publishing

5:V^'>^^i\i-^tSf?:*a!^**:S4*'tiS>¥>S'^: lJ.-WfS*'^:^rSKC«»^fi%5S«»:^3i3JM;iC^

About the browser views

Note The record range and book icons do not appear unless you are

using a Java-enabled Web browser.

Detailed help is available to Web users by clicking the question mark (?)

button on the Web page.

Table View

Table View is the view the user sees when the database opens. It lists

multiple records in tabular form. Each record appears as a row, while

each field appears in a column.

Table View in the browser

View a single record •

Record range icon: move -

slider to view a different range

of records

Change the size of the record

range by typing a range, then -

clicking the arrow

Click to see this record

in form view -

Sort records

Add a record

Find all records after a search -

or creation of a new record

Click to return to the database home page

Click for Help

Tl^ta^ records 3

Unsorted

Prodncl ID
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Note These screens change to reflect features you have enabled or

disabled. For example, the New record button does not appear if a user is

not permitted to add records.

Form View

The Form View displays one record at a time, making it easy to see the

detail of each record. From this view, Web users can edit information in

a record.

Form View in llie browser

View a list of records

Book icon: view the previous record

View the next record

To see a record, type its number
and click the arrow

Edit this record

Add a record

Delete this record

Sort records

Find all records after a search

or creation ot a new record

Note These screens change to reflect features you have enabled or

disabled. For example, the New record button does not appear if a user is

not permitted to add records.
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1

Search page

The search page displays fields that can be used to find specific

information in your database. The results of the search are displayed in

Table View.

Searching in the browser

Click for search tips -

Begin searching -

Set new search criteria -

Choose a search operator -

Total reconls 3

Unaorted

-(-CleMtieuT]

^|i

Database Pnidncts

Select seaa-h type . enter seaich cntena. then cbcX Stan seaich BSifiitilllliiH

(•) Match all T^T^rds oa page (AND) O Match axiy voiil on page (OR)

Field Tjrpe Ciiteiia

Product ID

Product Name

Choose a search type Type find criteria, then

clicl< Start search

E
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Sort page

When records are displayed to users, those records can appear in a

particular sorted order. See "Setting sort options" on page 11-13 for

more information.

Sorting records in the browser

Perform sort

Return to ftie

previous view

Undo ttie sort

Select field riaiiie(s) and son order to define your son, Uien

click Stan sort

Sort by Field name

Aacendmg

I

Product Name Products '/alue list

1
Unit Pnce Descending

[ -None- Ascending

Use pop-up menus to select field names for ttie

first, second, ttiird, and fourtti sorts

Use pop-up menus to select ascending or

descending sort order, or a custom sort order

based on a value list

O Choose FileMaker Help Index from the ^ or Help menu, and then type:

Web browsers
ism^£sssise>X!Ssism^sis!a»ssf3»mi!S^

Database security

You can control access to your database. This limits who can use your

file, as well as what they can do. There are two types of database security

available using FileMaker Pro Web Companion:

FileMaker Pro access privileges

Web security databases

Important For a list of security considerations see "'Security

considerations before you publish a database" on page 1 1-6.

FileMaker Pro access privileges

If you have specified FileMaker Pro access privileges for your file, those

same access privileges are in effect when you publish your database on

the Web.
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When users open your database on the Web, they enter the same
password as if they were opening your file on the host machine (or over

a FileMaker Pro network). The Web browser's password dialog box has

two fields: Name and Password. FileMaker Pro access privilege security

ignores anything entered in the Name field.

FileMaker Pro access privileges are convenient, easy to use, and the best

choice for most database security needs. For more information on

FileMaker Pro access privileges, see chapter 7, "Networking and access

privileges."

*} Choose FileMaker Help Index from the i2] or Help menu, and then type:

access privileges

Web Security database

If you want to establish access privileges that are more specific than

FileMaker Pro access privileges, you can use the FileMaker Pro Web
Security database.

With the Web security database, you can control whether users can

search, update, add, or delete records; whether they can use scripts; and

which fields they can work with. If you choose, you can also administer

access privileges remotely over the Web. If you do not require this level

of security, use FileMaker Pro access privileges.

To use the FileMaker Pro Web Security database:

1. Be sure that Web Security Database is selected under Security in the

Web Companion Configuration dialog box. For more infonnation see

"Web security" on page 11-11.

2. Choose Open from the File menu.

3. Navigate to the FileMaker Pro 4.0 folder, then open the Web Security

folder.

4. Open the Databases folder, and then double-click Web Security.

5. Select New Record from the Mode menu.
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6. For Database Name, type the name of the database you are establishing

security for.

7. Enter information for the access privileges you want to grant.

8. If the FileMaker Pro database has a password set up with

FileMaker Pro access privileges, type that password in the Database

Password field.

UJeb SeLuritu fD3

Database Name: Products

Database Passvord: |^

User Passvord User Pemissions

BBto H':teaie HEdii HDeleie HScnpis

PBrowsa PCweta QE^it DDateta pSoripis

Field Reslriotions

D PonrShow

D PontShov

DE-MiSewch DExacrPelere

Q Readonly d Ex3Atl^eJ;«

DDontSearch DExaclSearch D E>«jCtDelete

ilii

looUi^B JK

Note The Database Password overrides the Web Security database.

Web access privileges are never greater than the privileges provided

by the Database Password, regardless of the settings in the Web
Security database.

The Security folder contains HTML files that enable you to remotely

administer the Web Security database.

See the following sections for more information.
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User permissions

To set user access privileges, type the user's name in the User Name
field, and if desired, type a password for that user in the User Password

field. Then select the access privileges for that user. Press Return to set

access privileges for another user.

To provide these access
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Keep these points in mind:

Create a separate record for every database you want to assign Web
Security database access privileges.

You can type All Users in the User Name field to create privileges

that apply to any Web user. These privileges override more restrictive

privileges you may set later. To prevent this, carefully decide which

privileges you want to grant to all users.

When creating a password, use only the characters A through Z,

numerals, or a combination of the two. Do not include spaces in your

password. This minimizes the possibility that you will choose

characters that may be interpreted incorrectly over the Web.

'P Choose FileMaker Help Index from the CS or Help menu, and then type:

Web Security database

Web Security database remote password administration

To remotely administer the Web Security database:

1

.

In the Web Companion Configuration dialog box, be sure to select

Web Security Database and to enable Remote Administration.

See "Configuring FileMaker Pro Web Companion" on page 1 1-8 for

more information.

2. Open the Web Security database, located in the Databases folder in

the Web Security folder.

3. Copy the Security folder from the Web Security folder to the Web
folder.

4. In your Web browser, type the IP address for the computer where the

Web Security database is open, and /Security/default. htm

For example, 12.34.56. 78/Security/default .htm

5. On the resulting Web page, for Database Name, type the name of the

database whose privileges you want to change and click OK.

Click the Add Database link to add a new database record to the Web
Security database.

6. If you specified Requires password in the Web Companion

Configuration dialog box, you're prompted for a User Name and the

password. Type Admin in the User Name field, type the password, and

cHck OK.
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7. On the resulting Web page, make changes to the privileges as you

would in the Web Security database.

*? Choose FileMaker Help Index from the ^ or Help menu, and then type:

remote administration

Helping Web users find your database

Browsing a database set up in FileMaker Pro Web Companion requires

only Web browsing software and access to the Internet (or an intranet).

The Web browser must also have the Internet Protocol (IP) address (and

port number if it is other than 80, which is the default) of the machine

that hosts your database file. You can supply this address for the user to

type directly in the Web browser software, or you can provide a link to

this IP address on a Web page you set up.

Example The IP address of the machine that hosts your database file is

similar to 12 . 34 . 56 . 78. To see your data, the user launches Web
browser software and types this IP address.

Edok Honw peloid

Type IP address in browser window

If you have specified a port number other than 80, that port number must

be appended, using a colon, to your IP address:

12.34.56.78:591

For more information see "Specifying a port number" on page 11-11.

For more information on using a custom home page, see "Specifying a

home page for your database" on page 11-9.

Note If you connect to the Internet using a modem connection to an

Internet service provider, your IP address could be dynamically

allocated, meaning it is different each time you connect. This makes it

much more difficult to create links from a Web page to your database,

since your IP address is constantly changing.
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Once Web browser software is pointed to the IP address of the machine

hosting your database files, the Web user sees your database home
page—a bacicground screen and the Hst of the files you have currently

running on your host machine. Clicking a filename opens the file. If you

have specified a password for the file, the user is prompted for it.

Click here for help on working in the browser

Instant Web Publishing built-in

home page

Click the filename to

open the file

FileMaker
Web Companion

These FileMal:er ?to databases are shared by S^rua Long

Select a database to viev:

Note You can publish a file on the Web. but keep it from displaying on

the Built-in home page, by typing an underscore character at the end of

the filename, before any filename extension.

Example: 'Orders_" or "Orders_.fp3"

'P Choose FileMaker Help Index from the [2J or Help menu, and then type:

Web, publishing databases on
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Custom Web Publishing

Custom Web Publishing allows you to customize the appearance of your

FileMaker Pro data on the Web. To use Custom Web Publishing, you

must create fornuit files, HTML pages that contain Claris Dynamic

Markup Language (CDML) tags. CDML is Claris Corporation's

proprietary add-on to HTML that allows Web users to dynamically

interact with FileMaker Pro databases.

If you do not want to learn HTML and CDML, you can use the

FileMaker Pro Assistant feature in Claris Home Page 3.0 to create

format files. Otherwise, you must have an HTML editing application

and an understanding of HTML and CDML.

FileMaker Pro 4.0 includes several resources to help you learn and use

CDML:

the CDML Reference database (Web Tools folder)

the CDML Tool (Web Tools folder)

CDML teinplate files (Web Tools folder)

example Web solutions (Web folder)

Choose FileMaker Help Index from the (^ or Help menu, and then type:

Custom Web Publishing

\«y**-.>«!!3Sn«!s™iw««S"-?:^--^-?«e>~:

The CDML Reference database

The CDML Reference, located in the Web Tools folder, provides:

the Developer's Guide, to get you started with Custom Web
Publishing

a CDML Tag Index, which shows CDML tag syntax and provides

examples
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The Developer's Guide in the CDML Reference database provides

general information about Custom Web Pubhshing and step-by-step

instructions on using the CDML Tool to create format files.

You can start a new format file by:

using one of the templates in the CDML Tool (see "Using the CDML
templates" in the Developer's Guide)

copying and pasting CDML tags from the CDML Tool to existing

HTML pages (see "Adding CDML tags to format files")

modifying one of the format files in the Web folder (see "Working

with the sample solutions")

customizing one of the template files in the Web Tools folder

Note The CDML Reference focuses primarily on the CDML syntax. For

information about working with HTML, see an HTML reference book.

MB- CDML Reference
:

FileMaker Pro CDML Reference

J Developer's Guide CDML Tag Index

Click on a heading lo displaymore ml ormati on

» Getting started with Custom Web Publishing

k About the Web Companion plug-in

Considerations before publishing a database

About format files

Using the CDML Tool

Exploring the Quest Book format files

Reference

Pl Browse |b|
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The CDML Tool

The CDML Tool, located in the Web Tools folder, interacts between

open FileMaker Pro databases and HTML editing applications to help

you construct format files quickly and accurately.

Use the CDML Tool to:

start a format file using basic templates that contain step-by-step

instructions (Templates tab)

copy and paste CDML tags to format files (Tags tab)

The CDML Tool links open FileMaker Pro databases with HTML
editing applications.

Follow these general steps to create a format file using the CDML Tool:

1

.

Open and share your FileMaker Pro database using Web Companion

sharing.

2. From the Web Tools folder, open the CDML Tool.

3. Click the Templates tab and choose the database and layout names.

4. Open an HTML editing application.

5. From the Templates tab of the CDML Tool, copy a template from the

Format File (Action) list.

6. Paste the template text into a blank HTML editing document.

7. From the Tags tab of the CDML Tool, copy and paste additional

CDML tags into the appropriate location in the format file.

Create one format file to handle each database activity.
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For more information on the CDML Tool, see the Developer's Guide in

the CDML Reference database.

Opens the CDML
Reference database

Tafls
I

Tetnpbtes [

Database | Ftodn.

KmeniAcimn | B K I

ipui i^e="subinit**naines*''Oeleie" -ir

valiie=T>elete'*>

4 7
I

r7 DescHption
|

Refresh j

[.^l^r^;ph,.,^,.,,,.l:[,^,,h*.jbv^;^i-|[' -^

100|J,iB3l Brovse
_11

Select a database

Select a CDML tag category

Select a tag

CDML tag syntax

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

CDML Reference database

Sample Web solutions

Three sample Web solutions are provided for you to use as a model for

database Custom Web Publishing. The sample Web solutions include

helpful comments to assist you in creating format files.

The following sample Web solutions are located in the Web folder in the

FileMaker Pro 4.0 Folder:

The Guest Book solution allows Web users to add records in the

Guest Book.fp3 database.

The Shopping Cart solution allows Web users to browse through and

purchase items from a catalog.

The Employee Database solution is designed to demonstrate the most

widely used CDML tags.



Appendix A: Recovering damagedfiles

Power failures, hardware problems, and other factors can damage a

FileMaker Pro file. If a file is damaged, you can use the FileMaker Pro

recovery feature. FileMaker Pro attempts to repair and salvage as much
of the information in the file as possible, and then creates a recovered

file. You can open and use a recovered file just like any other

FileMaker Pro file.

Important Before you begin, be sure you have enough disk space for the

recovered file. If there isn't enough space, the recovered file won't

be usable.

To recover a damaged file:

1

.

Be sure the damaged file is closed.

2. Choose Recover from the File menu.

3. In the Open Damaged File dialog box, select the damaged file, and

then click Open.

In the Name New Recovered File dialog box, FileMaker Pro adds

Recovered to the filename (which might be truncated).

4. If you want to rename the file, for Name new recovered file, type a

name.

5. Click Save.

A status message tells you about the recovery process. A second

message reports the success of the recovery—how many bytes were

salvaged, the number of records and values skipped, and the number

of lost field definitions that were rebuilt.

6. Click OK.
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Keep these points in mind:

To ensure you always have a file that's up to date, make frequent

backup copies of your files, and don't write over the most recent

copies.

If a file is severely damaged, you might not be able to recover it.

A file can grow or shrink in size. A file can grow if the indexes are

damaged and repaired. A file can shrink when data deleted by the user,

like a paragraph, has finally been deleted from the file.

9 Choose FileMaker Help Index from the 12) or Help menu, and then type:

recovering files
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When you create or clone a database tile, FileMaker Pro uses the current

settings in the Numbers and Date & Time control panels as the default

date, time, and number formats and stores them internally with the file.

These system fonnats control how FileMaker Pro enters and indexes

data in these field types.

The internal default formats saved with a file may be different from the

system formats currently set on your computer when:

you receive or share a file with different internal default fonnats

you changed the system formats on your computer after creating or

cloning the file

For example, a file created on a U.S. system has different formats from

a file created on a German system, as shown in the following example.

For this

field type
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Using the current system formats

When you open or work with a file with formats different from the

current system formats, you can continue to use the formats saved with

the file, or you can use the cuirent system formats. (When you use the

current system formats, you don't change the formats saved with the

file—you simply enter and view data in a format that's familiar to you.)

When you open a file with different internal default formats,

FileMaker Pro displays a message alerting you to the situation. To

use the current system formats, click Yes. To use the formats saved

with the file, click No.

FileMaker Pro
;

A The date and time formats associated uiith

"Organisation" are different ttian the current

system settings. Do gou mish to use the

system settings for data entrg?

No (^O

As you work with a file with different internal default formats, you

can use the current system fomiats by choosing Use System Formats

from the Format menu. You see this command only when the current

file was saved with internal default formats different from the current

system formats.

Keep these points in mind:

You see the alert message only if the setting of Use System Formats

when the file is closed is different from the setting when the file

was open.

To change the formats saved with a file, you must change the system

formats, and then clone the file. You can then change the system

formats to their original settings. (For information about cloning a

file, see "Saving a copy of a file" on page 1-11.)
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Using system formats doesn't affect the formatting of dates, numbers,

and times that you set in FileMaker Pro for displaying data in fields.

However, you must enter data precisely according to the system

format. For example, when date parts in a system format are in order as

year, month, and day, separated by a period (.), you must enter dates in

that format, as in 98.12. 31. (For information about display formats

for fields, see "Defining display formats for fields" on page 3-59.

)

*? Choose FileMaker Help Index from the (^ or Help menu, and then type:

system formats

Defining scripts for system formats

You can have FileMaker Pro open a file using the current system

formats by including the Set Use System Formats script step in a startup

script. In the Script Definition dialog box, choose the Set Use System

Formats script step, and then select On to use the current system formats.

(To use the formats saved with the file, select Off.

)

For more information about defining scripts, see chapter 5, "Using

ScriptMaker and buttons."

*? Choose FileMaker Help Index from the iilS or Help menu, and then type:

system formats

SiSiS?Sl'ia:rS3»SSKK



Appendix C: Summary offunctions

A function is a predefined, named formula that performs a specific

calculation and returns a single, specific value. You use functions when

you are defining calculation fields. You can use functions by themselves

or combine them with other functions or expressions.

This appendix summarizes the FileMaker Pro functions by category. For

detailed information about functions, see FileMaker Pro Help.

Important In the United States, commas act as list separators in

functions, formulas, and calculations. In other countries, semicolons

might be used as list separators. The separator being used depends on the

operating system your computer uses, as well as the one used when the

file was created.

Important Before you read this appendix, be sure you understand

formulas and how to define calculations, as explained in "Understanding

formulas" on page 2-13. In addition, be sure you know how to use

FileMaker Pro Help, as explained in the preface, "Getting help."

Understanding functions

With a few exceptions, all FileMaker Pro functions use the following

syntax:

Function nameiparameter)

This part
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Here are some examples of functions:

This function Returns

Length ( "John"

)

4 (the number of characters in the text "John"

Round(SalesTax,2) The amount of sales tax rounded to two decimal places

Position (Name, "Mc" ,1,1) The position of the first occurrence of "Mc " in the Name
field

Some functions require two or more parameters, as in this example;

Position(LastNaine, "Mc" , 1, 1)

You can nest one function within another to perform more powerful

calculations on your data, as in this example:

Left (Name, Position (Name, " ",1, 1))

The result of a function can be used as a constant. The following

example shows how FileMaker Pro evaluates a complex formula by

simplifying each function into a constant. In the example, the Right

function returns every character of text that is to the right of the first

space in the Name field. (This example shows how Right returns the last

name of a field that contains a first name and last name, when the value

doesn't include a title like Dr. or middle initials.)

Contents of Name iS|0|N|l|A| |L|0|N|G|
123456789 10

Formula walk-through -

JT Indicate a space in

your calculation

Right (Name, Length (Name )
- Position (Name, " ",1,1)) by typing quote

~\

I

space, quote

10 - 6

Right (Name, 4)

LONG
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Summary of functions C-3
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Keep these points in mind:

The following sections summarize FileMaker Pro functions. Values

in quotation marks ("") are text values. To include a space in a text

expression, type a quote, then a space, then a quote (" "). For

complete information about each function, including examples, see

FileMaker Pro Help.

A function can return the following data types: text, number, date,

time, or container. However, you determine the data type of the

calculated field when you define its calculation.

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

functions, using

The parameter text can be a text expression (in quotes) or a field name.

Syntax Definition

Exact (original le.xi, comparison Compares original text and comparison text for exact

text) match, including case when comparing text. Returns " 1

"

r- , , • , , tor a match, "0" for no match,
hxaci {original container.

comparison container) Compares original ctmuiiner and comparison container

for exact match. Returns "
I " for a match. "0" ioi no

match.

Left (text, number)
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Syntax



Date functions

Syntax

Summary ot functions C-5

1

Definition

Round (number, precision) Returns number rounded lo the number of decimal

places in precision. When precision is negative, all

digits right of the decimal separator are dropped and

number is rounded to the nearest ten for a precision

of -1 , the nearest hundred for -2, and so on.

Sign (number) Returns -1 when number is negative; returns when

number is zero; returns 1 when number is positive.

Sqrt (number) Returns the square root of number

Truncate (number, precision) Returns number truncated to the number of decimal

places in precision

"? Choose FileMaker Help Index from the ^ or Help menu, and then type:

number functions

Syntax Definition

Date (month, day. year) Returns the calendar date of month, day, vear (in digits ).

from January 1 . 0001 , in the date field fonnat you've set

in your computer system software. Year must be four

digits.

DateToText (date)



C-6 FileMaker Pro User's Guide

Syntax

WeekofYearFiscal

(date, starling day)

Year (date)

Definition

Returns the number of weeks elapsed since the first

week of the year of date, using starting day (a number

from 1-7, where I is Sunday) as the first day of the

week. The first week of the year is a week that contains

four or more days of that year.

Returns a number representing the year portion of date

O Choose FileMaker Help Index from the 09 or Help menu, and then type:

date functions

Time functions
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Syntax Definition

Max (field)

Max (relationship: .field)

Mm (field I. field:....)

Max (
relationship: ifieldl

,

relationship: :field2...)

Returns the highest nonblank value in a repeating field

(field) ox (relationship:
:
field)

Returns the highest nonhlank value in each

corresponding repetition of one or more repeating or

non-repealing fields (fieldl. field2....) or

(relationship: :field I. relationship: .field!...)

Min (field)

Min (relationship::field)

Um (fieldl. field!....)

Min (relationship:
:
fieldl

.

relationship: .field!...)

Returns the lowest nonblank value in a repeating field

(field) or (relationship: :field)

Returns the lowest nonblank value in each

corresponding repetition of one or more repeating or

non-repeating fields (fieldl. field!.... ) or

( relationship: :fieldl , relationship::field!...

)

StDev (field)

StDev ( relationship: :field)

SlDe\ (fieldl. field!....)

StDev (relationship: :fieldl

.

relationship::field!...)

StDevP (field)

StDevP (relationship: .field)

SlDevP (fieldl. field!....)

StDevP ( relationship: .fieldl,

relationship: .field!...)

Returns the standard deviation of the sample

represented by a series of nonblank values in a repeating

field (field) or ( relationship: .field)

Returns the standard deviation of the sample

represented by a series of nonblank values in each

corresponding repetition of one or more repeating or

non-repeating fields (fieldl. field!....) or

( relationship: :fieldl. relationship::field!...

)

Returns the standard deviation of a population

represented by a series of nonblank values in a repeating

field (field) or (relationship: :field)

Returns the standard deviation of a population

represented by a series of nonblank values in each

corresponding repetition of one or more repeating or

non-repeating fields (fieldl. field!....) or

(relationship:
:field I. relationship:

:field!. . .

)

Sum (field)

Sum (relationship::field)

Sum (fieldl. field!....)

Sum (relationship::fieldl.

relationship::field!...

)

Returns the sum of nonblank values in a single repeating

field (field) or (relationship: :field)

Returns the sum of nonblank values in each

corresponding repetition of one or more repeating or

non-repeating fields (fieldl. field!....) or

( relationship: .field1 . relationship::field!...

)

When you use aggregate functions, keep these points in mind:

You can specify fields in the current database (field) or in a related

database (relationsh ip:field)

.

If you specify a single parameter (field) or (relationship: .field), it

must be either a related field, or a repeating field. If you specify

multiple parameters {fieldl, field2....) or (relationship: fieldl,

relationship: :field2), they can be field references, a constant, or any

valid expression. If you specify related fields, you can name a

different relationship for each related field if you want

(relationship 1: .field 1, relationship!: :field 2...)
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The parameters /?eW7, field!,... can include a numeric constant (for

example, 10). A constant in a formula for a repeating field affects the

result for every repetition.

Whenfieldl,field2,... includes a nonrepeating field, that value is used

in the result for only the first repetition unless you use the Extend

function. For information about the Extend function, see "Repeating

functions" on page C-12.

Empty (null) values are ignored.

If you specify a single parameter (field) or (relationship:.field), the

result includes all nonblank values in all repetitions. When the

calculation is also repeating, the result is returned in the first

repetition.

When fieldl.field2,... are repeating and the calculation result is not

repeating, only the values from the first repetition of the repeating

fields are used to calculate the result. If the calculation result field is

also repeating, FileMaker Pro uses the corresponding repetitions of

the fields to calculate the result.

Values in repetitions that exceed the number of repetitions in the

calculated field are ignored. For example, a calculated field with three

repetitions holds only three results, even when one field in the

calculation has five repetitions.

The following examples show how aggregate functions produce results

based on the number of parameters and whether the calculations involve

repeating or nonrepeating fields.
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Example 1

Single Input parameter

Repeating Field Sum{Repeating Field) Sum(Repealing Field)

10

Example 2

Single Input parameter

Field Sum(Field) Sunn(Field)

Example 3
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Break field'

Sales
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Repeating functions

Use repeating functions with repeating fields.

Syntax Definition

Extend {nonrepeating field) Allows the value of non-repealing field to be

used in a calculation involving repeating fields.

(See the following example.)

GetRepetition (repeating field, number) Returns the contents of the repetition number of

repeating field

Last (repealing field) Returns the last valid, nonblank value in

repealing field

This example shows how the Extend function ensures accurate results

when u.sed in calculations involving nonrepeating fields.

Item Total Tax Rate Item Tax

5 00

17 00

82 79 -

07 35 Without Extend, a calculation

includes a nonrepeating value in the

result for only the first repetition of

the calculated field

; Item Total • Tax Rate

Item Tota l Tax Rate Item Tax
07500

17.00

82 79

.35

1.19

5 795

: Item Total • Extend (Tax Rate)

- Using Extend, a calculation includes

a nonrepeating value in the result for

all repetitions of the calculated field

'P Choose FileMaker Help Index from the ^ or Help menu, and then type:

repeating functions
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Financial functions

Syntax Definition

FV (payment, interest rate, periods) Returns the future value of an investment based on

interest rate and payment for periods

NPV {payment, interest rate) Returns net present value of a series of unequal

payments (in a repeating field) made at regular

intervals using a fixed interest rate (in a number

field) per interval. (When payments contains equal

values, use the PV function.)

PMT (principal, interest rate, term) Returns the payment needed to meet the

requirements of principal, interest rate, term

PV (payment, interest rate, periods) Returns the present value of equal payments made

at regular p^rio(/i, assuming a fixed interest rate

per payment

Keep these points in mind:

Term is expressed in months

Interest rate is a value from 0.0 to 1.0, divided by 12 (months).

9 Choose FileMaker Help Index from the ES or Help menu, and then type:

financial functions

Trigonometric functions

Syntax
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Logical functions

Syntax

Radians (number

j

Sin (number)

Tan (number)

Definition

Converts degrees (7t/l 80 radians) in number to

radians. Parameters for trigonometric functions

must be in radians—use tiiis function to convert

values from degrees to radians within a formula.

Returns the sine of an angle expressed in radians

Returns the tangent of the angle (in radians) in

number. Tangents for values of 90 degrees (jt/2

radians) or multiples are undefined (infinite).

*? Choose FileMaker Help Index from the (^ or Help menu, and then type:

trigonometric functions

Syntax Definition

Case (lesrl. result! /, tesl2, result!,

default result]...)

Evaluates lestl to produce a result. When testl is

true (a nonzero value), returns result I: when tesl2 is

true, returns result 2. and so on. When no test is true,

returns an empty (null) value, or the default result

you supply.

Choose (test, resultO /. resuit 1.

result2]...)

Evaluates test to produce an index number used to

choose a result. When index is 0, returns resultO;

when index is 1, returns result!, and so on. When
there's no corresponding result, returns an empty

(null) result.

If (test, result one, result tvi'o) Evaluates test to return a true or false result. When
test is true ( 1 ), returns result one: when test is false

(0), returns result tuo. Test must return either a

numeric or Boolean result. (See the example below.)

IsEmpty (field) Returns true ( 1 ) when field is empty (null);

otherwise returns false (0)

IsValid (peld) Returns false (0) when field is missing from the file

or when /if /(/ contains an invalid value; otherwise

returns true ( 1 ). For example, if a field in a related

file is deleted, references to that field in the master

file are invalid. See chapter 10, "Using data from

related files."
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The following example shows how the If function returns a different

result based on a true or false condition.

SYNTAX:

If (Test, ResultifTrue, Result IfFalse)

BASIC EXAMPLE (Not Nested):

If (Signal="Green" ,Go, Stop)

When test is True

If (Signal="Green" ,Go, Stop)

When test is False

If (Signal="Green" ,Go, Stop)

ADVANCED EXAMPLE (Nested If's):

If (Signal="Green" ,Go, If (Signal=" Yellow" , Slow down, Stop)

)

When first test is True

If (Signal= "Green", Go, If {Signal="Yellow" , Slow down, Stop)

)

When first test is False

If (Signal="Green",Go, If (Signal="Yellow" , Slow down, Stop)

When second test is True ^ ^

If (Signal="Green",Go, if (Signal="Yellow" , Slow down. Stop) )

When second test is False ^,_- -^^

If (Signal = "Green",Go, If (Signal="Yellow" , Slow down. Stop) )

9 Choose FileMaker Help Intlex from the 29 or Help menu, and then type:

logical functions
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Status functions

You can use status functions in ScriptMaker scripts to monitor tiie state

of your database. When creating a calculation using a status function,

choose Status functions from the pop-up menu above the function list,

then double click the status function you want from the function list. For

examples of scripts that use status functions, see "Displaying

customized layouts" on page 5-32 and FileMaker Pro Help.

Syntax Definition

Status (CurrentAppVersionl Returns the FileMaker Pro version currently in use

Status (CurrentDate) Returns the current date

Status (CurrentError) Returns a nuinber for the current error value. Use

Status (CurrentError) to check error results when

FileMaker Pro performs a script. (See "Control

steps" on page 5-5.)

Status (CurrentFieldName)
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Syntax Definition

Status (CurrentModifierKeys) Returns a number representing which keyboard

modifier keys (for example. Shift) are being pressed

by the user). For more information, see

FileMaker Pro Help.

Status (CurrentMultiUserStatus) Returns for a single user file. 1 for a multiuser file

and the computer is the host, or 2 for a multiuser file

and the computer is a guest

Status (CurrentNetworkChoice

)

Returns the name of the network protocol

Status (CurrentPageNumber) Returns the page number currently printing or being

previewed. When no page is printing or being

previewed, returns 0.

Status (CurrentPlatform) Returns a number for the platform currently in use.

Returns I for Mac OS, 2 for Windows.

Status (CurrentPortalRow

)

Returns the number of the current row in a selected

portal. When no portal is selected, returns 0.

Status (CurrentPrinterName) Returns the identification of the current printer

Status (CurrentRecordCount) Returns the number of records in a file

Status (CurrentRecordlD) Returns the unique ID of the current record. (For

more information, see FileMaker Pro Help.)

Status (CurrentRecordNumber) Returns the number of the current record in the

found set

Status (CurrentRepetitionNumber) Returns the current repetition number (counting the

first repetition as 1 ) of the current repeating field.

When the current field is nonrepeating, returns 1

.

Status (CurrentRequestCount) Returns the number of find requests defined in the

database

Status (CurrentScreenDepth) Returns the number of bits needed to represent the

color of a pixel on the main computer screen

Status (CurrentScreenHeighl) Returns the number of pixels displayed vertically

on the screen on which the current file is open.

When the window spans more than one screen, uses

the screen that contains the largest percentage of the

FileMaker Pro window.

Status (CurrentScreenWidth) Returns the number of pixels displayed horizontally

on the screen on which the current file is open.

When the window spans more than one screen, uses

the screen that contains the largest percentage of the

FileMaker Pro window.

Status (CurrentScriptName) Returns the name of the script currently running or

paused

Status (CurrentSortStatus) Returns a number representing the current sort

status. Returns for unsorted, 1 for sorted, or 2 for

semisorted.
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Syntax Definition

Status (CurrentSystemVersion) Returns the system version currently in use

Status (CurrentTime) Returns the current time

Status (CurrentUserCount) Returns the number of users accessing the file.

Returns 1 for a single user, or 1 plus the number of

guests for multiple users using FileMaker Pro

networking. (Web users are not counted.)

Status (CurrentUserName)
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Syntax Definition

Relationlnfo {database name. Returns the name of the related tile for a specified

relationship name) relationship

RelationNames (database name) Returns the relationships defined in a specified

database file

ScriplNames (database name) Returns the scripts defined in a specified

database file

ValueListltems (database name. Returns the values defined for a specified value list

value list name)

ValueListNames (database name) Returns the value lists defined in a specified

database file

FileMaker Pro Web Companion external functions

FileMaker Pro Web Companion and other FileMaker Pro plug-ins can

add new functions to the standard functions that are available in

FileMaker Pro. Functions added by FileMaker Pro plug-ins are called

external functions.

You use special syntax with external functions:

External ("function name", parameter)

where function name is in quotes and is the name of an external

function supported by an installed and configured plug-in. The

parameter is required, even if it is only 0.

Note The following functions are only available if FileMaker Pro plug-

ins, such as the FileMaker Pro Web Companion, are installed on your

computer (see the FileMaker Pro Installation and New Features Guide

for more information on Web Companion installation). If there are no

FileMaker Pro plug-ins installed, or the ones installed do not support

external functions, you see only the generic external function definition

in the Specify Calculation dialog box:

External (name, parameter)

Syntax Definition

External ("Web-Version", 0) Returns the version of FileMaker Pro Web
Companion that loads when you open

FileMaker Pro
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Syntax Definition

External ("Web-ClientAddress", 0) Returns the domain name (for example,

www.claris.com) of a Web user whose HTTP
request is currently being processed by

FileMaker Pro Web Companion. Returns the Web
user' s IP address if the domain name is not available.

External ("Web-ClientIP". 0) Returns the IP (Internet protocol) address of the

Web user whose HTTP request is currently being

processed by FileMaker Pro Web Companion

External ("Web-ClientName", 0) Returns the value that the Web user types for user

name in the Web browser password dialog box

External ("Web-ClientType", 0) Returns the name and version of the Web browser

being used by the Web user

External ("Web-ToHTML", field

name)

External ("Web-ToHTML", text value)

Returns the contents of the specified field or of the

text value encoded in HTML

External ("Web-ToHTTP", field name)

External ("Web-ToHTTP", text value)

Returns the contents of the specified field or of the

text value encoded in HTTP
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privileges

Auto Enter 2-6

on the Web 2-9

AutoGrid

described 3-40

reshaping objects to 3-51

setting units 3-42

turning on/off 3-41

Automatic phone dialing 9-4

Automating tasks. See Scripts

Average for summary fields 2-23

B

Background color 3-51

Balloon Help XU, XVII

Baselines, field borders 3-73

BASIC format 8-3

Batteries, preferences for saving 9-4

Blank

layout 3-7

passwords 7-12

records, printing 6-1,6-12

Blank spaces, closing up. See Sliding

objects

Body 3-25

Book icon

Browse mode 4-2,4-18

Find mode 4-21

Layout mode 3-4
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Preview mode 6-12

Boolean expressions 2-17

Boolean numbers

finding 4-24

formatting 3-62

Borders 3-53

button 3-43

field 3-73

Boundaries

field 3-43

text 3-43

Break fields 3-31

Browse mode 1-7

Browser, Web
home page 1 1-23

opening URL 4-17.5-11. 11-23

protecting files 1 1-6

setting up views for 1 1 - 1 2 to

15 to

starting 5-1

1

viewing databases in 1

1

11-18^

Browsing records

access privileges 7-13

described 4-1

groups of 4-

1

in a list 4-16

individually 4-16

on Web 11-15 to 11-18

sorted 4-30

Built-in home page 1 1-6. 1 1-9. 1 1-23

hiding databases on 1 1 -24

Buttons

borders 3-43

changing 5-23

copying 5-23

creating 5-21

defining 5-21,9-3

deleting 5-23

described 5-20

examples 5-29, 5-3

1

non-printing 6-9

performing scripts 5-19.5-20

shapes 9-3

showing 5-20

Buttons, radio. See Radio buttons

Calculation fields

See also Calculations; Formulas

changing 2-25

defining 2-20

described 2-5

formulas 2-13,2-20

functions C-1

importing 8-4

moving to 4-3

stored results 2-20

unstored results 2-20

Calculations

See also Calculation fields

fonnatting 3-62

functions C-1

importing 8-4

related fields 10-31

Canceling, scripts 5-19

CDML Reference 11-25

CDMLtags 11-2

CDML Too! 11-27

CGI applications 11-3

Changing

See also Editing

access privileges 7-15

calculation fields 2-25

dictionary terms 1-18

field definitions 2-25

field values 4-14

formulas 2-25

layout parts 3-35. 3-36

layouts 3-4, 3-23

passwords 7-15

portals 10-27

preferences 9-1

related fields 10-27

relationships 10-29

scripts 5-16

serial numbers 4-14

stacking order 3-46

units 3-85

value lists 4-9

Character sets, cross-platform 8-2

Characters, deleting 4-5

Charts, with FileMaker Pro data 8-

1

Checkboxes

See also Value lists

choosing from 4-9

displaying field values 3-75

editing 4-9

tab order 3-70

Claris Dynamic Markup Language.

See CDML tags

Claris Home Page 1 1-25

Clarislmpact

See also Exporting; Importing

file formats 8-3

ClarisWorks

See also Importing

file formats 8-3

Clients. See Guests

Clones 1-11

Closing FileMaker Pro 1-13,7-8

Closing files 1-11,7-8

Coffee cup icon 7-6

Color

fill 3-51

palette 3-51

pen 3-51

text 3-88

Columnar report layout

See also Extended columnar

layout; Layouts

described 3-9

setting number of columns 3-20

Columns
page breaks 3-33

previewing 3-22

printing 6-10

resizing 6-5

setup 3-21

Comma-Separated Text format 8-3

Commands. See Script steps

Comments, in scripts 5-11

Comparison operators 2- 1

7

Compressed copies of files 1-11

Confidential information. See Access

privileges

Connecting files. See OLE objects;

Relational databases

Constants 2-15

Container fields

See also Fields

deleting 4-8

described 2-5. 4-6

exporting 8-9

formatting 3-67

importing 8-4

searching by 4-22

sorting by 4-3

1
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Context menu 3-42

Converting files 1-11

Copying

buttons 5-23

field definitions 8-2

fields

between fields 4-12,8-4

between files 3-57, 8-2

from previous record 4- 1

2

files 1-11

found set 4-29

graphics and sounds 4-13

layouts 3-23, 8-2

non-standard fields 4-13

objects 3-45

OLE objects 7-7

records 4-4, 4- 1

2

related records 10-31

scripts 5-16

text attributes 8-4

text using drag and drop 9-2

value lists 3-76

values 4-12

versus importing or exporting

Count for summary fields 2-23

Cover page for report 3-29

Creating. See Adding; Defining

Cross-platform

considerations 7-2

exporting 8-2

file sharing 7-1

importing 8-2

Currency, exporting formats 8-11

Current

date

formatting 3-65

pasting into fields 4-11

field 4-3

record 4-2

system formats B-2

time, pasting into fields 4- 1

1

user name
in scripts 4-12

pasting into fields 4-11

Current file. See Files; Master file

Custom
field values 3-76

labels 3-16

line spacing 3-88

order, sort by value list 4-30

Custom Web F'ublishing

See also Instant Web Publishing,

Web Companion
described 11-2

Customer support XI

Customizing FileMaker Pro. See

Preferences

Cutting

layout text 3-82

objects 3-45

Data

described 1-1

entering automatically 2-7

from other files 10-1

relationships 1-2

Data entry

access privileges 7-13

exporting 8-1

importing 8-1

tab order 3-69

Database files. See Files

Database locks. See Access privileges

Database system l-I

Databases

See also Files; Relational databases

described 1-1

planning 2-1

publishing on Web 11-1

single file 1-6

Databases, relational. See Relational

databases

Date

See also Dates; Fields

fields 2-5

finding today's 4-24

functions C-5

symbol, formatting 3-65

Date fields

See also Dates

described 2-5

formatting 3-64

typing values in 4-4

Dates

See also Date; Date fields

current

formatting 3-65

pasting into fields 4-1

1

entering data 4-4

finding 4-24

invalid 4-20

typing in 4-4

dBASE, exchanging data 8-3

DBF format 8-3,8-14

Decimal tabs 3-86

Default

formats 3-60

passwords 9-8

Defining

See also Adding

calculation fields 2-20

fields 2-3

global fields 2-9

lookups 10-3

merge fields 3-58

passwords 7- 1

1

portals 10-20

related records 10-32

relational databases 10-20

relationships 10-9

repeating fields 2-1

1

scripts 5-12
^ summary fields 2-23

value lists 3-75

Deleting

buttons 5-23

characters 4-5

dictionary terms 1-18

duplicate records 4-20

fields 1-12,2-25,3-59,7-16

find requests 4-26

graphics 4-8

groups 7-19

imported records 8-8, 8-9

layout parts 3-36

layouts 3-23

master records 10-23,10-34

movies 4-8

objects 3-45

passwords 7-15

records 4-29

related fields 10-28

related records 10-23, 10-34

Script menu items 5-16

script steps 5-16

scripts 5-18

sounds 4-8

text 3-82

value lists 3-76

Delimiters. See File formats

Design functions C-18



1-4 FileMaker Pro User's Guide

Designing databases

planning 2-1

relational 10-15

Detail databases. See Related files

Detail tables. See Related files

Dialing phone numbers

procedures 9-4

script steps 5-1

1

Dictionaries

See also Spelling

adding words 1-14,1-18

changing words 1-18

deleting words 1-18

described 1-13

editing 1-17

installing 1-16

main 1-13

options 1-17

selecting 1-16

user

adding words 1-14

described 1-13

exporting 1-18

importing 1-18

installing 1-16

DIF format 8-3

Display formats 3-60

Displays. See Layouts

Document preferences 9-7

Documentation

overview XVII

using with Help XI

Double arrow icon 7-6

Drag and drop

described 4-13

disabling 4-14

enabling for text 9-2

multiple objects 4-14

requirements 4-13

text 9-2

Dragging information 4- 1

3

Duplicate records, finding with

scripts 5-34

Duplicating. See Copying

Edit items 3-78.4-9

Editing

See also Changing

find requests 4-26

objects quickly 3-42

value lists 4-9

Edition File format 8-3

Edition Manager 8-3

Elements. See Objects

Email, sending 5- 1

1

Embedded groups 3-47

Empty fields 4-20

Enabling plug-ins 9-7

Encryption. See Access privileges

Entering data

automatically 2-7

typing in fields 4-4

Entry options

always selected 3-68

changing 2-25

tab order 3-69

Envelope layout

See also Layouts

described 3-18

headers 3-20

using 3-18

Error messages, displaying in

scripts 5-5

Errors, finding 4-19

Excel format 8-3

Exchanging files

See also Exporting; Files;

Importing

Apple events 5-23, 5-37

AppleScript commands 5-37

cross-platform considerations 8-2

exporting 8-1, 8-9

importing 8-1, 8-4

lookups 10-1, 10-3

relational databases 10-1

remote data 8-10

sharing files 7-1

with other applications 8-1

Exchanging information. See

Exchanging files

Exporting

See also Exchanging files

access privileges for 7- 1

3

described 8-1,8-9

dictionaries 1-18

field order 8-10

file formats 8-3

formatting 8- 1

1

grand summaries 8-13

opening exported files 8-9

related records 10-32

repeating fields 8-14

requirements 8-4

shared files 8-2

summary fields 8-10,8-12

versus copying and pasting 8-2

Expressions

Boolean 2-17

described 2-15

Extended columnar layout

See also Layouts

described 3-9

printing 6-10

setting number of columns 3-20

External tiles. See Exchanging files;

Exporting

External functions C-19

External scripts 5-3

False. See also Boolean

expressions 3-62

Field definitions

changing 2-25

described 1-4

duplicating 2-25

importing 8-2

printing 6-1.6-12

related fields 10-30

reordering 2-25

Field labels, layout 3-56

Field references in formulas 2-16

Field rights. See Access privileges

Field types

changing 2-25

described 2-5

Field values

described 1-4

replacing 4-14
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Fields

See also Calculation fields:

Container fields; Date fields;

Global fields; Match fields;

Number fields; Related fields;

Summary fields; Text; Time fields

access privileges 7-9,7-16,7-18

adding to current layout 9-3

borders 3-73

boundaries, showing/hiding 3-43

changing

calculations 2-25

definitions 2-25

entry opfions 2-25

formulas 2-25

names 2-25

sort order of 4-30

types 2-25

copying

between fields 4- 1

2

between files 3-57

from previous record 4-12

current 4-3

custom values 3-76

defining 2-3

definitions 1-4

deleting 1-12,2-25,3-59,7-16

described 1-3, 1-4

displaying 3-1

duplicating definitions 2-25

Edit items 4-9

editing 2-25

empty, finding 4-20

entry options 2-6

formatting

as selected 3-68

sample data 3-57

scroll bars 3-71

text 3-60

identifying records 5-34

indexing 2-12

lookups

defining 10-3

updating 10-14

maximum text entry 4-4

merge 3-58

modifying in multiple

records 4-14

moving between files 3-57

naming 2-3

opening URL from 4-17

options 2-4

Other items 4-9

pasting into 4-10, 4-11

patterns 3-73

planning 2-3

positioning 3-44

removing 1-12, 3-59

reordering definitions 2-25

repeating

adding 3-72

described 2-11

formatting 3-72

sliding 6-9

sorting 4-32

tab order 3-70

rotating 3-49

scroll bars 3-71

selecting 3-39, 3-68

stored results 2-20

tab order 3-69

types 2-5

typing in 4-4

unstored results 2-20

validation options 2-7

value lists 3-75

values 1-4

Web display 11-12, 11-21

Fields functions. See Aggregate

functions

File formats

See also Files; Formats

BASIC 8-3

ClarisWorks 8-3

Comma Separated text 8-3

DBF 8-3

described 8-3

DIF 8-3

Edition File 8-3

Excel 8-3

exporting 8-3

FileMaker Pro 8-3

HTML table 8-3

importing 8-3

list of 8-3

Merge 8-3

repeating fields 8-14

requirements 8-4

SYLK 8-3

Tab-Separated Text 8-3

WKS 8-3

File types. See File formats

FileMaker Pro

customer support XI

file format 8-3

registration XI

FileMaker Pro Web Companion. See

Web Companion

FileMaker Pro Server 7-2, 7-4, 7-5

Files

See also Exchanging files; File

formats; Related files

access privileges 7-9

closing 1-11

converting 1-11

copying 1-11

creafing 1-9,8-9

described 1-1

exporting 8-9

importing 8-4

internal default formats B-1

international B-1

lookup 10-3

multiuser 7-3

opening 1-10,8-9

as host 7-3

planning 2-1

protecting 7-9

recovering A-1

related 1-6, 10-1

saving 1-11

security 7-9

shared

access privileges 7-9

closing 7-8

described 7-1

guests 7-2, 7-4

host 7-2,7-3

on remote volumes 7-3

on Web 7-3, 11-1, 11-6. 11-7

preferences 9-7

requirements 7-1

saving 7-6, 7-8

System 7 File Sharing 7-2

system formats B-1

templates

creating files 1-9

described 1-9

displaying 9-2

updafing to current version 1-11

Files, external. See Exchanging files

Files, master. See Master file

Fill attributes

color 3-51

described 3-53

pattern 3-73

setting 3-51, 3-52
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Financial functions C-13

Find criteria 4-19

Find mode 1 -7

Find requests

See also Finding

defining 4-19

deleting 4-26

described 4-19

editing 4-25. 4-26

mixing find and omit 4-27

multiple 4-25

operators in 4-20

order of 4-27

repeating 4-25,4-26

reverting 4-21

summary fields in 4-20

Finding

See also Find requests

all records 4-25

Boolean numbers 4-24

dates 4-24

described 4-19

duplicate records 5-34

duplicate values 4-20

empty fields 4-20

errors 4-19

exact values 4-20, 4-2

1

graphics 4-22

invalid dates and times 4-20

numbers 4-24

operators 4-20

order of requests 4-27

ranges 4-20

records 4-19

records using related fields 10-34

text 4-23

times 4-24

today's date 4-24

Flat-file databases 1 -6

Fonts

text ruler 3-85

Footers

described 3-25

printing 6-1

Form letters 3-58

Form View, Web
setting up 11-12 to 11-18

viewing in browser 1 1-16

Format files 11-2, 1 1-4, 1 1-6. 1 1-25

to 11-28

and Claris Home Page 1 1 -25

CDMLtags 11-25

Formats

See also File formats; System

formats

default 3-60

display 3-60

internal default B-1

international 3-60, B-1

system B-1

Formatting

calculations 3-62

custom line spacing 3-88

export data 8-4, 8-11

fields

as selected 3-68

defaults 3-60

sample data 3-57

text 3-60

graphics 3-67

import data 8-4

merge fields 3-58

paragraphs 3-84

repeating fields 3-72

scroll bars 3-71

text 3-88

times 3-65

Forms

See also Layouts

printing 6-1, 6-12

Formulas

See also Calculation fields;

Summary fields

calculation fields 2-20

changing 2-25

constants 2-15

described 2-13

expressions 2-15

field references 2-16

functions C-1

operators 2-16

results 2-14

syntax 2-14

Found set

copying 4-29

deleting 8-8

described 4-4,4-19

import data 8-8

switching with omitted set 4-27

Fraction of Total for summary
fields 2-23

Functions

aggregate C-6

date C-5

described 2-20

design C-1

8

external C-1

9

financial C-13

logical C-1

4

number C-4

parameters C-1

repeating C-1

2

status 5-33. C-16

summary C-9

text C-3

Ume C-6

trigonometric C-13

Web Companion C-1

9

Getting help. See Help

Global fields

See also Fields

defining 2-9

described 2-5, 2-9

examples 5-34

importing 8-4

shared files 7-6

Glossary in Help XIV

Grand summaries

described 3-29

exporting 8-13

Graphic

objects

adding to layouts 3-54

described 3-52

rulers

described 3-40

showing/hiding 3-41

Graphics

copying 4-13

deleting 4-8

finding 4-22

importing 4-6

pasting 4-8

positioning 3-44

rotating 3-49

storing methods 4-6

viewing on the Web 3-3

Graphs, with FileMaker Pro data 8-1

Grouping objects 3-47
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Groups

access privileges 7-9.7-15,7-17

associating with passwords 7- 1

8

changing 7-19

defining 7-15

deleting 7-19

embedded 3-47

examples 7-10

limiting access 7-9

master passwords 7- 1

7

versus passwords 7-9

Guests

closing files 7-8

described 7-2

opening files 7-4

performing tasks 7-6

related files 10-32

saving files 7-6, 7-8

sending messages to 7-3

Guides. See AutoGrid; Ruler lines; T-

square

H
Headers

described 3-25

Envelope layout 3-20

Labels layout 3-15

printing 6-1

title 3-25

Help, using XII

context-sensitive XVI
for databases in browser 11-23

glossary XII

Hiding objects

See also Showing/hiding

during printing 6-3, 6-9

Home page

directing Web users to 11-23 to

11-24

logging activity 11-10

replacing built-in 11-10

specifying default 1 1 -9

Horizontal pitch, custom labels 3-16

Host

closing files 7-8

database on Web 7-3, 11-1. 11-6

described 7-2

FileMaker Pro Server 7-2, 7-4

opening files 7-3

performing tasks 7-6

related files 10-32

saving files 7-6, 7-8

sending messages to guests 7-3

System 7 File Sharing 7-2

HTML files

and Custom Web
Publishing 11-25

described 11-2

exporting to HTML table 8-3

HTTP commands 1 1-3

HyperText Markup Language. See

HTML

Identification fields 5-34

Importing

See also ClarisWorks; Exchanging

files; Exporting

appending new records 8-4, 8-7

canceling 8-8

cross-platform considerations 8-2

data order 8-4

described 8-1,8-4

destination files 8-5

dictionaries 1-18

exception fields 8-4

field definitions 8-2

field order 8-5

file formats 8-3

found set 8-8

graphics 4-6

into existing files 8-4

layouts 8-2

movies 4-6

new files 8-9

options 8-4

record order 8-4

related records 10-32

repeating fields 8-7

requirements 8-4

shared files 8-2

source files 8-5

updating existing records 8-8

validating data 8-8

versus copying and pasting 8-2

Index

Help XII

pasting from 4-10

Indexing fields 2-12

Instant Web Publishing

See also Custom Web Publishing,

Web Companion
and layout objects 3-3

built-in home page 11-9, 1 1-23

described 1 1 -2

disabling or enabling 1 1 -9

language in interface 11-10

setting up pages 11 -12 to 11-18

showing value lists 3-78

using Scripts with 5-1

viewing browser pages 11-15 to

11-18

International files. See System formats

Internet See also Web
access 11-2, 11-5

described 11-1

service provider 11-5

Intranet 11-1

IP address 11-1, 11-11, 11-23

J

Join expressions. See Relationships

Join fields. See Match fields

Joins. See Relationships

Jusfification. See Text, alignment

K

Key fields. See Match fields

Keywords. See Help

Labels

custom 3-16

dimensions 3-16

field 3-56

margins 3-16

print area 3-17

printing

dot matrix printer 3-13

entire sheet 3-17

Labels layout

See also Layouts

customizing 3-11

described 3-6

headers 3-15

page setup 3-13
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preset sizes 3-1

1

printing 3-13

sizing 3-17

using 3-13

Layout mode 1-7

Layout objects. See Objects

Layout parts

adding 3-27

adding objects to 3-29

body 3-25

changing 3-35, 3-36

deleting 3-36

described 3-24

field labels 3-56

footer 3-25

grand summaries 3-29

header 3-25

modifying 3-36

page breaks 3-32

page numbers 3-32

reordering 3-35

resizing 3-36

restoring 3-60

subsummaries 3-35

summaries 3-29

title footer 3-25

title header 3-25

Layout pop-up menu 3-4, 3-23

Layout text. See Text

Layouts

See also Columnar report layout:

Envelope layout; Extended

columnar layout; Labels layout

access privileges 7-9,7-13,7-16,

7-18

adding graphics 3-54

Blank 3-7

blank space, removing 6-5

buttons 3-43,5-20

changing 3-4, 3-23

checking 3-7

choosing 3-23

columns

page breaks 3-33

resizing 6-5

setup 3-21

cover page 3-29

custom line spacing 3-88

customizing for users 5-33

deleting 3-23

described 3-1

displaying related records 1 0-26

duplicating 3-23

field boundaries 3-43

fields

deleting 3-59

displaying 3-1

removing 3-59

selecting 3-39

importing 8-2

margins 6-3, 6-4

modifying 3-23

naming 3-8,3-10,3-13,3-23

objects

deleting 3-45

graphic 3-52

locking 3-52

non-printing 6-9

on Web 11-5, 11-12

page breaks 6-3

predefined 3-5, 3-6

previewing 3-7

print area 6-3

printing

Extended columnar 6-10

overview 6-1

procedures 6-12

subsummaries 6-1

1

related fields

deleting 10-28

displaying 10-26

field definitions 10-30

removing 3-23

renaming 3-23

reordering the menu list 3-23

setting preferences 9-3, 9-8

Single-page form 3-7

Standard 3-7

switching 3-23

tools

described 3-4

locking 3-38,9-3

viewing on the Web 3-3

Leading summaries 3-29

Leading. See Line spacing, custom

Leaving FileMaker Pro 1-13

Line spacing, custom 3-88

Lines 3-53

Links. See Linked objects;

Relationships

List separators C-1

Lists, pop-up. See Pop-up lists

Locking

objects 3-52

shared records 7-6

tools 3-38

Log, of Web activity 11-10

Logical

AND search 4-25

functions C-1

4

operators 2-18

OR search 4-25

Lookups

and relational databases 10-1

defining 10-3

defining relationships 10-9

updating 10-14

Lotus 1-2-3, exchanging data 8-3

M
Macros. See Scripts

MacWrite Pro data file. See Merge
format

Mail merging. See Merge format

Mail, sending 5-11

Main database. See Master file

Main dictionary. See Dictionaries;

Spelling

Main forms. See Master records

Margins

alternating 6-4

changing, text ruler 3-85

displaying

in Layout mode 6-3

in Preview mode 6- 1

1

labels 3-16

setting 6-4

Master file

described 10-2

planning 10-15

Master password

defining 7-13

described 7-1

1

groups 7-17

Master records

deleting 10-23, 10-34

duplicating 10-31

finding with related fields 10-34

sorting with related fields 10-35

Master table. See Master file
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Match fields

See also Fields

described 10-3

planning 10-16

Mathematical operators 2-17

Maximizing window size 9-9

Maximum for summary fields 2-23

Memory preferences 9-4

Menu commands, access

privileges 7-14

Menus
context, described 3-42

layout pop-up 3-23

Script

adding items 5-14.5-16

deleting items 5-16

reordering items 5- 1

8

Menus, pop-up. See Pop-up menus

Merge fields

adding 3-58

described 3-58

formatting 3-58

Merge format 8-3

Messages, sending 7-3

Minimum for summary fields 2-23

Modems, configuring 9-5

Modes 1-7

Modifying. See Changing

Movies

deleting 4-8

importing 4-6

importing with scripts 5-8

moving 4-8

pasting 4-8

playing 4-7

Moving

fields between files 3-57

movies 4-8

objects

between applications 3-45

between layouts 3-45

overview 3-44

part labels 3-35

record to record 4- 1

8

to calculation fields 4-3

to summary fields 4-3

MuUiple platforms. See

Cross-platform

Multi-table databases. See Relational

databases

Multiuser files 7-3

N
Naming

fields 2-3, 2-25

layouts 3-8,3-10,3-13

scripts 5-13

value hsts 3-75

Networks

See also Access privileges; Shared

files

changing connections 9-2

cross-platform 7-2

FileMaker Pro Server 7-2, 7-4, 7-5

protecting files 7-9

sharing files 7-

1

Web 7-4, 11-6

No. See Boolean expressions

No password 7-12

Non-printing objects 6-9

NOT operator 2-18

Number fields

See also Fields

Boolean 3-62

described 2-5

entering data 4-4

finding 4-24

formatting 3-62

typing values in 4-4

Number functions C-4

Objects 3-49

adding to layouts 3-29

aligning 3-48

copying 3-45

cutting 3-45

deleting 3-45

described 3-37

edifing quickly 3-42

fill 3-53

graphic 3-52

grouping 3-47

locking 3-52

moving

between applications 3-45

between layouts 3-45

overview 3-44

non-printing 6-9

pasting 3-45

positioning 3-40

resizing 3-50

rotating 3-49

selecting 3-39

sliding

described 6-5

displaying 6-6, 6-8

repeating fields 6-9

setting 6-7

stacking order 3-46

text

adding 3-80

deleting 3-82

described 3-79

pasting 3-82

replacing 3-82

ungrouping 3-47

OLE objects, working with 7-7

Omitting

fields

during printing 6-3. 6-9

from tab order 3-70

records

find requests 4-26

related 10-34

One-to-many relationship between

data 10-20

One-to-one relationship between

data 10-20

Onscreen help. See Help

Opening

files 1-10.7-3

Help XII

URLs 5-M, 11-23

Operators

AND 2-18

comparison 2-17

in find requests 4-20

in formulas 2-16

logical 2-18

mathematical 2-17

NOT 2-18

OR 2-18

precedence 2-16

text 2-19

XOR 2-18
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Index 1-11

locking layout tools 9-3

maximizing window size 9-9

memory 9-4

modem 9-4, 9-5

network connections 9-2

opening to specific layout 9-8

opening witli default password 9-8

performing scripts 9-9

saving files 9-4

shared files 9-7

showing/hiding status area 9-9

specifying user names 9-2

spelling 9-9

using smart quotes 9-8

Web Companion 11-7, 11-9

window size 9-9

Preset label sizes 3-1

1

Preview mode 1-7,6-11

Previewing

See also Printing

columns 3-22

records 6- 1

1

related records 10-32

subsummaries 3-31

Print area

labels 3-17

objects outside 6-3

viewing 6-3, 6-1

1

Print preview. See Preview mode

Printer, selecting 6-14

Printing

See also Previewing

access privileges for 7-13

blank records 6-1,6-12

canceling 6-13

columns 3-22

Extended columnar layout 6-10

field definitions 6-1,6-12

forms 6-1,6-12

headers and footers 6-

1

labels

dot matrix printer 3- 1

3

setup 3-13

tips 3-13,3-17

layouts 6-1, 6-12

overview 6-1

page orientation 6-10,6-12

previewing 6-11

print area 3-17,6-3,6-11

procedures 6-12

records 6-1,6-12

related records 10-32

reports 6-1,6-12

script definitions 6-1,6-12

setup 6-14

stopping 6-13

subsuminaries 3-22,6-11

Privileges. See Access privileges

Procedures. See Scripts

Protecting files. See Access privileges

Publish and Subscribe. See Edition

Manager

Publishing, databases on the

Web 11-1

overview 11-3

Pushbuttons. See Buttons

QuickHelp applicafion XIV

QuickTime movies. See Movies

Quitting FileMaker Pro 1-13, 7-8

Quotation marks in searches 4-23

Quotes, smart 9-8

Radio buttons

See also Value lists

choosing from 4-9

displaying field values 3-75

editing 4-9

tab order 3-70

Ranges, finding 4-20

Read/write password. See Access

privileges

Record locking 7-6

Recording

scripts 5-12

sounds 4-8

Records

access privileges 7-13

adding 4-4

appending 8-4

browsing

groups of 4-

1

in a list 4-16

individual 4-16

on Web 11-15 to 11-18

sorted records 4-30

copying 4-4, 4- 1

2

deleting 4-29

on Web 11-15 to 11-18

deleting duplicates 4-20

described 1-2, 1-5

dupMcating 4-4

exporting 8-9

finding 4-19

all 4-25

duplicates 5-34

on Web 11-15 to 11-18

importing 8-4

locked 7-6

modifying field values 4-14

moving to 4-18

omitting 4-26

previewing 6-1

1

printing

blank 6-1,6-12

large 6-1,6-10

overview 6-1

procedures 6-12

reserializing 4-14

reverting 4-4

semi-sorted 4-32

sorting 4-30

on Web 11-13

related records 10-36

Records, master. See Master records

Records, related. See Related records

Recovering files A-1

Rectangle tool 3-53

Registering FileMaker Pro XI

Related fields

See also Fields; Relational

databases

calculations 10-31

changing 10-27

deleting 10-28

described 10-3

display on Web 11-6, 11-13

field definitions 10-30

finding 10-34

on layouts 10-26

one-to-one relationship between

data 10-20

planning 10-17

script steps for 10-31

sorting 4-32, 10-35

summarizing data 10-31

syntax for field names 10-3
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Related files

See also Files: Relational databases

access privileges 10-10,10-19,

10-30

described 1-6, 10-2

planning 10-15

shared 10-32

Related records

See also Records; Relational

databases

adding 10-23

defining 10-32

deleting 10-23, 10-34

described 10-3

displaying in portals 10-26

duplicating 10-31

finding and omitting 10-34

importing and exporting 10-32

previewing 10-32

printing 10-32

sorting 10-36

Relational databases

See also Portals; Related fields;

Related files; Related records;

Relationships

copying related records 10-31

defining 10-20

defining portals 10-20

deleting related records 10-34

described 1-2, 10-5

example 10-36

finding and omitting related

records 10-34

master file

described 10-2

planning 10-15

match fields

described 10-3

planning 10-16

one-to-many relationship between

data 10-20

one-to-one relationship between

data 10-20

planning 10-15

portals 10-3

printing and previewing 10-32

related fields 10-3

related files 10-2

related records 10-3, 10-32

relationships 10-3

sorting 10-35

terminology 10-2

Relationships

See also Relational databases

changing 10-29

defining 10-9

described 10-3

planning 10-18

to and from same file 10-10

Relookups

automating 10-14

described 10-14

Remarks, in scripts 5-11

Remote files, sharing

local network 7-3

Web 11-10, 11-18 to 11-22

Removing. See Deleting

Renaming layouts 3-23

Reordering

field definitions 2-25

layout parts 3-35

layouts 3-23

Script menu items 5-18

script steps 5-13, 5-17

scripts 5-18

sort fields 4-30

Repeating fields

adding 3-72

defining 2-11

described 2-11

exporting 8-14

formatting 3-72

importing 8-7

separating 8-14

shding objects 6-9

sorting on 4-32

splitting 8-14

tab order 3-70

Repeating find requests 4-25, 4-26

Repeating functions C-12

Repeating panels. See Portals

Repetitions. See Repeating fields

Replacing

field values 4-14

text 4-5

Reports

See also Layouts

adding page numbers 3-83

adding printing date 3-83

adding printing time 3-83

columnar 3-9, 3-20

cover page 3-29

previewing 6-1

1

printing 6-1, 6-12

Requests. See Find requests

Requirements

exporting 8-4

file sharing 7-

1

importing 8-4

Web Companion 11-5

Reserializing records 4-14

Resizing

layout parts 3-36

several objects 3-50

Restoring

layout parts 3-60

script settings 5-15

Restricting access. See Access

privileges

Retrieving data from other files. See

Exchanging files

Reverting

find requests 4-2

1

records 4-4

Rights. See Access privileges

Rotating objects 3-49

Rounded rectangle tool 3-53

Ruler lines

described 3-40

setting units 3-41

showing/hiding 3-41

Rulers

graphic 3-40

lines 3-40

setting units 3-41

showing/hiding 3-41

text 3-40

Running scripts 5-19

Sample data in fields 3-57

Saving

files l-U
setting preference for 9-4

shared files 7-6,7-8
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Script menu
adding items 5-14,5-16

deleting items 5-16

reordering items 5-18

Script specifications. See Scripts,

settings

Script steps

See also Scripts

adding 5-13.5-16

Control 5-5

deleting 5-13, 5-16

described 5-4

Editing 5-7

Export 5-8

Fields 5-7

Files 5-9

Find 5-6

for related fields 10-31

Import 5-8

italicized 5-17

Miscellaneous 5-10,5-11

Navigation 5-6

options 5-4.5-13,5-16

Print 5-6

Records 5-8

reordering 5-13,5-17

Sort 5-6

Spelling 5-10

Windows 5-9

ScriptMaker

See also Scripts

examples 5-29

steps 5-4

using 5-1

Scripts

See also Script steps; ScriptMaker

adding

comments 5-1

1

menu items 5-14,5-16

remarks 5- 1

1

Apple events 5-23

AppleScript commands 5-24, 5-28

automating relookups 10-14

buttons 5-20

canceling 5-19

changing 5-16

commands 5-4

conditional 5-5

current user name 4- 1

2

defining 5-12

deleting 5-18

deleting menu items 5-16

described 5-2

designing 5-11

dialing phone numbers 5-11,9-4

displaying error messages 5-5

duplicating 5-16

examples 5-29

external 5-3

keyboard shortcuts 5-18

looping 5-5

modifying 5-16

naming 5-13

passwords 7- 1

3

pausing

adding to scripts 5-14

described 5-3

example 5-2

resuming 5-19

stopping 5-19

performing 5-2,5-19

planning 5-11

playing 5-19

printing 6-1,6-12

reordering in Script menu 5-18

resuming 5-19

running 5-19

sending Apple events 5-11,5-25

setting preferences 9-9

settings

changing 5-16

examples 5-29, 5-31

keeping 5-17

replacing 5-17

restoring 5-15

storing 5-15

shutdown 5-3, 9-9

sort order 4-32

startup 5-3,9-9

stopping 5-19

subscripts

adding to scripts 5-12

changing 5-16

described 5-3

system formats B-3

testing 5-12

with Instant Web Publishing 5-1

Scroll bars

adding to fields 3-71

in portals 10-25

Search page, Web
setting up 11-12 to 11-18

viewing in browser 11-17

Search requests. See Find requests

Searching. See Finding

Secondary files. See Relational

databases

Security, file. See Access privileges

Selecting

checkboxes 4-9

Edit items 4-9

from pop-up lists 4-9

from pop-up menus 4-9

objects

all fields 3-39

by type 3-39

grouping 3-47

individually 3-39

multiple 3-39

ungrouping 3-47

Other items 4-9

patterns 3-51

printer 6-14

radio buttons 4-9

semi-sorted records 4-32

text 3-82

Selection handles 3-39, 3-50

Self-joins. See Relationships

Sending mail 5-1

1

Sending messages 5-11, 7-3

Separator line in value lists 3-76

Serial numbers, modifying 4-14

Server. See Host; FileMaker Pro

Server

Settings

See also Preferences

alignment 3-49

tab order 3-69

Web Companion 11-7, 11-8

Shared files

See also Networks

access privileges 7-9

closing 7-8

coffee cup icon 7-6

described 7-1

double arrow icon 7-6

guests 7-2

host 7-2

on Web 11-1, 11-7

access privileges 11-10,

ll-18to 11-22

opening 7-3. 7-4

quitting FileMaker Pro 7-8
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related 10-32

saving 7-6, 7-8

System 7 File Sharing 7-2

Sharing information. See Exchanging

t~iles

Showing/hiding

See also Hiding objects

ruler lines 3-41

rulers 3-41

status area 4-2

T square 3-41

Shutdown

options 5-3

scripts 5-3.9-9

Single file databases 1-6

Single-page form layout 3-7

Size

palette

described 3-40

positioning objects 3-41

resizing objects 3-50

text 3-88

text ruler 3-85

Sliding objects

displaying 6-6, 6-8

parts 6-6

repeating fields 6-9

setting 6-7

Smart quotes 9-8

Sort order

See also Sorting

changing 4-30

creating 4-30

in scripts 4-32

records on Web 11-13

restoring original 4-31

summary fields 4-32

Sort page, Web
setting up 11-12 to 11-18

viewing in browser 11-18

Sorting

See also Sort order

ascending order 4-30

canceling 4-31

container fields 4-3

1

custom order 4-30

descending order 4-30

described 4-30

in scripts 4-32

master records with related

fields 10-35

on subsummaries 3-31

records on Web 11-13

related fields 4-32

related records 10-36

repeating fields 4-32

summary fields 4-32

Sounds

copying 4-13

deleting 4-8

playing 4-8

recording 4-8

Space, removing blank 6-5

Speaking text 5-1

1

Speech 5- 1

1

Spelling

See also Dictionaries

checking

as you type 1-15

automatically 1-15

options 1-13, 1-14

setting preferences 9-9

Splitting repeating fields 8-14

Spreadsheets

See also Exporting; Importing

file formats 8-3

Stacking objects 3-46

Standard Deviation for summary

fields 2-23

Standard layout 3-7, 3-8

Startup

options 5-3

scripts

described 5-3

examples 5-33

performing 9-9

Statistical functions. See Aggregate

functions

Status area

Browse mode 4-2

Find mode 4-2

1

showing/hiding 4-2, 9-9

Status functions

described C-16

using in scripts 5-4, 5-33

Steps. See Script steps

Stopping

See also Closing

printing 6-13

scripts 5-19

Stored results 2-20

Strings, text. See Text, literal

Subforms. See Portals

Subscripts. See Scripts, subscripts

Subsummaries

described 3-29

exporting 8-12

importing 8-4

leading 3-29

page breaks 3-32

previewing 3-31

printing 6-11,6-12

sorting 3-31

trailing 3-30

Subtotals. See Subsummaries;

Summary fields

Summaries. See Summary fields;

Summary parts

Summarizing data in related

fields 10-31

Summary fields

See also Fields; Formulas

Average for 2-23

Count for 2-23

defining 2-23

described 2-5, 2-23

exporting 8-12

find requests 4-20

formulas 2-13

Fraction of Total for 2-23

importing 8-4

Maximum for 2-23

Minimum for 2-23

moving to 4-3

on layouts 3-9

options for 2-24

sorting 4-32

Standard Deviation for 2-23

Total for 2-23

Summary functions C-9

Summary parts 3-29

Switching layouts 3-23

SYLK format 8-3,8-14

Symbols

pasting 3-83

Syntax

formulas 2-14

related field names 10-3
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System 7 File Sharing 7-2

System formats

See also Formats

changing B-2

current, using B-2

described B-1

scripts, defining B-3

working with B-1

Tab order

omitting fields 3-70

on the Web 3-69

repeating fields 3-70

setting 3-69

Table rights. See Access privileges

Table View, Web
setting up 11-12 to 11-18

viewing in browser 11-15

Tables. See Files

Tabs

alignment 3-86

attributes 3-86

decimal 3-86

setting 3-85

Tab-Separated Text format 8-3

TCP/IP network protocol 9-2

TCP/IP port 11-11, 11-23

Technical support. See Customer

support

Templates

creating files 1-9

described 1-9

displaying 9-2

suppress New Database dialog

box 1-10

Web 11-26, 11-28

Text

See also Fields

adding 3-79, 3-80

alignment 3-88

attributes 3-60,3-90,8-4

on the Web 3-61

baselines 3-73

boundaries, showing/hiding 3-43

color 3-88

cutting 3-82

deleting 3-82

fields 2-5

finding 4-23

formatting 3-60. 3-88

line spacing 3-88

objects

viewing on the Web 3-3

objects, described 3-79

operators 2-19

paragraphs 3-84

pasting 3-82

removing 3-82

replacing 3-82,4-5

rotating 3-49

selecting 3-82

sizes 3-88

speaking 5-1

1

styles 3^-88

tool 3-80

typing values in fields 4-4

using drag and drop 9-2

Text fields. See Text

Text functions C-3

Text ruler

changing text attributes 3-85

described 3-40

formatting paragraphs 3-84

setting tabs 3-85

setting units 3-41

showing/hiding 3-41

Text tool 3-80

Time
See also Time fields

current 4-1

1

finding 4-24

formatting 3-65

functions C-6

invalid 4-20

Time fields

See also Fields; Time
described 2-5

entering data 4-5

international formats 4-5

typing values in 4-5

Title headers and footers

cover page 3-29

described 3-25

Today's date, finding 4-24

Toolbars. See Tools

Tools

described 3-4

locking 3-38

switching between 3-38

text 3-81

tools palette

line tool 3-53

oval tool 3-53

pointer 3-39

rectangle tool 3-53

rounded rectangle tool 3-53

text tool 3-80

working with 3-38

Total for summary fields 2-23

Totals. See Summaries

Trailing summaries 3-30

Transactions. Web 11-10

Trigger fields. See Match fields

Trigonometric functions C-13

True. See also Boolean

expressions 3-62

T-square

.» adjusting 3-41

described 3-40

showing/hiding 3-41

Typing in fields 4-4

u
Unauthorized users. See Access

privileges

Ungrouping objects 3-47

Unstored results 2-20

Updating files. See Converting

Updating lookup values 10-14

Updating records. See Importing

URLs, opening 4-17, 5-1 1, 11-23

User dictionaries. See Dictionaries

User names

current

pasting into fields 4-11

scripts 4-12

examples 5-33

setting 9-2

Using data from other files. See

Exchanging files
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Validating fields 2-7

Value lists

See oho Checkboxes; Pop-up lists;

Pop-up menus; Radio buttons

access privileges 7-13

copying 3-76

custom sorting by 4-30

defining 3-75

deleting 3-76

described 3-75

Edit items 3-78,4-9

editing 4-9

naming 3-75

options 3-76

Other items 4-9

separating line 3-76

showing/hiding 4-9

Values

copying 4-12

displaying 3-75

finding duplicates 4-20

finding exact 4-20,4-21

inserting indexed 4-10

looking up automatically 10-3

lookups, updating 10-14

modifying 4-14

Values, field. See Field values

Vertical pitch, custom labels 3-16

View as list

described 4-16

subsummaries 3-31

Views, Web
setting up 11-12 to 11-18

Views. See Layouts

Virtual results 2-20

w
Web

access 11-5

described 11-1

hosting databases on 11-1

servers 11-3

Web browser. See Browser, Web
Web Companion

See also Custom Web Publishing,

Instant Web Publishing

and tab order 3-69

and text formatting 3-61

CDML Reference 11-25

CDMLTool 11-27

configuring 1 1 -8 to 11-11

default settings 11-8

enabling 9-7

functions C-19

homepage 11-9,11-23

Instant Web Publishing browser

pages 11-15 to 11-18

port number 11-11,11-23

remote administration 11-10

requirements 1 1 -5

sample files 11-28

setting up 11-7 to 11-8

setting up layouts 11-5

Web security databases 11-11,

11-18 to 11-22

Wildcards in searches 4-23

Windows, setting size 9-9

WKS format 8-3,8-14

Worid Wide Web. See Web

XOR operator 2-18

Yes. See Boolean expressions

Zoom controls 3-4, 4-2



Controlling windows

'ext record, layout, or request

aste a merge field (Layout)

I'aste from tfie index (Browse and Find)

Paste from the last record (Browse and Find)

Paste from tfie last record and move to ttie

next field

Paste ttie current date

Paste the current time

Paste the current user name

Paste without style

Previous field (Browse and Find)

Previous record, layout, or request

Replace the contents of the current field in all

records in the found set

3€-Tab

3€-M

Shift-*-'

38-- (hyphen)

3€-:

Shift-8g-N

Option-36-V

Shift-Tab

Control-t. or

Shift-8€-Tab

Spell the selected word correctly



Quick Reference

Keyboard and mouse shortcuts

Working with layout objects

Align objects using the current settings

Align to grid off while resizing/nnoving an

object
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